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ВСТУП 
 

Мікроконтролери (МК) можна зустріти практично в будь-якому тех-
нічному завданні, де потрібно вирішувати завдання вимірювання, оброб-
лення інформації та управління. Це може бути електропобутова техніка, 
вимірювальні прилади або засоби комунікації, а також такі складні об'єкти 
управління, як автомобілі або літаки. Коло таких завдань дуже широке, по-
чинаючи від увімкнення звукової або світлової сигналізації та закінчуючи 
складною математичною обробкою й аналізом інформації, що надходить 
від різних давачів, з подальшим формуванням керуючих впливів на об'єкт 
управління. 

Одним з найбільш популярних наборів мікроконтролерів, які застосо-
вуються в системах оброблення даних, контролю і управління, є пристрої, 
що випускаються фірмою Microchip та відомі під абревіатурою PIC. Однак, 
останнім часом корпорація Atmel (США) стала виробляти набір мікросхем 
на ядрі AVR, яке має більш досконалу архітектуру й забезпечує мікрокон-
тролерам цього набору високу швидкодію та низьке енергоспоживання, що 
дає їм відчутну перевагу, порівняно з контролерами PIC [15, 22, 24].  
До того ж, цінова політика корпорації Atmel є більш привабливою для роз-
робників таких систем. Порівняно з пристроями PIC, МК AVR мають 
більш розвинену систему команд, що налічує до 133 інструкцій, їхня про-
дуктивність наближається до 1 MIPS/МГц, а flash-пам'ять програм має  
можливість внутрішньосхемного програмування. Архітектура ядра AVR 
оптимізована так, що дозволяє використовувати мову високого рівня С.  
На відміну від пристроїв PIC, де одна операція виконується за 4 такти, МК 
AVR можуть виконувати команди в кожному такті, тобто в 4 рази швидше 
на тій же тактовій частоті. А що менша частота, то менше енергоспожи-
вання мікроконтролера. 

Серед великих виробників мікроконтролерів потрібно виокремити  
такі фірми, як: Texas Instruments, Dallas Semiconductor, Philips, 
STMicroelectronics, Mitsubishi Electronics та ін. Однак корпорація Atmel є 
нині одним з визнаних світових лідерів у виробництві виробів сучасної  
мікроелектроніки. Вона добре відома на світовому ринку електронних 
компонентів. Заснована в 1984 році фірма Atmel визначила для своєї про-
дукції такі сфери додатків: телекомунікації та мережі, обчислювальна тех-
ніка, вбудовані системи контролю та управління, побутова техніка та  
автомобільний транспорт [15, 22]. Тому методи та засоби програмування 
мікроконтролерів AVR є актуальними.  

У навчальному посібнику комплексно розглянуті та актуалізовані 
апаратно-програмні засоби підтримки мікроконтролерів AVR, що має ва-
гоме значення для розробників вбудованих систем. 
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1 ПРОГРАМНІ ЗАСОБИ ПІДТРИМКИ ПРОЕКТУВАННЯ  
ТА ВІДЛАГОДЖЕННЯ СИСТЕМ 

 
1.1 Середовища розробки програмного забезпечення  

для мікроконтролерів AVR 
 

Процес написання програм для МК AVR як і для будь-яких інших, 
складається з декількох етапів: 

–  підготовка вихідного тексту програми якою-небудь мовою програ-
мування;  

–  компіляція програми;  
–  налагодження й тестування програми;  
–  остаточне програмування й підготовка до серійного виробництва. 
Мікропрограма пристрою має бути написана однією з мов програму-

вання. На сьогодні для МК AVR існують декілька мов програмування, а 
також різних засобів підтримки розробки, що використовують одну мову, 
але різняться за функціональністю. На кожному з етапів необхідне засто-
сування спеціальних програмних й апаратних засобів. Варто наголосити, 
що базовий набір програмного забезпечення (компілятор асемблера, ПЗ 
для програмування) поширюється фірмою Atmel безкоштовно. Однак за 
досить довгий період часу, що пройшов з моменту появи цих МК, з'явила-
ся велика кількість програмного забезпечення сторонніх виробників.  

 
1.1.1 Компілятори асемблера 
Вибір компілятора асемблера є найменш принциповим питанням, 

оскільки сам процес компілювання (перетворення вихідного тексту про-
грами в машинний код) виконується досить однозначно. Власне, усі  
відмінності між асемблерами полягають у можливостях процесора, що  
обробляє макрокоманди, наявності текстового редактора або середовища 
розробки й типу операційної системи, що підтримується AVR Studio. 

Досить вдалим вибором при розробці програмного забезпечення для 
МК набору AVR може стати інтегроване середовище розробки AVR Studio 
фірми Atmel [2, 8, 15, 20, 21, 23, 27], що містить у собі текстовий редактор 
з підсвічуванням синтаксису, компілятор асемблера, симулятор, відлаго-
джувач й інтерфейс із апаратними емуляторами. Програма розрахована на 
роботу під керуванням операційних систем Windows 7, 8, 10. До недоліків 
AVR Studio можна віднести деяку нестабільність роботи налагоджувача, а 
також неповну симуляцію периферійних пристроїв (зокрема, відсутня си-
муляція АЦП). До плюсів же належить, насамперед, підтримка практично 
всіх МК набору AVR. 

Atmel безкоштовно розповсюджує асемблер фірми IAR. Цей компіля-
тор є частиною IAR Embedded Workbench [16, 27] – середовище розробки, 
що містить менеджер проектів, редактор, лінкер і менеджер бібліотек. Цей 
компілятор відрізняється розширеними можливостями по роботі з макро-
сами.  
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GNU/Linux AVR Assembler повністю сумісний із компілятором фірми 
Atmel, має, порівняно з ним, кілька переваг. Він надається з відкритими 
текстами, так що користувач, якщо буде потреба, може легко додати нові 
можливості. І це один з декількох асемблерів для МК фірми AVR, що пра-
цюють під керуванням операційної системи Linux (до того ж, наявність 
вихідних текстів дозволяє легко перенести його на будь-яку іншу Unix-
систему). У GNU AVR Assembler значно розширені, порівняно з асембле-
ром фірми Atmel, можливості по роботі з макрокомандами (зокрема, допу-
скаються макроси усередині макросів). Програма поширюється за умовами 
GNU Public License (GPL) [2, 21, 27].  

 
1.1.2 Компілятори мови C 
Останнім часом усе популярнішим стає використання компіляторів 

мов високого рівня під час написання програм для МПС. Найбільшого по-
ширення при цьому одержали компілятори мови C, оскільки в цій мові 
найбільш просто реалізуються всі необхідні можливості з керування апара-
тними засобами МК.  

Компілятор фірми IAR є одним із кращих компіляторів C для МК на-
бору AVR. Пов'язано це з наявністю в ньому можливостей з оптимізації 
коду. Істотним його недоліком є те, що у демонстраційній версії наклада-
ються значні обмеження на максимальний обсяг коду. Компілятор дода-
ється у склад інтегрованого середовища розробки IAR Embedded 
Workbench (EWB), що містить компілятор асемблера, лінкер, менеджер 
проектів і бібліотек, а також відлагоджувач. Він може працювати сумісно з 
AVR Studio. 

Image Craft C Compiler [5, 14, 16] є другим за популярністю компіля-
тором мови C для МК набору AVR. До переваг цього компілятора можна 
віднести можливість підтримки мікросхем набору FPSLIC фірми Atmel, 
непоганий рівень оптимізації коду й досить низька ціна. Демо-версія ком-
пілятора не містить функціональних обмежень і лімітована тільки часом 
роботи (30 днів).  

Іншим популярним компілятором мови C для МК набору AVR є Code 
Vision AVR C Compiler [5, 14, 10, 16, 21, 27]. Компілятор підтримує МК 
ATTiny22, AT90S23x3, AT90S4433 та багато інших. Демонстраційна версія 
компілятора, так само, як і компілятор фірми IAR, має обмеження на мак-
симальний обсяг коду програми. Компілятор додається до інтегрованого 
середовища розробки, у якому крім стандартних можливостей, включена 
досить цікава функція – Code Wizard AVR Automatic Program. Фактично це 
генератор стандартних блоків програми, що виконує такі функції: 

–  налаштування доступу до зовнішньої пам'яті;  
–  ініціалізація портів введення/виведення, зовнішніх переривань, тай-

мерів, сторожового таймера;  
–  ініціалізація асинхронного порту послідовної передачі даних 

(UART) і  прийом, передачу даних через UART;  
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–  налаштування аналогового компаратора й АЦП;  
–  ініціалізація шини I2C і підключених до неї температурного датчика 

LM75 або годинника реального часу PCF8583, DS1302, DS1307;  
–  реалізація протоколу 1-Wire Bus й ініціалізація температурного дат-

чика DS1820;  
–  керування LCD-індикатором.  
Наявність цієї можливості спрощує написання програм. Наявність у 

середовищі розробки послідовного термінала дозволяє робити налаго-
дження програм з використанням послідовного порту UART МК. Крім C, 
при розробці програмного забезпечення для МПС застосовуються й інші 
мови високого рівня. Так, для МК набору AVR існують також компілятори 
мов Basic, Pascal і Forth [5, 21, 27]. 

Компілятор мови Basic, розроблений фірмою MCS Electronics. Є демо-
версія з обмеженням на обсяг коду програми. За вхідним кодом компілятор 
практично повністю сумісний з компіляторами VisualBasic/QuickBasic  
фірми Microsoft. У синтаксис мови додано кілька нових команд для забез-
печення підтримки LCD-індикаторів, I2C й 1-Wire інтерфейсів, оброблення 
переривань й інших специфічних для МК можливостей. 

ABC Basic Compiler, що розроблений фірмою Investments Technologies 
PTY, дозволяє писати й налагоджувати програми мовою Basic в інтегрова-
ному середовищі розробки. Існують версії компілятора як під Windows, так 
і під DOS. 

Microbasic i Mikropascal є потужними середовищами програмування 
для МК AVR. Такі середовища створені для полегшення роботи користу-
вача і поліпшення можливості роботи з МК набору AVR. Вони дозволя-
ють: 

–  писати код Basic та Pascal за допомогою редактора коду; 
–  використовувати бібліотеки для прискорення роботи з даними, 

пам’яттю, індикаторами, периферійними пристроями; 
–  бачити структуру програми, змінні й функції у редакторі коду, гене-

рувати прокоментовану, зрозумілу людині програму і сумісну з НЕХ-
файлами для будь яких програм. 

 
1.2 Інтегроване середовище розробки програм AVR Studio 

 
Фірмою «Atmel» розроблено програмний пакет підтримки розробок 

на AVR-мікроконтролерах в середовищі Windows – AVR Studio. AVR 
Studio – це інтегроване середовище відлагодження розробки програм 
(Integrated Development Environment – IDE), що містить транслятор мови 
асемблера AVR-мікроконтролерів, відлагоджувач програмного забезпе-
чення верхнього рівня для підтримки внутрішньосхемного програмування. 
Відлагоджувач AVR Studio підтримує всі типи мікроконтролерів AVR і 
має два режими роботи: режим програмної симуляції і режим управління 
різними типами внутрішньосхемних емуляторів виробництва фірми 
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«Atmel». Середовище відлагоджування підтримує виконання програм як у 
вигляді асемблерного тексту, так і у вигляді вихідного тексту мови С. AVR 
Studio поширюється вільно, його остання версія завжди доступна на сайті 
фірми «Atmel» [2, 8, 15, 20, 27]. Для запуску програми запустіть файл 
AVRStudio.exe. З'явиться основне діалогове вікно програми (рис. 1.1).  
У верхній частині програми знаходиться меню, у якому необхідно вибра-
ти Project→New Project (рис. 1.2). У новому вікні обирається ім’я проекту 
(Project name), місце на диску, де зберігається проект (Location), а також 
тип проекту (Project type). Для цього мишею обираємо AVR Assembler та 
натискаємо кнопку Next. 

 

 
 

Рисунок 1.1 – Основне вікно програми AVR Studio 
 

 
 

Рисунок 1.2 – Створення нового проекту  
у програмі AVR Studio 
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У вікні вибору платформи відлагодження та пристрою (Select debug 
platform and device) обираємо AVR Simulator та мікроконтролер, наприклад, 
Atmega8535і завершуємо процедуру вибору кнопкою Finish (рис. 1.3). 

 

 
 

Рисунок 1.3 – Вибір платформи відлагодження та типу мікроконтролера  
у середовищі AVR Studio 

 

 
 

Рисунок 1.4 – Вікно нового проекту  
у програмі AVR Studio 
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У вікні Project (див. рис. 1.4) обираємо файл з розширенням  *.asm та 
у вікні, що відкрилось, набираємо програму. Після того як програма напи-
сана, у верхньому меню обираємо Build та виконуємо її компіляцію, при 
цьому створюється файл з розширенням *.hex, який необхідно записати в 
мікроконтролер. Після компілювання з'явиться вікно Build, де зазначено, 
який файл асемблюється, файли бібліотеки, що використовуються, кіль-
кість слів у програмі та повідомлення про відсутність помилок Assembly 
complete with 0 errors, 0 warnings. Якщо є помилки, то в цьому вікні вказу-
ються тип помилки, номер рядка з помилкою і в кінці загальне число по-
милок. Для їхнього виправлення необхідно повернуться до редагованого 
файлу, а потім знову відкомпілювати програму. 

AVR Studio дозволяє не тільки компілювати програми, а й налагоджу-
вати їх на етапі розробки. При цьому AVR Studio емулює роботу мікрокон-
тролера, всіх портів введення/виведення, лічильників/таймерів, перери-
вань, ШІМ і АЦП. Емуляція роботи програми дозволяє розглянути її робо-
ту, якщо б вона була записана в мікроконтролер. 

Необхідно зазначити, що емулювати можна тільки роботу програми, 
яка не містить помилок. Тому перед емуляцією AVR Studio зробить компі-
ляцію програми, і якщо є помилки, то емулювати (відлагодити) програму 
неможливо. Для налагодження програми, після того як вона написана, пот-
рібно в меню Build вибрати пункт Build and run. Викликати вікно опцій 
емулятора (Simulation Options) у меню Debug→AVR Simulator Options.  
У пункті пристрій (Device) потрібно вибрати мікроконтролер ATmega8535, 
у пункті частота (Frequency) ‒ частоту 8 МГц, натиснути кнопку ОК 
(рис. 1.5). 

 

 
 

Рисунок 1.5 – Опції емулятора (Simulation Options)  
середовища AVR Studio 
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Після цього з'явиться вікно, де набиралася програма, початок програ-
ми буде зазначено жовтою стрілкою ‒ це початок програми, вище вказано 
директиви компілятора. При емуляції роботи програми необхідно бачити 
стан регістрів, портів введення/виведення (рис. 1.6). Для перегляду регіст-
рів у головному меню програми обираємо пункт перегляд (View), потім 
пункт регістри (Registers), для перегляду стану процесорного ядра викори-
стовується панель процесор (View→Toolbars→Processor), порти введен-
ня/виведення і периферійні модулі зручно спостерігати через панель вве-
дення/виведення (View→Toolbars→I/O). У меню View є й інші пункти, що 
можна використовувати: пам'ять (Memory) для перегляду пам'яті даних і 
програм. 

 

 
 

Рисунок 1.6 – Вікно емуляції роботи програми в AVR Studio 
 

AVR Studio дозволяє запустити програму в реальному часі у покроко-
вому режимі до покажчика. У головному меню в пункті налагодження 
(Debug) знаходяться всі варіанти запуску програми. Reset – скидання на 
початок програми (жовта стрілка покажчика показує на початок); Go –  
запуск у реальному часі (програма буде виконуватися до тих пір, поки не 
буде обраний пункт Break); Step over – покроковий режим (програма вико-
нується через рядок, при цьому зупиняється після кожної команди, стрілка 
вказує на поточну команду); Run to cursor – виконувати до курсора  
(програма виконується до місця зазначеного курсором у вікні з редагованої 
програмою). Під час виконання програми можна спостерігати за станом 
регістрів після кожної команди ‒ так перевіряється правильність операцій, 
що виконується мікроконтролер. Найбільш зручний режим для цього ‒  
покроковий. 

12 



На панелі Input/Output View, де наведені всі пристрої мікроконтроле-
ра, навпроти кожного пристрою є знак «+»; клацнувши на ньому мишкою, 
отримуємо вміст цього пристрою, тобто стан регістрів, регістрів даних і 
т. д. Два рази клацнувши на змісті якого-небудь регістра, можна змінити 
його стан в процесі виконання програми. У регістрах портів введен-
ня/виведення можна задати вхідні сигнали. Для цього позначають галоч-
кою потрібний біт стану (логічна одиниця), так емулюється вплив зовніш-
ніх сигналів. 

До Atmel Studio 7 входить бібліотека Atmel Software Framework (ASF), 
і являє собою колекцію готового до використання початкового коду та  
більше 1600 прикладів проектів, що створені та оптимізовані експертами  
та випробувані в промислових системах. Наявні у складі колекції драйвера 
периферійних пристроїв, комунікаційні стеки та спеціальні прикладні біб-
ліотеки прискорюють та спрощують розробку проектів. 

 
1.3 Робота в інтегрованому середовищі  

розробки програм WinAVR 
 

Відкрийте програму Programmers Notepad (PN), що входить до складу  
WinAVR та виберіть новий C/C++ файл (рис. 1.7). 

 

 
 

Рисунок 1.7 – Створення нового файлу  
в редакторі Programmers Notepad 

 
Створіть папку проекту, наприклад D:\prj. У PN наберіть код  

і збережіть файл у папку проекту під ім’ям simple.c. 
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#include <AVR/io.h> 
#include <stdint.h> 
// Підключення необхідних бібліотек  
void main(void)  
{ MCUCR = 0xA0; //Дозволити роботу зі зовнішньою пам'яттю  
 unsigned char* const pLeftInd = 0xA000; 
 //Покажчик на комірку пам'яті за адресою 0xA000 
  *pLeftInd = 0x66; 
 while (1)  
 {   
 // Нескінчений цикл 

} 
} 
 

Для компілювання програми в середовищі WinAVR використовується 
один з найпотужніших і найгнучкіших компіляторів – GCC. І саме через 
свою універсальність він має дуже багато налаштувань, які для компілю-
вання програми можна кожний раз вводити через командний рядок, а мож-
на один раз записати у спеціальний makefile.  

 

 
 

Рисунок 1.8 – Вибір типу мікроконтролера для створення makefile 
 

Після компілювання буде створено об’єктний файл у форматі опера-
ційної системи Linux (ELF). Цей об’єктний файл необхідно перетворити у 
формат HEX. Ця дія забезпечується за допомогою лінковщика, який зок-
рема може бути викликаний з командного рядка, або керуватися налашту-
ваннями makefile. Тож найкращий вихід побудови файлу програми – це 
побудова з використанням makefile. Створити makefile можна або вручну, 
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або за допомогою спеціального генератора. У ролі генератора мейкфайлів 
буде використовуватись опція Mfile (рис. 1.9). 

Для створення makefile проекту виконуються такі кроки: 
1. Завантажуємо програму Mfile (входить до складу WinAVR) і 

вибираємо тип МК (див. рис. 1.8). 
2. У меню Output format виберіть ihex (Intel HEX). 
3. У меню C standard level – gnu99. 
4. Збережіть файл у директорію проекту. Файл обов’язково має 

містити ім’я makefile. 
5. Додайте до makefile запис про вихідний текст програми, що 

знаходиться у файлі simple.c.  
 

 
 

Рисунок 1.9 – Налаштування makefile  
 

Зробити це можна за допомогою діалогу, що викликається при виборі 
пункту меню C/C++ source file(s). Але ця частина програми працює не  
завжди коректно, і тому, якщо змін файлу не сталося (зміни у makefile під-
свічуються жовтим кольором), цей параметр потрібно встановити вручну. 
Для цього поставте прапорець на пункті меню Makefile→Enable Editing of 
Makefile.  

Знайдіть параметр TARGET та встановіть його значення: TARGET = 
simple. Знайдіть параметр SRC і встановіть його значення: SRC = simple.c. 
Приберіть значення параметра CPPSRC. Необхідні налаштуваня наведені на 
рис. 1.9. Збережіть вміст makefile. 

Компіляція та лінкування. Після виконаних дій у директорії проекту 
з’являться 2 потрібних файли (рис. 1.10): simple.c і makefile.  
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Рисунок 1.10 – Файли проекту 
 

Тепер потрібно створити виконуваний файл програми (ihex), що зро-
зумілий МК: 

1. Відкривається вихідний текст програми в редакторі PN. 
2. Обираємо пункт меню Tools→[WinAVR] Make Clean (рис. 1.11). 

 

 
 

Рисунок 1.11 – Виконання make clean 
 

Ця дія запускає спеціальну утиліту make, що згідно з параметрами має 
очистити всі зайві файли, що могли залишитися від попереднього компі-
лювання. Під час виконання команди у нижній частині PN з’явиться вікно 
“Output” (рис. 1.12), що буде інформувати про перебіг виконання команди. 
Операція вважається успішною, якщо ви побачите внизу рядок: 

“> Process Exit Code: 0” 
Якщо значення Process Exit відмінне від нуля – це означає, що сталася 

помилка. Для операції "make.exe" clean помилку потрібно шукати у непра-
вильній конфігурації мейкфайлу. Якщо операція пройшла успішно, то ви-
конуємо побудову виконуваного файлу. Для цього виберіть пункт 
Tools→[WinAVR] Make all. Якщо результат компілювання успішний,  
і є таке повідомлення “Process Exit Code: 0”, це означає, що необхідний 
hex-файл був побудований без помилок. Інакше – помилки знаходяться у 
тексті програми. Усю необхідну інформацію про місце виникнення помил-
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ки можна дізнатися з вікна “Output”. Компіляція та лінкування програми 
завершена. Якщо результат операції був успішним, то в директорії проекту 
з’являться такі нові файли: 

– simple.eep – містить інформацію, що буде скопійована в EEPROM; 
– simple.elf – об’єктний файл. Саме на основі інформації цього файлу 

буде створений виконуваний файл; 
– simple.hex – виконуваний файл. Програма в кодах МК; 
– simple.lss – містить інтерпретацію відкомпільованої програми мо-

вою Асемблер; 
– simple.map, simple.sym – допоміжні файли, що описують хід компі-

лювання та лінкування проекту. 
 

 
 

Рисунок 1.12 – Результати роботи операції "make.exe" clean 
 

1.4 Робота в інтегрованому середовищі розробки ICCAVR 
 

Середовище програмування ICCAVR (рис. 1.13) фірми ImageCraft 
Creations Inc призначена для розробки програмного забезпечення (проекту) 
та його компілювання e виконуваний AVR-мікроконтролерів файл. 
ICCAVR є одним з найпростіших і дуже зручних компіляторів. Він має на-
бір стандартних бібліотечних функцій і низку підпрограм, спеціально при-
значених для AVR-мікроконтролерів. Їх можна використовувати у своєму 
проекті, попередньо підключивши їх до проекту директивою #include. У 
роботі ICCAVR використовуються такі типи файлів: 
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– С – вихідний текст мовою С; 
– S – вихідний текст мовою Assembler, що генерується для кожного 

вихідного С-файлу;  
– H – заголовки (header) файл; 
– PRJ – файл проекту; 
– SRC – список файлів проекту; 
– O – об'єктний файл, який утворюється після компілювання асемб-

лерного файлу; 
– HEX – вихідний файл у форматі Intel HEX для завантаження у мік-

роконтролер; 
– EEP – вихідний файл у форматі Intel HEX для завантаження в ПЗП 

даних мікроконтролера; 
– COF – вихідний файл у форматі COFF, використовується при нала-

штуванні проекту в AVR Studio або інших середовищах програ-
мування; 

– LST – файл-лістинг, що містить інформацію про адреси; 
– MP – MAP-файл, який містить символічну інформацію; 
– DBG – файл з налаштування;  
– A – бібліотечний файл. 

 

 
Рисунок 1.13 – Головне вікно ICCAVR  

 
Після запуску ICCAVR на екрані монітора з'являється головне вікно, 

яке розділене на три частини (вікна). Ліва верхня частина – вікно редактора. 
У ньому представлені тексти програм, які утворюють проект. Саме з цими 
текстами і працює програміст, редагуючи їх або додаючи нові рядки та бло-
ки програм. При першому запуску ICCAVR вікно, як правило, порожнє. 
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Права частина – вікно менеджера проекту, що містить дві вкладки: 
Project та Browser. Перша містить список файлів проекту, кожен з яких  
можна відкрити у вікні редактора подвійним клацанням миші. Друга вклад-
ка – оглядач коду, що показує список функцій та змінних, визначених у 
проекті. Нижня частина – вікно стану. У ньому показуються результати 
компілювання окремого файлу або всього проекту в цілому. Якщо є помил-
ки, то після компілювання з'являться повідомлення про виявлені помилки із 
зазначенням їхнього місця розташування і підказкою про тип помилки. Усі 
свої дії з управління проектом або окремими файлами користувач здійснює, 
використовуючи пункти меню у верхній частині головного вікна, кнопки 
панелі інструментів (під пунктами меню) або праву кнопку миші й сплива-
юче при цьому контекстне меню.  

Меню Project дозволяє відкрити будь-який проект або створити новий; 
відкрити або закрити всі файли проекту; відкрити один з останніх проектів, 
з яким працював користувач; закрити проект або зберегти його під новим 
ім'ям; додати відкритий у вікні файл у проект або видалити з проекту файл, 
який обраний у вікні менеджера проекту. Пункт Make Project дозволяє 
здійснити компіляцію відкритого у вікні редактора файлу, а пункт Rebuild 
All – компіляцію всіх файлів проекту. Важливим пунктом є Option, який 
відкриває діалогове вікно (рис. 1.14). У пункті Target у вікні Device 
Configuration необхідно задати мікроконтролер, для якого розробляється 
проект, наприклад ATmega128/CAN128 (рис. 1.14). У пункті Paths необхід-
но встановити шляхи до бібліотечних файлів і файлів, які користувач підк-
лючає до проекту, наприклад, для бібліотечних файлів c:\icc\lib\. У пункті 
Compiler у вікні Output Format встановити формат вихідних файлів ‒ 
COFF/HEX. 

 

 
 

Рисунок 1.14 – Вікно при виборі пункту меню Project→Option  
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У пункті Tools головного вікна важливими є три пункти: Editor 
Options, Application Builder і In System Programmer. Пункт Tools→Editor 
Options дозволяє встановити необхідні параметри для редактора тексту. 
Тут краще все залишити без змін. Але якщо виникає необхідність писати 
коментарі в програмі російською мовою, то в пункті Tools→Editor 
Options→Highlighting необхідно у вікні Characters установити опцію 
Russian. Пункт Tools→Application Builder призначений для ініціалізації  
периферійних пристроїв мікроконтролера, а також для налаштування сис-
теми зовнішніх переривань. Налаштування периферійних пристроїв можна 
виконати і вручну, присвоївши в програмі відповідним регістрів управлін-
ня і статусу потрібні значення. Однак за допомогою модуля Application 
Builder ця ініціалізація здійснюється набагато швидше і надійніше. Вікно 
Application Builder з опціями налаштування портів введення/виведення  
зображено на рис. 1.15. 

 

 
 

Рисунок 1.15 – Вікно Application Builder  
з опціями налаштування портів введення/виведення 

 
Як приклад на рис. 1.15 показана ініціалізація портів A, B, C і D, а для 

портів E, F і G ‒ стан регістрів напрямку DDRx та даних PORTx (х = E, F, G) 
залишено без змін. Видно, що всі виводи портів (за винятком 4-х старших 
у порту В і 4-х молодших у порту С) налаштовані на вхід. До того ж, у ви-
водів 3, 4 та 5 порту А та у всіх виводів порту D підключені резистори 
PushUp. У результаті Application Builder згенерує програмний код з функ-
цією void port_init (void), при виконанні якої у всіх регістрах DDRx і 
PORTx будуть присвоєні значення, що відповідатимуть заданим користу-
вачем встановленням (рис. 1.15). 
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Так, за допомогою Application Builder можна налаштувати роботу сис-
теми зовнішніх переривань, таймерів/лічильників, усіх інтерфейсів 
(USART, SPI, TWI), АЦП, компаратора, а також вирішити низку інших  
завдань, пов'язаних з роботою пам'яті EEPROM, сторожового таймера. 
Якщо дозволені якісь переривання, наприклад, від таймерів або USART, то 
Application Builder генерує програмний код, що містить шаблони функцій 
для оброблення цих переривань. 

Пункт Tools→In System Programmer призначений для «прошивки» 
HEX-коду програми в пам'ять мікроконтролера за допомогою програмато-
рів.  

Розглянемо послідовність дій при створенні нового проекту. Для  
початку створимо робочу папку, в якій будуть зберігатися всі файли проек-
ту. Потім виберемо пункт меню Project→New і у вікні, задаємо ім'я проекту 
та шлях до нього. У вікні менеджера з'явиться ім'я нового проекту і порожні 
папки для зберігання С-файлів, Н-файлів та файлів для документів,  
наприклад, у текстовому форматі. 

Далі необхідно провести налаштування проекту, установивши за  
допомогою Project→Options→Target у вікні Device Configuration потрібний 
тип мікроконтролера, наприклад, ATMega128/CAN128. За допомогою 
Project→Options→Paths можна у вікні Library Path установити шлях до 
стандартних бібліотечних файлів, а  у вікні Include Paths – шляхи підклю-
чення файлів до проекту. Ці файли знаходяться в папках icc\lib та 
icc\include, які, насамперед, знаходяться в папці, де встановлений компіля-
тор ICCAVR. Якщо це не перший проект, який створюється на такому 
комп'ютері, то правильні шляхи до бібліотек вже встановлені, треба тільки 
це перевірити. 

Підключаємо файл з вихідним кодом, попередньо обравши пункт 
File→New. Можна написати вихідний код безпосередньо у вікні редактора. 
У цьому випадку дуже корисна комбінація клавіш Ctrl + J, яка відкриває 
вікно з шаблонами операторів. Використання цієї комбінації клавіш допо-
може уникнути синтаксичних помилок при розробці програм. 

Якщо текст програми (С-файл) вже є і його треба лише відредагувати, 
то можна відкрити цей файл та зробити необхідні виправлення. Якщо  
програма складна, то варто скористатися Tools→Application Builder. Він 
здійснить початкову ініціалізацію периферійних пристроїв та згенерує  
початковий фрагмент програмного коду, який користувач може допрацьо-
вувати на свій розсуд. Необхідно пам'ятати, що після виклику Application 
Builder в пункті CPU необхідно встановити тип мікроконтролера, напри-
клад, M128 (скорочення від ATMega128) та частоту синхронізації Xtal speed, 
наприклад, 11.059MHz. Усі інші периферійні пристрої налаштовуються 
(або не налаштовуються) відповідно до вирішуваних в такій програмі  
завданнями. Зазвичай, цей фрагмент коду закінчується функцією 
init_devices. Ім'я цієї функції необхідно вставити в текст головної функції 
програми main однією з перших (відразу після оголошення змінних у  
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функції main), так як саме з ініціалізації периферійних пристроїв почина-
ється виконання програми. Варто пам'ятати, що в програмі обов'язково має 
бути головна функція з ім'ям main, інакше компілятор буде видавати пові-
домлення про помилку. 

Після створення вихідного файлу, розробленого мовою С, його необ-
хідно зберегти в робочій папці. Після цього потрібно додати файл до  
проекту, використовуючи, наприклад, праву кнопку миші й контекстне 
меню. У результаті у вікні менеджера проекту в папці Files з'явиться ім'я 
першого файлу проекту. До проекту можна додавати нові С-файли або  
Н-файли, попередньо обравши папку Headers. Так, створюється проект, що 
містить кілька файлів. Така модульна структура проекту дозволяє краще 
сприймати його алгоритм функціонування. Для контролю помилок при  
розробці програми необхідно періодично здійснювати компіляцію окремо-
го файлу або всіх файлів проекту. Успішне компілювання закінчується  
повідомленням Done, неуспішне – повідомленнями про помилки та додат-
ковою інформацією про суть цих помилок і їхнє місцезнаходження в про-
грамі. 

 
1.5 Робота в інтегрованому середовищі  

розробки CodeVisionAVR 
 
CodeVisionAVR ‒ інтегроване середовище розробки програмного  

забезпечення для мікроконтролерів набору Atmel AVR (рис. 1.16).  
 

 
 

Рисунок 1.16 – Вікно програми CodeVisionAVR 
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CodeVisionAVR містить такі компоненти: компілятор мови С для 
AVR; компілятор мови асемблер для AVR; генератор початкового коду 
програми, що дозволяє провести ініціалізацію периферійних пристроїв; 
модуль взаємодії налагоджування платою STK-500; модуль взаємодії з 
програматором; термінал. Вихідними файлами CodeVisionAVR є: HEX, 
BIN або ROM-файл для завантаження в мікроконтроллер за допомогою 
програматора; COFF-файл, що містить інформацію для усунення несправ-
ностей; OBJ-файл. Середовище CodeVisionAVR є дуже популярним сере-
довищем програмування мікроконтролерів AVR. Проект можна створюва-
ти як з нуля, так й за допомогою майстру коду (Code Wizard AVR).  

Для створення проекту запускаємо середовище CodeVisionAVR C 
Compiler та обираємо меню File→New. У формі Create New File обираємо 
Project (проект) та на пропозицію створити код за допомогою майстра – 
обираємо No (рис. 1.17). Зберігаємо проект як Prog1. Обираємо мікроконт-
ролер, визначаємо тактову частоту (рис. 1.18). 

 

 
 

Рисунок 1.17 – Створення нового проекту в CodeVisionAVR 
 

 
 

Рисунок 1.18 – Вікно налаштування властивостей проекту 
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Список File Output Format(s) (див. рис. 1.18) визначає, які файли  
будуть створені при компілюванні проекту. Цікавлять два файли: файл 
HEX, який записується в мікроконтролер, та файл COF, що відкривається  
в середовищі AVR Studio та за допомогою симулятора дозволяє проаналі-
зувати роботу програми. Знов обираємо File→New та File Type→Source.  
З’явилось пусте вікно коду, зберігаємо його як Prog1.c. Відкриваємо вікно 
Configure Project  та на вкладці Files додаємо створений файл Prog1.c 
(рис. 1.19). 

 

 
 

Рисунок 1.19 – вікно Configure Project 
 

Далі у вікні коду набираємо код програми залежно від задачі, що 
розв’язується (рис. 1.20). 

 

 
 

Рисунок 1.20 – Вікно коду програми Prog1.c. 
 

Компілюємо проект, для виявлення можливих помилок та попере-
джень компілятора. У процесі компілювання створюється початковий файл 
асемблера Prog1.asm, який можна відкрити редактором для перегляду та 
внесення необхідних змін. На стадії компілювання файли COF, ROM, 
HEX, EEP не створюються. Виконуємо остаточне збирання проекту, при 
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цьому створюються готові до використання файли COF, ROM, HEX, EEP. 
Якщо проект створюється за допомогою майстра коду (CodeWizardAVR), 
то після необхідних установок на вкладках (рис. 1.21), то в меню File  
майстра обираємо Generate, Save and Exit (рис. 1.22), то виконуємо необ-
хідні збереження. Переглянути попередній код, що створює майстер, мож-
на шляхом вибору у меню File командного рядка Program Preview! 

 

 
 

 

Рисунок 1.21 – Вікно налаштувань 
CodeWizardAVR 

 

 

Рисунок 1.22 – Вікно налаштувань 
CodeWizardAVR;  

збереження та вихід з майстра коду 
 

1.6 Робота в інтегрованому середовищі  
розробки AVR Builder 

 
Середовище призначене для створення повного циклу розробки. Роз-

робка програми може виконуватись як на рівні асемблера, так і на макро-
рівні з маніпуляцією багатобайтними величинами зі знаком. На відміну від 
класичного асемблера, програма вводиться у вигляді алгоритму з дерево-
подібними розгалуженнями і відображається на площині у двох вимірах. 
Мережа умовних і безумовних переходів відображається графічно у зруч-
ній векторній формі. Уся логічна структура програми стає наглядною.  
Візуальність логічної структури зменшує ймовірність помилок і скорочує 
строки розробки. Для налаштування периферійних пристроїв (таймери, 
UART, ADC, SPI) передбачений спеціальний елемент алгоритму –  
«налагоджувач» з віконним інтерфейсом. У ньому досить вибрати необ-
хідні параметри роботи пристрою, а набір інструкцій, що забезпечують ці 
параметри, сформує компілятор (у правій частині вікна). Підтримується 
автоматичне перекодування рядків ANSI-кодів Windows у коди русифіко-
ваного буквено-цифрового LCD-індикатора [3, 27].  

Середовище поєднує в собі графічний редактор, компілятор алгорит-
му, симулятор МК та програматор. При використанні програматора МК 
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підключається до COM порту комп'ютера через нескладний адаптер. 
Algorithm Builder забезпечує моніторне відлагодження на кристалі (On 
Chip debug), що дозволяє спостерігати вміст реального кристала в заданій 
точці зупину. При цьому, для зв'язку МК з комп'ютером використається 
тільки один вивід, на вибір користувача. Моніторне відлагодження може 
бути застосоване до будь-якого типу кристала, що має SRAM. Будь-яке 
програмне забезпечення можна розбити на окремі логічно завершені фраг-
менти. Як правило, останнім оператором цих фрагментів є такі оператори, 
як безумовний перехід або повернення з підпрограми, тобто оператори, 
після яких лінійне виконання програми однозначно припиняється. Розроб-
ка програмного забезпечення в середовищі Algorithm Builder зводиться  
до формування таких блоків, розміщення їх на площині й установлення 
між ними векторних зв'язків з умовних і безумовних переходів. Основний 
інтерфейс програми зображено на рис. 1.23. 

 

 
 

Рисунок 1.23 – Вікно програми AVR Builder 
 

Для побудови алгоритму в Algorithm Builder передбачено 7 елементів: 
− Text (рядок локального текстового редактора); 
− Vertex (вершина блоку); 
− Field (поле); 
− Label (мітка); 
− Condition (умовний перехід); 
− Jmp Vector (відносний безумовний перехід); 
− Setter (налагоджувач периферійних пристроїв). 
Усі елементи знаходяться на панелі інструментів для швидкого досту-

пу до них та зручного використання (рис. 1.24).  
Елемент «Text» являє собою текстовий рядок, що починається від  

лівого краю поля алгоритму. Сукупність із декількох таких рядків утворює 
локальний текстовий редактор, обведений пунктирними лініями. Правила 
роботи в ньому, аналогічні іншим текстовим редакторам. 

Рядки призначені для запису в них ряду директив компілятора, а  
також для коментарів. Для додавання нового рядка текстового редактора 
потрібно вибрати меню «Элементы→Текст», або натиснути клавіші 
«Alt+T». Також можна натиснути кнопку «Т» на панелі інструментів.  
Коментарі мають позначатися двома слешами: «//». 

Елемент «Label» являє собою вертикальний штрих, розташований 
усередині блоку операторів, і необов'язкове ім'я, що розташовується ліво-
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руч або праворуч від штриха. Мітка призначена для позначення місць в 
алгоритмі, куди можливе здійснення умовних і безумовних переходів. Така 
реалізація значно спрощує розробку програми, так як код стає більш зро-
зумілим, ніж у звичайній програмі на Assembler. 

Для додавання мітки в блок використовується пункт меню «Элемен-
ты→Метка», або ж натисканням клавіші «Alt+L», або кнопкою «L» на  
панелі інструментів. 

Елемент «Vertex» за своїм змістом й призначенням повністю ідентич-
ний мітці, але на відміну від неї, задає розташування блоку на робочій 
площині й завжди є його початком. Створення нової вершини виконується 
з пункту меню «Элементы→Вершина», або ж викликом гарячої клавіші 
«Alt+V», або натисканням кнопки «V» на панелі інструментів. 

Елемент «Field» являє собою рядок у блоці. Об'єкт призначений для 
запису більшості операторів МК. Щоб додати поле, потрібно вибрати 
пункт меню «Элементы→Поле», або натиснути кнопку «F» на панелі  
інструментів, або комбінацією клавіш «Alt+F», або клавішею «Enter» у  
випадку, якщо курсор перебуває поза локальним текстовим редактором. 

Елемент «Condition» призначений для реалізації умовних переходів. 
Являє собою овальний контур, усередині якого вписується умова переходу 
й можливий вектор у виді ламаної лінії зі стрілкою на кінці, біля якої мож-
ливо необов'язкове ім'я вектора. Кінець вектора має: 

− закінчуватися на якій-небудь мітці; 
− закінчуватися на вершині блоку; 
− закінчуватися на відрізку іншого вектора; 
− мати ім'я адресованої мітки. 

Проведення вектору до потрібного місця відбувається натисканням 
лівої кнопки миші при натиснутій клавіші «Alt». Для редагування вектора 
використовуються клавіші напрямку в комбінації із клавішею «Alt». Щоб 
ввести новий об'єкт, варто обрати пункт меню «Элементы→Условие»,  
натиснути клавіші «Alt+C» або кнопку на «С» панелі інструментів. 

Елемент «JMP Vector» призначений для реалізації коротких безумов-
них переходів (у базовому асемблері це оператор «RJMP»). Являє собою 
ламану лінію, що виходить із середини блоку зі стрілкою на кінці, аналогіч-
ну вектору об'єкта «Condition». Щоб додати новий безумовний перехід, пот-
рібно вибрати пункт меню «Элементы→Вектор б/у перехода», натиснути 
комбінацію клавіш «Alt+J» або кнопку «J» на панелі інструментів. 

Елемент «Setter» являє собою сірий прямокутник, усередину якого 
вписане ім'я периферійного компонента МК такого, як таймер, АЦП,  
регістр маски переривань та ін. Настроювач призначений для формування 
послідовності операцій МК, які забезпечують завантаження необхідних 
констант у відповідні керуючі регістри введення/виведення відповідно до 
обраних властивостей. 

Перед використанням цього елемента потрібно визначити тип МК. 
Для додавання настроювача в алгоритм потрібно обрати пункт меню 
«Элементы→Настройщик», натиснути клавіші «Alt+S» або кнопку «S» на 
панелі інструментів. 
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Об'єкт «Setter» є макро-оператором. Після компілювання він перетво-
риться в послідовність команд МК, які забезпечують завантаження необ-
хідних констант у відповідні регістри керування. У цих операціях буде  
використаний регістр R16. 

Для ряду компонентів, наприклад ADC, настроювач може впливати на 
декілька регістрів керування. У такому разі, за необхідності, вплив на кож-
ний конкретний регістр можна заблокувати. 

Для створення нового проекту в програмному середовищі AVR 
Builder потрібно вибрати пункт меню «Файл→Новый». При цьому в робо-
чій області програми з’явиться елемент «Текст», «Вершина блоку» та еле-
мент «Поле» з пустим оператором NOP (рис. 1.24). 

 

 
 

Рисунок 1.24 – Порожній проект AVR Builder 
 

Розглянемо застосування AVR Builder на прикладі програми «бігучий 
вогонь». Алгоритми  програми наведений на рис. 1.25. Цей алгоритм почер-
гово виводить логічні одиниці в біти порту В. З лівої сторони відображено 
алгоритм основної програми, а з правої – алгоритм підпрограми затримки.  
Запис даних до регістрів відбувається за допомогою вказівки «->».  

 

 
 

Рисунок 1.25 – Алгоритм програми «Бігучий вогонь» в AVR Builder 
 
Для створення нового поля використовується клавіша «Enter», а для 

його видалення комбінацію клавіш «Ctrl+Del». Помітка біля оператора 
«250→r18» означає точку зупину для симулятора. Додається вона за допо-
могою клавіші «F5» або ж відповідною піктограмою на панелі інструментів. 
Після завершення роботи над алгоритмом програми необхідно визначити 
тип МК, після чого можна буде скомпілювати програму. Для цього потрібно 
скористатися пунктом меню «Опции→Опции проекта» та на закладці «Кри-
сталл» обрати потрібний МК. Обираємо МК AT90S2313 (рис. 1.26). 
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Після виконання цих дій можна скомпілювати програму та запустити 
на виконання в симуляторі. Для цього використовується клавіша «F9». 
Якщо в програмі відсутні помилки, то запуститься симулятор. Якщо ж по-
милки є, то про це буде повідомлено.  

Для спостереженням за станом МК під час виконання програми в 
AVR Builder передбачені вікна моніторингу (рис. 1.27). Їх можна виклика-
ти через пункт меню «Открыть». Для відстеження стану МК у цьому алго-
ритмі достатньо відкрити вікна «Processor», «Working Registers» та «I/O 
Registers→ Port B». При запуску симулятора вміст регістрів SRAM автома-
тично заповнюється випадковими числами, тому що в реальному часі їх 
вміст неможливо передбачити з появою напруги живлення. Синя мітка  
біля оператора (рис. 1.28) – це поточне положення програмного лічильни-
ка. Вона вказує на оператор, який буде виконаний далі. Після компілюван-
ня програми та запуску симулятора вона автоматично встановлюється біля 
першого оператора. 

 
Рисунок 1.26 – Опції проекту  

AVR Builder 

 
Рисунок 1.27 – Вікно стану процесора, 

стану регістрів, стану порту В 

 
 

Рисунок 1.28 – Вікно симулятора AVR Builder 
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Для покрокового виконання програми використовується клавіша 
«F7». Покрокове виконання без входу в підпрограму виконується за допо-
могою клавіші «F8». Виконання алгоритму до виходу з підпрограми вико-
нується клавішею «F6». Запуск на необмежене виконання до точки зупину 
виконується клавішею «F9», а виконання до виділеного елемента клавішею 
«F4». При цьому виконання алгоритму може бути призупинено натискан-
ням клавіші «F2». Для більш зручного використання програми передбачені 
спеціальні кнопки на панелі інструментів симулятора, які відповідають 
вищезазначеним функціям. Під час виконання алгоритму у вікні моніторин-
гу порту В спостерігається почергова поява логічних одиниць на виходах. 

1.7 Робота в інтегрованому середовищі 
розробки FLOWCODE 

У сучасному світі швидкість розробки програмного забезпечення є 
одним з головних чинників успішності продукту на ринку. З появою і ши-
роким упровадженням пристроїв на базі мікроконтролерів (MCU) з'явилася 
проблема прискорення процесу написання програмного забезпечення для 
таких систем. Одним із способів вирішення цієї задачі є застосування сере-
довищ візуального програмування. Яскравим представником подібних за-
собів розробки є програмний комплекс FlowCode від компанії Matrix 
Multimedia [7, 25]. FlowCode – це середовище розробки із зрозумілим 
графічним інтерфейсом, що використовує мову програмування на основі 
об'єктів і блок-схем. Реалізація технології Drag and Drop дозволяє з легкіс-
тю створювати програми простим перетягуванням необхідних іконок, а 
блок-схемний підхід до написання програми підвищує її наочність та 
структурованість. Таке середовище програмування дозволяє створювати 
код для мікроконтролерів AVR, ARM і PIC, які є на сьогодні найпошире-
нішими. У ньому є готові бібліотеки програмного коду для різних перифе-
рійних модулів таких, як USART, SPI, ADC, а також різних компонентів, 
що, як правило, входять до складу пристроїв на основі мікропроцесорів 
(світлодіодні індикатори, LCD, крокові двигуни) (рис. 1.29).  

Така можливість дозволяє зобразити ці блоки як окремі елементи 
(рис. 1.30), які мають відповідні входи і виходи, що істотно скорочує час 
на реалізацію коду. Досить просто додати звернення до потрібного модуля 
з програми. Ще однією корисною функцією такої програми є відкрита ар-
хітектура, яка дає можливість отримати лістинг мовою Асемблер і С. За 
необхідності  
його можна відредагувати, що особливо актуально в додатках, де потрібна 
максимальна продуктивність. Також можна перевірити код на наявність 
логічних помилок за допомогою вбудованого відлагоджувача, який дозво-
ляє візуалізувати такі процеси, як: вивід інформаціїї на LCD дисплей, 
обертання крокового двигуна і т. д. 

30 



Ри
су

но
к 

1.
29

 –
 З

ов
ні

ш
ні

й 
ви

гл
яд

 п
ро

гр
ам

и 
Fl

ow
C

od
e 

31 



 
 

Рисунок 1.30 – Призначення елементів інтерфейсу програми FlowCode  
 

1.8 Робота у програмному симуляторі Proteus VSM 
 

Для розробки і налагодження МПС потрібні прилади, які здатні вико-
нувати функції вимірювання напругу і струму, можуть відтворювати фор-
му сигналу, подавати імпульси певної форми і т. д.; подавати послідовність 
сигналів одночасно на декілька входів відповідно до заданої часової діаг-
рами або заданого алгоритму функціонування; збирати значення сигналів 
багатьох ліній протягом одного і того ж проміжку часу, який визначається 
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подіями, що задаються комбінацією або послідовністю сигналів на лініях; 
обробляти і представляти зібрану інформацію або у вигляді часової діаг-
рами, або у вигляді таблиці логічних станів, або мовою високого рівня. Для 
автономного налагодження широко використовуються осцилографи, 
вольтметри, амперметри, частотоміри, генератори імпульсів і кодів, що  
дозволяють виконувати це для апаратури на схемному рівні. Для здійснен-
ня комплексного налагодження МПС використовують логічні аналізатори, 
налагоджувальні й діагностичні комплекси. 

Процес моделювання має бути максимально наближений до реальнос-
ті. У такому разі користувач здійснює природну послідовність таких дій, 
як складання схеми, підключення вимірювальних приладів, встановлення 
режимів роботи вимірювальних приладів, отримання режимів роботи в 
звичній для нього формі. Таку можливість надає програма Proteus VSM [9, 
11, 19, 26, 27]. 

На відміну від багатьох інших, ця програма здатна моделювати  
пристрої не тільки на дискретних компонентах, звичайних аналогових і 
цифрових мікросхемах, а й на МК серії AVR, 8051, PIC12, PIC16, PIC18, 
Z80, 68000. Програма містить велику кількість бібліотек напівпровіднико-
вих пристроїв, пасивних компонентів, ламп, індикаторів (світлодіоди,  
семисегментні, LCD), кнопок, клавіатур, динаміків, мікрофонів, джерел 
струму, напруги, генератори спеціальних сигналів тощо. 

Пакет Proteus складається з двох програм: ISIS – моделювання елект-
ронних схем та ARES – програма створення друкованих плат. У ISIS пе-
редбачена покрокове налагодження МПС, можливість анімації елементів 
схем. Розглянемо налагодження пристрою на МК AVR AT90S8515 і інтер-
фейсом 1-Wire, по якому підключаються DS1990, DS18S20 та інші 1-Wire 
прилади [9, 11, 19, 27]. Запускаємо PROTEUS і в меню File→Load Design 
перейдемо на один рівень вверх ‒ у папку, де встановлений PROTEUS і 
відкриваємо папку SAMPLES. У ній знаходимо і відкриваємо файл проек-
ту One-Wire→NETWORK→1WIRE_NET.DSN. Розгорніть вікно PROTEUS 
на весь екран (рис. 1.31). 

У лівій верхній області екрана відображається міні-макет сторінки й 
трохи нижче панель DEVICES – компоненти проекту (рис. 1.32). У цьому 
вікні відображаються всі елементи, що використовуються в схемі. Кнопка з 
буквою  «Р»  відкриває форму пошуку компонента в бібліотеках PROTEUS 
для додавання в схему. Кнопка з буквою «L»  відкриває менеджер бібліо-
тек – з його допомогою можна підключати нові бібліотеки компонентів. На 
рис. 1.32 бачимо МК AVR AT90S8515, кілька компонентів компанії 
DALLAS-MAXIM (вони підключені за схемою інтерфейсу 1-Wire). Внизу 
списку є компонент PULLUP – це резистор, що підтягує напругу до + жив-
лення МК і приладів DSXXXX (звичайно це +5 В). 
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Рисунок 1.31 – Вікно проекту 1WIRE_NET у середовищі Proteus 
 

 
 

Рисунок 1.32 – Панель DEVICES 
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Натисніть кнопку з буквою «Р». Відкриється форма, що містить меню 
пошуку і вибору компонентів «Pick Devices» (рис. 1.33).  

 

 
 

Рисунок 1.33 – Форма-меню пошуку і вибору компонентів  
«Pick Devices»; введений ключ пошуку DS2 

 
У полі «Keywords» (ключові слова) введіть DS2 і виберіть верхній  

з 4-х знайдених компонентів – DS2405. У полі «Description» (опис) спосте-
рігаємо «адресований перемикач», тобто до цього приладу можна зверну-
тися за його адресою і «наказати» йому зробити на виході PIO логічний 
«1» або «0» і можливо перевести вихід у високо імпедансний Z-стан –  
вивід з дуже великим опором, який не впливає на те, що до нього підклю-
чено. У правій частині форми можна побачити назву моделі компоненту, 
його зображення на схемі, а нижче за нього «FootPrint» – його корпус.  
Ще нижче назва корпусу компонента – TO92. 

Інша частина 1-Wire приладів на схемі починається на DS1 (рис. 1.34) – 
введіть ці символи у поле ключових слів. Тепер знайдено 8 приладів. При-
чому вони розташовані в 2-х категоріях. Обираємо мишкою DS18S20 –  
в описі написано: «Високоточний 1-Wire цифровий термометр». На схем-
ному зображенні (рис. 1.35) цього компоненту видно деяке поле, що нага-
дує дисплей, у якому будуть виводиться дані в процесі симуляції. 
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Рисунок 1.34 – Форма-меню пошуку та вибору компонентів  
«Pick Devices»; введений ключ пошуку DS1 

 
Помістити компонент на схему можна натиснувши «ОК», потім  

помістите покажчик миші у потрібне місце на листі схеми і натиснути ми-
шею. Компонент опиниться на схемі. Червоними стрілками під час симу-
ляції можна змінювати температуру корпусу датчика – натиснувши по них 
мишею. Тут VCC – + живлення датчика, GND – «земля», DQ – лінія даних. 

 

 
 

Рисунок 1.35 – Умовне позначення датчика DS18S20 у вікні проекту  
1-WIRE_NET у середовищі Proteus 

 

 
 

Рисунок 1.36 – Панель керування симуляцією 
 

Панель керування симуляцією (рис. 1.36) складається з 4 кнопок: 
«Пуск» – запуск симуляції або продовження припиненої симуляції; «Крок» 
– виконати мінімальний крок за програмою МК, звичайно це одна інструк-
ція на асемблері (цією кнопкою теж можна почати симуляцію); «Пауза» – 
пауза симуляції (можна продовжити кнопками «Пуск» або «Крок»); 
«Стоп» – зупинка симуляції.  
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Обираємо МК (рис. 1.31) натиснувши на ньому правою кнопкою ми-
ші. МК і підключені до нього провідники стануть червоними. Відкриваємо 
панель редагування властивостей компонента (Edit Component) натиснув-
ши на МК лівою кнопкою миші. Натисніть кнопку "Hidden Pins" (прихова-
ні виводи) –  відкриється додаткове меню (рис. 1.37), де за замовчуванням 
є назви вузлів схеми, до яких підключені живлення МК: VCC і GND. Зміна 
цих назв інколи необхідна при живленні МК або інших компонентів різ-
ною напругою або від різних джерел. 

 

 
 

Рисунок 1.37 – Панель редагування властивостей компонента 
 

Головне для МК це програма за якою він працює, тому  у полі 
«Program File» потрібно вказати:  .cof – файл, якщо ведеться налагодження 
програми (початкова програма)  мовою С;  .hex   –  файл прошивки, якщо 
немає ніякої  початкової програми на С, ні на Асемблері. Якщо є початкова 
програма  на Асемблері  .asm, то потрібно вказати назву .hex  файлу  і  че-
рез  меню:  Source →Add/remove Source File...  додати назву файлу з текс-
том програми на асемблері і вибрати потрібний асемблер (рис. 1.38). 

Щоб симулювати у Proteus роботу МК необхідно знайти його в біблі-
отеках і помістити на схему,  указати яку програму він повинен виконува-
ти, вказати тактову частоту МК. Що б побачити всі встановлення компо-
ненту в  панелі редагування (рис. 1.37) натисніть  Edit All Prop. As Text 
(рис. 1.39). 
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Рисунок 1.38 – Вікно Add/remove Source File 
 

 
 

Рисунок 1.39 – Редагування властивостей МК у текстовому режимі 
 

{CLOCK} – однозначно визначає тактову частоту МК при симуляції. 
Кварц і конденсатори не потрібні для симуляції, їх встановлюють на схему 
тільки для того, щоб врахувати при розводці друкованої плати пристрою. 

{Wdg_clock}– показує частоту роботи генератора сторожового тайме-
ра. Хоча вона і позначена як  1MHz  – сторожовий таймер не включений, 
поки не додамо у властивості  МК стрічку:  {Wdgon=1} (для даного проек-
ту не потрібно її включати). 

{Program} – показує, що МК працюватиме за програмою ds1990.cof  
(створив компілятор CVAVR). 

Значення інших параметрів можна дізнатися в довідці, яка відкриється 
після натискання кнопки Help. Керувати процесом симуляції програми на 
асемблері можна за допомогою клавіш F10, F11, F12 і їх комбінацією з 
клавішами Alt і Ctrl і через меню DEBUG (рис. 1.40). 
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Рисунок 1.40 – Меню DEBUG 
 

При виборі команди Execute for Specified Time виводиться поле вве-
дення для вказівки скільки часу має відпрацювати схема (n – наносекунди, 
u – мікросекунди, m – мілісекунди, секунди можна не позначати). Вказа-
ний час буде використовуватись, якщо до його закінчення в програмі МК 
не зустрінеться точка зупинки (BP –  Breakpoint) –  симуляція зупиниться 
на ній. 

Для меню DEBUG корисні такі команди: 
− F12 еквівалентна кнопці  «Пуск»  – запускає або продовжує си-

муляцію до BP;    
− Alt+F12 запускає або продовжує симуляцію, що не зупиняється 

на BP;  
− F10  –  симулювати не використовуючи процедури на асемблері 

або функцій на С (вони будуть виконані як 1 крок);  
− F11 – симулювати крок  за програмою із входом у процедуру 

або функцію;  
− Ctrl+F11 – закінчити процедуру або функцію, у якій знаходимо-

ся;  
− Ctrl+F10 – виконувати сумуляцію до місця в програмі, яке озна-

чене виділеним рядком в програмі на асемблері.  
При симуляції пристрою на екрані спостерігаємо анімаційну картин-

ку. Режим анімації можна встановити через меню System→Set Annimation 
Options (рис. 1.41). 
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 відображати напругу і струм на щупах  
L13 і  L14
підсвітити логічні рівні на виводах
 показати кольором напруги на 
провідниках

 показати стрілками напрям струму в 
провідниках

Отримання довідки 
 

 

Рисунок 1.41 – Встановлення опцій анімації 
 

Запускаємо симуляцію проекту 1WIRE_NET.DSN кнопкою «Пуск» 
(рис. 1.40). З’явиться вікно віртуального терміналу ПК (рис. 1.42) і прибли-
зно за 1 секунду програма МК зробить все, що потрібно. При анімації логі-
чні рівні на виводах вказуються кольоровими квадратиками: червоний – 
логічний рівень «1», синій  – логічний рівень «0», сірий  –  Z стан.  

 

 
 

Рисунок 1.42 – Вікно симуляції проекту 1WIRE_NET.DSN;  
відкрито вікно Virtual Terminal 
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У вікні віртуального термінала (див. рис. 1.42) виводиться інформація 
з UART МК на віртуальний COM-порт ПК списку розпізнаних пристроїв 
на шині 1-Wire і їх номери: серійний номер DS1990, серійні номери прила-
дів DSXXXX, що задаються на заводі й незмінні (у Proteus ці номери зада-
ються у вікні редагування властивостей компонента). 

У Proteus можна не використовувати узгоджувач рівнів RS232 з UART 
типу MAX232, а підключати термінал безпосередньо до МК. Термінал  
підтримує службові символи ASCII ‒ управління виведенням тексту:  
CR (0DH), BS (0X08H) і BEL (0X07H). LF (0X0A) і решта службових кодів 
не підтримуються. У режимі паузи симуляції можна  за натисненням пра-
вої кнопки миші на екрані  терміналу відкрити меню, де можна скопіюва-
ти, вставити інформацію, можна змінити формат виводу числа (символи 
або 16 річний код), можна очистити екран даних, можна встановити режим  
«ехо» (прийняті на RXD терміналу символи будуть виводиться на його  
ніжку TXD). 

Виводи RTS і CTS можна не з’єднувати і не підключати взагалі –  
хоча вони працюють як у справжньому COM-порту ПК. Термінал може 
передавати щось тільки при рівні «0» на виводі CTS. Можна використову-
вати декілька незалежних терміналів.  

Якщо натиснути мишею у вікні терміналу, то він почне передавати 
символи, що набирають  на клавіатурі ПК, на ніжку TXD. Можна вставити 
з буфера обміну інформацію, яку термінал так само виводитиме на ніжку  
TXD. Інформація, що передається не відображається у вікні терміналу.  
Курсор залишається на місці. У властивостях терміналу в полі додаткові 
властивості (Other Properties) можна ввести текст, який посилатиметься з 
терміналу при натисненні кнопки «Пуск» із затримкою на час передачі  
одного символу.  

Компонент COMPIM дозволяє віртуальному пристрою підключитися 
до реального COM-порту ПК. 

Натисніть «Стоп» потім «Старт» і «Пауза». На екрані монітора будуть 
відображатись  вікна з налагоджувальною інформацією,  перелік цих вікон 
задається у меню DEBUG (рис. 1.43).  

Інші елементи схеми, у яких є цифрові дані або пам'ять, мають свої 
підменю з можливістю виведення інформаційних вікон. Наприклад, циф-
ровий термометр DS18S20 має Scratch RAM і EEPROM. Якщо в схемі  
декілька МК, то для кожного буде своє підменю. 

Watch Window ‒ вікно стеження (рис. 1.44). Після налаштування воно 
не зникає з екрана при симуляції і знаходженні в паузі. У цьому вікні мож-
на розмістити регістри МК і не тільки відстежувати їх вміст за ходом про-
грами, а й задавати деякі умови і дії, при досягненні  яких, наприклад, зу-
пинити симуляцію. При виборі  Add Items (By Address) з'являється панель 
спостереження. Натиснувши на ній правою кнопкою миші, з’являється  
меню для додавання регістрів, що будуть спостерігатись (за ім’ям або за 
їхньою адресою). Подвійний натиск мишею на назві регістра додає його у 
вікно спостереження.   
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Рисунок 1.43 – Вибір коду програми та змінних у меню DEBUG  
для відображення їх під час налагодження роботи програми 

 
Якщо задати умову у Watch Expression, то етапи процесу симулювання 

визначаються у вікні (рис. 1.45). Розглянемо уважно й інші пункти меню 
DEBUG (рис. 1.43). Вікно з текстом програми – AVR Source Code ‒ U9. На 
жаль, при симуляції МК AVR в Proteus – це вікно не пам'ятає, яку програму 
показувати, якщо в ній немає активних BP. Тому потрібно вказати, яку про-
граму використовувати (рис. 1.46).  
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Рисунок 1.44 – Вікно Watch Window та його властивості 
 

 
 

Рисунок 1.45 – Вікно, що задає, як працює симулятор  
при виникненні умов у Watch Expression 

 

 
 

Рисунок 1.46 – Вибір тесту програми для режиму налагодження 
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Рисунок 1.47 – Вікно з текстом програми 
 

При виборі файлу програми відкривається вікно з текстом програми 
(рис. 1.47). Зелені цифри  показують рядки програми, які можна виділити 
мишею і потім кнопкою F9 поставити BP (точку зупинки) – червоний кру-
жечок. Програма, дійшовши до цієї точки зупиниться, у режимі паузи – на 
екрані монітора з’являться вікна з налагоджувальною інформацією. Якщо 
натиснути F9 ще раз, то BP дезактивувався – стане червоним колом і  
програма не зупиниться на ній. Наступне натиснення кнопки F9 приховає 
BP з виділеного рядка.   

Розставимо BP, як на рис. 1.47. Натискаємо кнопку «Стоп», а потім 
«Пуск». Програма зупиниться на 1-ій точці BP і з’явиться вікно з текстом 
програми мовою С (рис. 1.48).  

Рядок, на якому зупинилася програма, підсвічується сірим кольором і 
на неї вказує червоний трикутник зліва від BP. Натисніть «Старт», програ-
ма зупиниться на наступній точці BP, тобто на наступному рядку програ-
ми. У вікні терміналу видно, що відбулося виконання попереднього рядка 
програми.  

Натиснувши правою кнопкою миші у вікні програми відкривається  
меню, де можна побачити код мовою Assembler безпосередньо в тексті  
програми мовою С (рис. 1.49); включити нумерацію рядків програми; вклю-
чити або виключити усі BP; знайти щось у програмі; перейти на потрібний 
рядок програми; змінити шрифт у вікні.  
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Рисунок 1.48 – Процес налагодження програми;  
зупинка на першій точці BP 

 

 
 

Рисунок 1.49 – Відображення у вікні програми мовою С  
еквівалентного коду програми мовою Assembler 
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Розставивши BP у потрібному місці програми можна покрокове нала-
годження за кожним рядком програми кнопкою F12 або «Пуск». 

Навіть при покроковому налагодженні всі віртуальні прилади продо-
вжують показувати  вимірювані параметри і на віртуальному осцилографі 
або логічному аналізаторі можна побачити, після виконання якого рядка 
коду відбулося яка зміна на ніжках МК або в інших вузлах схеми. Деталь-
но про налагодження за початковим кодом програми написано у розділі 
допомоги: «SOURCE LEVEL DEBUGGING WITHIN PROTEUS VSM». 

Дані симуляції можна зберегти у файл через меню Graph→Export 
Data.  Отримаємо файл у стандартному форматі для вимірювальних прила-
дів – CSV (дані розділені комами). Цей файл можна імпортувати до Excel 
або до Matlab. Графіки результатів симуляції можна експортувати до гра-
фічних  та CAD форматів через меню File→Export Graphics. 

 
1.9 Програмне забезпечення  

для програмування мікроконтролерів 
 

1.9.1 Програмування у середовищі AVR Studio 
Після того як мікроконтролер поміщений в гніздо плати програмато-

ра, що з’єднаний з ПК, і на нього подано живлення, у середовищі AVR 
Studio для налаштування з'єднання варто вибрати команду меню 
Tools→Program AVR→Connect або натиснути кнопку Display the Connect 
dialog панелі інструментів STK500. У результаті відкриється діалогове  
вікно Select AVR Programmer, де необхідно вибрати поточний програматор 
та порт, по якому він підключений до ПК (рис. 1.50). 

 

 
 

Рисунок 1.50 – Діалогове вікно Select AVR Programmer 
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Програматори, що використовують інтерфейси USB, тут у списку 
Platform за замовчуванням відповідають елементи JTAG ICE, AVR ISP та 
AVR Dragon. Після того як програматор і порт обрані, можна натиснути 
кнопку Connect. Якщо усі апаратні підключення були виконані правильно, 
то на екрані має з'явитися діалогове вікно, яке зображено на рис. 1.51. 

На вкладці Main необхідно вибрати мікроконтролер (список Device), а 
також вказати виконувані НЕХ-файли для пам'яті программ (поле Flash – 
Input HEX File) та/або пам'яті EEPROM (поле EEPROM – Input HEX File). 
Перед програмуванням для контролю можна очистити пам'ять програм і 
даних мікроконтролера, натиснувши кнопку Erase Device. Власне програ-
мування починається після натискання відповідної кнопки Program. Режим 
програмування (Programming mode) обирається на вкладці Main: ISP ‒  
внутрішньосхемний;  PP/HVSP ‒ високовольтний;  JTAG ‒ для програма-
торів AVR Dragon та JTAGICE mkll.  

Установлення ознаки Erase Device Before Programming призводить до 
очищення пам'ять мікроконтролера перед записом. 

 

 
 

Рисунок 1.51 – Вікно керування процесом програмування 
 
Установлення ознаки Verify Device After Programming призводить до 

перевірки на коректність вмісту пам'яті мікроконтролера після запису 
Установлення ознаки Use Current Simulator/Emulator FLASH 

(EEPROM) Memory обирає для використання .hex файл з відкритого  
в цей момент проекту AVR Studio. Verify – кнопка перевірки записаних в 
пам'ять Flash або EEPROM даних. Read – кнопка читання записаних в па-
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м'ять Flash або EEPROM даних. Програма AVR Programmer (рис. 1.51)  
дозволяє також програмувати розряди Fuses та LockBits. Для цього слугу-
ють вкладки Fuses і LockBits відповідно. Вкладка Advanced слугує для чи-
тання з мікроконтролера байтів сигнатури та калібровки осцилятора, а  
також для запису останнього за заданим користувачем адресою пам'яті 
Flash або EEPROM. Вкладка Board дозволяє змінити умови роботи плати 
відлагодження, а вкладка Auto ‒ задати автоматичну виконувану послідов-
ність операцій [2, 12, 13, 24]. 

 
1.9.2 Програмування у середовищі PonyProg2000 
Завантажити і встановити програму PonyProg2000. Підключимо  

програматор до комп'ютера та запустимо PonyProg2000, з'явиться вікно 
програми (рис. 1.52) [2, 12, 13, 24, 30]. 

 

 
 

Рисунок 1.52 – Вікно програми PonyProg2000 
 

Далі необхідно налаштувати програму для роботи з програматором. 
Обираємо меню Setup→Interface Setup. У вікні налаштувань потрібно 
установити тип та порт програматора (рис. 1.53). Далі необхідно провести 
калібровку програми, для цього  обираємо меню Setup→Calibration. Натис-
каємо кнопку "Yes" (рис. 1.54) та очікуємо повідомлення (рис. 1.55) про 
завершення процесу калібрування. 
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Рисунок 1.53 – Вікно налаштування типу підключення програматора   
у PonyProg 

 

 
 

Рисунок 1.54 – Вікно початку режиму калібровки прграматора у PonyProg 
 

 
 

Рисунок 1.55 – Вікно завершення режиму калібровки 
 

Обираємо AVR-мікроконтролер, з яким будемо працювати, переходи-
мо до вкладки Device→AVR micro та обираємо мікроконтролер, наприклад 
Attiny13 (рис. 1.56). 

Для читання «прошивки» мікроконтролера переходимо до вкладки 
Command→Read All (рис. 1.57) та очікуємо завершення процесу читання 
(рис. 13) «прошивки » мікроконтролера.  

У вікні програми PonyProg2000 виводиться вміст  «прошивки» мікро-
контролера. Для збереження «прошивки», яку прочитали з мікроконтроле-
ра, обираємо режим File Save Device File As, обираємо ім’я файлу, тип 
файлу "*.HEX" та натискаємо кнопку "Сохранить". 
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Риснок 1.56 – Вибір типу мікроконтролера для роботи у PonyProg 
 

 
 

Рисунок 1.57 – Вікно вибору режиму читання «прошивки»  
з мікроконтролера 

 

 
 

Рисунок 1.58 – Вікно процесу та результату читання «прошивки»  
з мікроконтролера 

 
Для запису «прошивки» у мікроконтролер відкриваємо файл «прошив-

ки». Для цього обираємо File→Open Device File (рис. 1.59, а). У вікні, що  
відкриється, встановлюємо тип файлу "*.HEX" та відкриваємо файл з «про-
шивкою». Для програмування мікроконтролера обираємо Command→Write 
All (рис. 1.59, б). Процес програмування наведений на рис. 1.60. 
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а)      б) 

 
Рисунок 1.59 – Вибір  «прошивки» (а) та  режиму програмування (б) 

 

              
 

Рисунок 1.60 – Процес програмування мікроконтролера 
 

 
 

Рисунок 1.61 – Вибір режиму встановлення Fuse bits 
 

Для знищення інформації з мікроконтролера обираємо  
Command→Erase. Щойно процес завершиться, PonyProg2000 повідомить 
повідомленням «Erase succesful».  

Для встановлення Fuse bits мікроконтролера обираємо  
Command→Security and Configuration Bits (рис. 1.61). Для читання Fuse 
bits, що встановлені у мікроконтролері обираємо кнопку "Read" (рис. 1.62). 
Для запису Fuse bits встановлюємо необхідні біти у чек-боксах та натиска-
ємо кнопку  "Write" (рис. 1.62).  
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Рисунок 1.62 – Вікно встановлення Fuse bits у програмі PonyProg 
 

1.9.3 Програмування у середовищі AVRDUDE та SinaProg  
AVRDUDE PROG 3.1 призначена для програмування мікро-

контролерів AVR під всі версії Windows через USB (рис. 1.63) [28‒30]. 
Інтуїтивно зрозумілий інтерфейс, можливість вибору інверсних 

(PonyProg) та прямих (UniProf) Fuses біт, самостійне додавання мікроконт-
ролерів та програматорів, що підтримують AVRDUDE .  

Підтримує такі МК:  
AT90CAN128, 
AT90CAN32, 
AT90CAN64, 
ATmega128, 

ATmega1280, 
ATmega1281, 

ATmega1284p, 
ATmega128RFA1, 

ATmega16, 
ATmega162, 

ATmega164p, 
ATmega168, 
ATmega169, 

ATmega2560, 
ATmega2561, 

ATmega32, 
ATmega324p, 

 

ATmega325, 
ATmega3250, 
ATmega328p, 
ATmega329, 
ATmega3290, 
ATmega329p, 
ATmega3290p, 
ATmega32U4, 
ATmega48, 
ATmega8, 
ATmega8515, 
ATmega8535, 
ATmega88, 
ATtiny13, 
ATtiny2313, 
ATtiny261. 

 

Підтримує такі програматори: USBasp, USBtiny, AVR ISP, SI-Prog, 
AVR910, STK200, STK500, JTAG ICE. 
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Рисунок 1.63 – Інтерфейс програми AVRDUDE PROG 3.1 
 
Програма SinaProg портативна та не вимагає встановлення. До її скла-

ду входить AVRdude. Після запуску програми ми побачимо головне вікно 
(рис. 1.64) [28, 29, 30].  

Опис інтерфейсу програми зверху‒вниз:  
− вікно вибору шляху та імені для HEX-файлу;  
− вікно системних повідомлень;  
− стрілочка показує/ховає вікно з логом повідомлень від AVRdude; 
− прогрес-бар – відображає процес роботи з мікроконтролером;  
− поле роботи з Flash-пам'яттю мікроконтролера. Програмування, 

перевірка (порівнюється вміст пам'яті з HEX-файлом) та читання 
(до процедури читання має бути вибраний HEX-файл у верхньому 
вікні – інакше буде виводиться помилка);  

− поле роботи з EEPROM;  
− поле вибору мікроконтролера – у списку обираємо мікроконтро-

лер, з яким працюватиме програматор, кнопка «Search» запускає 
процес перевірки відповідності обраного мікроконтролера підк-
люченому (корисно для перевірки працездатності ланки програ-
матор-шлейф-мікроконтролер);  

− робота з Fuse bits. Вікно пресетів та кнопку «Program» не чіпаємо 
– це для роботи з пресетами. Кнопка «Advanced ...» відкриває вік-
но встановлення Fuse bits (рис. 1.65);  

− поле вибору програматора. У списку, що випадає, обираємо тип, 
наприклад, USBtiny, та порт – USB (у нових версіях SinaProg є 
можливість вибору різних портів та швидкості роботи з ними). 
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Рисунок 1.64 –  

Інтерфейс програми Sina Prog 
Рисунок 1.65 –  

Вікно «Advanced» роботи з Fuse bits 
 

Вікно «Advanced» містить сигнатуру мікроконтролера (Device Signature), 
значення калібровки для генератора (Calibration). Fuse bits розбиті на чотири 
байти (Lock Bits, High Fuse, Low Fuse, Ext. Fuse). При відкритті вікна дані 
автоматично зчитуються з мікроконтролера. Запис Fuse bits можливий у ви-
падках:  

1. Записом у відповідні вікна значень всього байту (шістнадцяткові  
числа).  

2. За допомогою Fuse-калькулятора (рис. 1.66). Для переходу в цей ре-
жим тиснемо «С» біля потрібного байта Fuse. Відкриється вікно калькуля-
тора, де і вибираються потрібні режими роботи. Після того як всі значення 
виставлені тиснемо «Write» (рис. 1.65). Значення Fuse bits тут не як по 
DataSheet, а інверсно. Чек-бокс дозволяється вибрану функцію. У такому 
разі це логічно, якщо сприймати калькулятор як настроювач конфігурації. 

 

 
 

Рисунок 1.66 – Вікно Fuse-калькулятора програми SinaProg 
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Питання для самоконтролю 
 

1. Опишіть основні етапи процесу написання програм для МК AVR. 
2. Охарактеризуйте ключові переваги компілятора Асемблера. 
3. Які Ви знаєте компілятори мови C? 
4. Опишіть принципи роботи в інтегрованому середовищі розробки  

програм AVR Studio. 
5. Які є особливості роботи в інтегрованому середовищі розробки  

програм WinAVR? 
6. Дайте характеристику інтегрованому середовищу розробки програм 

ICCAVR. 
7. Виконайте порівняльну характеристику інтегрованих середовищ 

розробки CodeVisionAVR та AVR Builder. 
8. Які базові переваги роботи в інтегрованому середовищі розробки  

програм FLOWCODE? 
9. Опишіть принципи роботи у програмному симуляторі Proteus VSM. 
10. Якими ключовими характеристиками володіють особливості  

роботи в таких середовищах програмування: AVR Studio, PonyProg2000, 
AVRDUDE та SinaProg? 
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2 АПАРАТНІ ЗАСОБИ ПІДТРИМКИ МІКРОКОНТРОЛЕРІВ AVR 
 

Донині поширеним способом створення прототипу майбутнього  
пристрою був такий: підібравши електронні компоненти, розробник брав у 
руки паяльник і збирав на макетних платах окремі вузли або пристрій в 
ціле. Далі починався процес налагодження: виправлення помилок принци-
пової схеми, встановлення режимів роботи, уточнення параметрів компо-
нентів, що застосовуються. Цей варіант не втратив своєї актуальності і  
нині, але застосовується тільки при розробках простих пристроїв, при ви-
робництві одиничних екземплярів і при обмеженому бюджеті. Але якщо на 
перший план виходять такі критерії, як швидкість, зручність, надійність 
розробки, то без професійних засобів не обійтися.  

До переваг використання засобів розробки можуть належати: 
− зменшення часу виходу готової продукції; 
− зменшення матеріальних витрат і ризику при розробці; 
− використання власних ресурсів для прискорення розробки; 
− вільне використання власних розробок надалі. 
До спеціалізованих професійних інструментальних засобів налаго-

джування належать: 
1. Оціночні та демонстраційні плати (Evaluation & demonstration 

board). Дозволяють швидко ознайомитися з тим чи іншим приладом або 
набором приладів та в короткі терміни розробити на ньому пристрій. 

2. Внутрішньосхемні емулятори (In-circuit emulator). Найбільш поту-
жні й універсальні налагоджувальні інструменти, що являють собою набір 
апаратно-програмних засобів, які дозволяють заміщувати собою емульова-
ний мікроконтролер у реальній схемі. 

3. Програмні симулятори (Simulator). Програмні засоби, здатні іміту-
вати роботу мікроконтролера і його пам'яті. 

4. Відлагоджувачі (Debugger). Свого роду міст між розробником і 
пристроєм налагодження, що дозволяє користувачеві одночасно контро-
лювати перебіг виконання програми і бачити відповідність між вихідним 
текстом, образом програми в машинних кодах і станом всіх ресурсів ему-
льованого мікроконтролера. 

5. Емулятори ПЗП (ROM emulator). Програмно-апаратні засоби, здатні 
заміщувати ПЗП на платі, що відлагоджується, шляхом підстановки за-
мість нього ОЗП і завантаження програми за допомогою комп'ютера через 
один із стандартних інтерфейсів. 

6. Програматори (Programmer). Пристрої, що дозволяють програмува-
ти мікросхеми пам'яті, МК і програмовані логічні інтегральні схеми. 

7. Інтегровані середовища розробки (Integrated Development 
Environment). 
 

2.1 Внутрішньосхемні відлагоджувачі 
 
Найважливіший інструмент будь-якого розробника програмного  

забезпечення – внутрішньосхемний відлагоджувач. Він з'єднує мікроконт-
ролер з ПК через спеціальний інтерфейс для налагодження та програму-
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вання, так відкривається доступ до внутрішніх алгоритмів функціонування 
мікроконтролера. Завантаження програми в мікроконтролер займає всього 
кілька секунд, при цьому не потрібно видаляти або перепаювати будь-які 
елементи. Запрограмований відлагоджувач може управляти процесором, 
запускаючи виконання програми, зупиняючи або реалізуючи її в покроко-
вому режимі, а також зчитувати дані в режимі реального часу з усіх облас-
тей пам'яті мікроконтролера і регістрів введення/виведення. Для пристроїв 
AVR існує три внутрішньосхемних відлагоджувача [5, 14, 15, 17].  

AVR Dragon. Внутрішньосистемний відлагоджувач для 8- і 32-
розрядних мікроконтролерів AVR з підтримкою внутрішньосхемною нала-
годження (OCD). З його допомогою можна виконувати символьне налаго-
дження на всіх пристроях з підтримкою внутрішньосхемною налагодження 
(OCD) з використанням режимів SPI, JTAG, PDI (на окремих пристроях), 
високовольтного послідовного програмування і паралельного програму-
вання, а також стандартне налагодження через інтерфейси SPI, JTAG, PDI. 
Робоча область дозволяє створювати власні схеми або додавати гнізда для 
бажаних пристроїв. Відлагоджувач підтримує технологію NanoTrace  
(залежно від модуля OCD на пристрої AVR) з використанням пам'яті  
цільового пристрою. 

JTAGICE 3. Внутрішньосистемний відлагоджувач та програматор  
середнього рівня для 8- та 32-розрядних мікроконтролерів AVR. Засіб роз-
робки середнього рівня для 8- і 32-розрядних мікроконтролерів Atmel AVR 
з підтримкою внутрішньосхемною налагодження для проведення символь-
ного налагодження на рівні вихідного коду, роботи в режимі NanoTrace 
(якщо підтримується пристроєм) і програмування. 

AVR ONE!. Професійний інструмент розробки для всіх 8- та 32-
розрядних пристроїв AVR з підтримкою внутрішньосхемного налагоджен-
ня (OCD). Відлагоджувач Atmel AVR ONE! застосовується для символьно-
го налагодження на рівні вихідного коду, трасування програм та програму-
вання пристроїв. Він забезпечує повний цикл розробки і є найшвидшим 
налагоджувальним інструментом, що пропонується компанією Atmel,  
дозволяє програмувати в режимах SPI, JTAG, PDA і aWire, а також здійс-
нювати налагодження через інтерфейси debugWIRE, JTAG, PDI і aWire. 
Також підтримує функцію LiveDebug, і допоміжний інтерфейс Nexus для 
високошвидкісної трасування програм, даних на частоті до 200 МГц в бу-
ферному або потоковому режимі. Заснований на потужній матриці FPGA, 
що забезпечує високошвидкісну передачу даних між ПК-хостом і пристро-
єм AVR, сприяючи швидкому завантаженню програм та зменшенню часу 
відгуку при налагодженні. 

 

2.2 Засоби розробки для мікроконтролерів  фірми Atmel 
 

Сучасні засоби розробки для мікроконтролерів AVR фірми Atmel та 
сторонніх виробників розглянуто в [5, 14, 15, 17].  

ICE 200 – внутрішньосхемний емулятор фірми Atmel для налагоджен-
ня пристроїв на МК набору AVR (ATtiny12, AT90S2313, AT90S2333/4433, 
AT90S4414/8515, AT90S4434/8535). Емулятор підключається до пристрою 
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за допомогою спеціальної емуляційної головки і може використовуватися з 
платами, на яких встановлені панельки DIP8, DIP20, DIP28 і DIP40. 

JTAGICE – внутрішньосхемний JTAG емулятор з фоновим налаго-
дженням програми користувача, який може бути використаний як внутріш-
ньосхемний програматор для мікроконтролерів AVR, що мають JTAG-
інтерфейс. 

STK500 – система відлагодження, яка полегшує роботу з AVR-
мікроконтролерами та забезпечує підтримку програмування через парале-
льний та послідовний інтерфейси. Додатково система може бути викорис-
тана як ISP-програматор. Використовуючи інтегровану середу розробки 
AVR Studio ATSTK500 забезпечує режими симуляції та емуляції, а також 
внутрішньосхемного програмування AVR-мікроконтролерів. 

STK501 – модуль розширення до STK500, що дозволяє збільшити 
список пристроїв, що підтримуються: ATmega64, ATmega103, ATmega128. 

STK502 – модуль розширення, розроблений для підтримки мікрокон-
тролерів ATmega169. У ATSTK502 входять роз'єми, перемички і апаратні 
засоби для повної підтримки всіх особливостей mega169, а також управ-
ління вбудованим LCD. 

STK600. Це повноцінний початковий комплект із системою розробки 
для 8- та 32-розрядних мікроконтролерів AVR. Комплект оснащений  
функціями моделювання та випробування нових проектів. Пристрої AVR 
взаємодіють з комплектом STK600 за допомогою інноваційної сендвіч-
системи плат для підключення та маршрутизації, тобто передачі сигналів 
від пристрою до відповідного обладнання. 

Сендвіч-система складається з базової плати з гніздами, на якій розмі-
щується пристрій AVR, і плати маршрутизації сигналів (для кожного при-
строю своя карта), яка направляє сигнали до різних блоків основної плати 
STK600 залежно від пристрою. Така система спрощує апаратне налашту-
вання при переході від одного мікроконтролера AVR до іншого, оскільки 
всі сеанси зв'язку пристрою з материнською платою визначаються платою 
маршрутизації, специфічною для такого пристрою. Система маршрутизації 
повністю пасивна. У перенаправленні сигналів не беруть участь електронні 
компоненти, тому всі контакти введення/виведення на роз'ємах доступні 
безпосередньо, без необхідності зміни електричних схем. 

Комплект забезпечує доступ до всіх виводів пристрою, а також підт-
римку корисних апаратних функцій таких, як: кнопки, світлодіодні індика-
тори та флеш-пам'ять даних Atmel DataFlash; являють собою повноцінну 
систему моделювання та випробування нових рішень. Безкоштовні про-
грамні платформи AVR Studio і AVR32 Studio дозволяють розробникам 
писати і компілювати внутрішнє програмне забезпечення для мікроконт-
ролерів, використовуючи асемблер або мову C, а також завантажувати го-
тові програми в цільові пристрої AVR. 

Плата також оснащена регульованим джерелом напруги і регульова-
ним генератором тактових імпульсів. Рівень напруги і частота генератора 
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оперативно регулюються через середовища AVR Studio або AVR32 Studio, 
дозволяючи розробникам проводити випробування продуктивності при 
різних рівнях напруги і робочих частотах шляхом натискання всього однієї 
кнопки. 

 
2.3 Апаратні засоби підтримки проектування  

та відлагодження систем 
 

2.3.1 Логічні аналізатори та осцилографи змішаних сигналів 
Логічні аналізатори є універсальними приладами для аналізу функці-

онування цифрових систем [14]. Вони дозволяють контролювати логічний 
стан декількох десятків точок системи протягом заданого проміжку часу і 
видати інформацію про їхній стан у візуальному (на екрані монітора) або 
друкованому вигляді. Форма подання може бути символьна або графічна 
(часові діаграми сигналів). Вхідні канали аналізатора підключаються до 
точок контролю за допомогою зондів-кліпсів. Число каналів у сучасних 
аналізаторах зазвичай становить від 16 до 200. Запуск аналізатора прово-
диться автоматично при надходженні на певні канали заданого коду (адре-
си, даних або комбінації керувальних сигналів) або послідовності кодів. 
Після запуску в пам'ять аналізатора записується послідовність значень  
логічних сигналів в точках контролю. Обсяг цієї пам'яті визначає число 
контрольованих точок на часовій осі (глибину контролю), яке може стано-
вити від декількох тисяч до сотень тисяч. На екран виводяться кілька  
десятків точок для кожного каналу з можливістю перегляду всієї записаної 
в пам'яті послідовності станів. Максимальна частота дискретизації часових 
інтервалів для різних моделей аналізаторів має значення від декількох  
десятків до сотень мегагерц. 

Логічні аналізатори, які випускаються провідними виробниками елек-
тронно-вимірювальної апаратури: Hewlett-Packard, Tektronix, John Fluke і 
низкою інших, ‒ реалізуються у вигляді автономних вимірювальних при-
ладів з власним дисплеєм або аналізаторів блоків, що підключаються до 
персонального комп'ютера. Наведемо основні характеристики логічних 
аналізаторів компанії Hewlett-Packard, які широко використовуються для 
налагодження систем на базі мікроконтролерів [5]. 

Аналізатори серії HP1660 є автономні прилади, які дозволяють конт-
ролювати від 34 до 136 каналів з глибиною до 8К точок, забезпечуючи  
контроль логічних станів з частотою до 100 МГц при роздільній здатності 
2 нс (частота дискретизації 500 МГц). Окремі моделі цієї серії містять та-
кож двоканальний осцилограф зі смугою пропускання 250 МГц або гене-
ратор послідовностей 32-розрядних тестових сигналів з частотою до 
200 МГц. Аналізатори серії HP 1670 забезпечують глибину контролю до 
128К точок при інших аналогічних параметрах. Ці серії логічних аналіза-
торів найбільш ефективні для налагодження систем на базі 8-розрядних 
мікроконтролерів набору AVR. 
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Ширші можливості налагодження реалізують аналізаторів HP 16600, 
HP 16700 компанії Hewlett-Packard, які працюють із зовнішніми моніто-
ром, клавіатурою і мишкою. Ці системи побудовані за модульним принци-
пом, дозволяючи користувачеві вибрати необхідний йому набір стандарт-
них функціональних модулів для виконання різних процедур контролю 
пристрою, що відлагоджуються. Системи серії HP 16600 мають від 68 до 
204 каналів, що виконують аналіз логічних станів з частотою до 100 МГц 
при роздільній здатності 4 нс (частота дискретизації 250 МГц) і глибині 
контролю 128К точок. Є можливість підключення до системи вимірюваль-
ного модуля, що виконує функції цифрового осцилографа або генератора 
тестових послідовностей, і модуля схемного емулятора.     

Особливо корисним у процесі налагодження цифрових систем є вико-
ристання осцилографів змішаних сигналів, які дозволяють одночасно кон-
тролювати логічний стан і значення аналогових сигналів в різних точках 
схеми. У цьому класі засобів налагодження оптимальним за комплексом 
технічних і експлуатаційних характеристик є прилад HP54645D компанії 
Hewlett-Packard [5], який містить двоканальний цифровий осцилограф із 
смугою пропускання 100 МГц (частота дискретизації 200 МГц), чутливіс-
тю 10 мВ/поділ, і 16-канальний логічний аналізатор з частотою дискрети-
зації 400 МГц, глибиною контролю до 2М точок. Комбінація синхронно 
запуску осцилографа і логічного аналізатора з великою глибиною контро-
лю відкриває нові можливості для виявлення причин виникнення збоїв і 
завад при роботі мікроконтролерних систем. Такий прилад дозволяє  
визначати причини виникнення завад на шинах живлення, виявляти  
імпульсні завади в лініях зв'язку, контролювати спільну роботу аналогових 
і цифрових блоків, налагоджувати процедури послідовного обміну даними 
при спотвореннях форми переданих сигналів, а також розв’язувати багато 
інших проблем, які досить важко вирішити іншими способами. 
 

2.3.2 Схемні емулятори і схемні симулятори 
Схемний емулятор (СЕ) являє собою програмно-апаратний комплекс, 

який у процесі налагодження заміщає мікроконтролер в реалізованої сис-
темі. У результаті такої заміни функціонування системи, що відлагоджу-
ється, стає наочною і контрольованою. Розробник отримує можливість ві-
зуального контролю за роботою системи на екрані дисплея та управління її 
роботою шляхом встановлення певних керуючих сигналів і модифікації 
вмісту регістрів та пам'яті. Завдяки наявності таких можливостей СЕ є 
найбільш універсальним та ефективним налагоджувальний засобом, що 
використовується на етапі комплексного налагодження системи [5, 14]. 

Найбільш широке застосування отримали СЕ, що підключаються до 
базового комп'ютера або робочої станції. Зазвичай, такі СЕ конструктивно 
оформлені у вигляді приладу, розміщеного в окремому корпусі з автоном-
ним джерелом живлення і з’єднаним з базовим комп'ютером. За допомо-
гою плоского кабелю до СЕ підключається емуляторна головка, яка має 
вилку для ввімкнення в систему замість емульованого мікроконтролера.  
У голівці розміщується емулятор, який виконує ті ж функції, що і мікро-
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контролер, але працює під управлінням комп'ютера. Більшість СЕ призна-
чений для роботи з певним набором мікроконтролерів, причому для ему-
ляції кожної моделі набору використовується відповідна головка. 

До структури типового СЕ входять такі блоки: 
− емулятор мікроконтролера (у голівці); 
− пам'ять траси, яка зберігає значення сигналів, що встановлюються 

на виводах мікроконтролера в процесі виконання програми; 
− блок контрольних переривань, який реалізує зупинки в контрольних 

точках, заданих користувачем з клавіатури комп'ютера; 
− емуляційна пам'ять (ОЗП), яка замінює в процесі налагодження 

внутрішнє ПЗП мікроконтролерів або інші розділи пам'яті, зовнішній дос-
туп до яких під час налагодження обмежений; 

− таймер, який використовується для контролю часу виконання фраг-
ментів програми. 

СЕ дозволяє вводити в систему тестову або робочу програму і контро-
лювати її виконання, забезпечуючи переривання в контрольних точках. 
Умовами переривання можуть бути різні комбінації значень адреси, даних 
і керувальних сигналів, що надходять на виводи мікропроцесора або мік-
роконтролера, що емулюється. Ці комбінації задаються користувачем з 
клавіатури комп'ютера, що управляє. Після зупинки користувач може 
отримати на екрані інформацію про поточний стан будь-яких регістрів і 
комірок пам'яті системи. За допомогою пам'яті траси можна переглянути 
стан системної шини для певної кількості попередніх циклів виконання 
програми. Дизасемблер дозволяє аналізувати виконання програми відповід-
но до її вихідного тексту мовою асемблера. Пам'ять траси працює аналогіч-
но пам'яті логічного аналізатора, тому СЕ може виконувати також і його 
функції. Об'єм пам'яті траси в різних СЕ дозволяє контролювати від 4К до 
512К програмних циклів. Таймер слугує для визначення часу виконання 
фрагментів програми з урахуванням реальної тактової частоти системи. 

Програмне забезпечення СЕ складається з монітора ‒ службової  
програми, що забезпечує роботу всіх блоків під керуванням базового ком-
п'ютера, транслятора, що дозволяє програмувати роботу системи мовою 
високого рівня або Асемблера, і відлагоджувача. Ці програмні засоби  
зазвичай функціонують у складі інтегрованого середовища програмування-
налагодження. Більшість сучасних СЕ використовують символьні відлаго-
джувачі і дизасемблери, застосування яких робить процес налагодження 
більш простим і наочним. Програмне забезпечення СЕ реалізує видачу  
даних на екран монітора в зручному для користувача форматі. 

Деякі моделі СЕ надають можливості аналізу ефективності виконува-
ної програми, забезпечуючи інформацію про частоту звернення до певних 
її фрагментів, і дозволяють виконувати налагодження мультипроцесорних 
систем за допомогою організації багатоемуляторних комплексів. СЕ, що 
реалізують перераховані вище функції, називають налагоджувальними 
комплексами або системами розвитку (development system). 
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Як правило, симулятор складається з відлагоджувача, моделі ЦП і  
пам'яті. Більш досконалі пристрої містять у своєму складі моделі вбудова-
них периферійних пристроїв (таймерів, портів, АЦП і систем переривань). 

Симулятор має вміти завантажувати файли програм в усіх популярних 
форматах, максимально повно відображати інформацію про стан ресурсів 
МК, а також надавати можливості по симуляції виконання програми, що 
завантажується, у різних режимах. Під час налагодження модель виконує 
програму, і на екрані монітора комп'ютера відображається поточний стан 
моделі. 

Завантаживши програму в симулятор, користувач може запускати її у 
покроковому або безперервному режимі, задавати умовні або безумовні 
точки зупинки, контролювати і вільно модифікувати вміст комірок пам'яті 
і регістрів МК. Симулятор дозволяє швидко перевірити логіку виконання 
програми, правильність виконання арифметичних операцій. Залежно від 
класу відлагоджувача деякі моделі симуляторів підтримують високорівне-
ве налагодження програм. Симулятор може містити і ряд додаткових про-
грамних засобів, наприклад інтерфейс зовнішнього середовища. Наявність 
такого інтерфейсу дозволяє створювати і гнучко використовувати модель 
зовнішнього середовища МК, що функціонує і впливає на програму, яка 
відлагоджується за заданим алгоритмом. 

У реальній системі МК зчитує інформацію з підключених до нього 
пристроїв (датчиків), обробляє її та видає сигнали керуювання на виконав-
чі пристрої. Для того, щоб в простому симуляторі змоделювати роботу  
датчика, потрібно вручну змінювати поточний стан моделі периферійного 
пристрою, до якого в реальній системі підключений датчик. Але існує  
низка сучасних розробок програмних симуляторів, у яких, щоб імітувати 
зовнішні умови і ситуації, зазвичай використовується спеціальний файл 
вхідних впливів. Цей файл задає послідовність вхідних сигналів, що над-
ходять на пристрій, який моделюється. 

Наприклад, для мікроконтролерів AVR цей вхідний файл програмного 
симулятора може виглядати так: 

000000000:00 
000000006:F1 
000000015:18 
000000109:1C  
000000203:61 
000000250:10 
000000344:1F  
000000391:71 
999999999:FF,   

де кожен рядок містить – цикл: дані, що надходять на будь-який вказаний 
порт. 

У деяких моделях симуляторів ця проблема імітації зовнішніх сигна-
лів вирішена так, що симулятор має вбудований засіб для створення моде-
лей підключених до МК зовнішніх пристроїв, включаючи засоби графічно-
го відображення інформації. Очевидна особливість програмних симулято-
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рів в тому, що завантажені в них програми виконуються в масштабі часу, 
відмінному від реального. Однак низька ціна, можливість налагодження 
навіть за відсутності макета пристрою роблять програмні симулятори дуже 
привабливим засобом налагодження. Необхідно також відзначити, що  
існує цілий клас помилок, які можна виявити тільки за допомогою симуля-
тора. 
 

2.3.3 Плати розвитку 
Цей клас засобів проектування мікроконтролерних систем є найбільш 

численним [14, 15]. Умовно їх можна розділити на такі типи: 
− оціночні комплекти (Evaluation kit) – набір розміщених на платі 

апаратних засобів для реалізації нескладних систем; 
− налагоджувальні плати і системи (Evaluation board, system) – розмі-

щені на платі програмно-апаратні комплекси, що забезпечують моделю-
вання та налагодження систем на базі певних моделей мікроконтролерів; 

− одноплатні контролери (single-board controller) – конструктивні 
комплекси, що призначені для використання як базові модулі при реаліза-
ції цільових систем промислового застосування. 

Ці засоби можуть використовуватися для таких цілей: 
− тестування та налагодження програмного забезпечення систем на 

реальних зразках мікроконтролерів; 
− комплексне налагодження макета системи, що використовується, як 

зразок для реалізації прототипу системи; 
− реалізація цільової системи, до складу якої входять плати розвитку 

як базові модулі; 
− вивчення функціонування мікроконтролерів, отримання навичок  

їхнього практичного застосування. 
Практично всі типи плат розвитку містять у своєму складі порти для 

підключення персонального комп'ютера. Найчастіше для цієї мети викори-
стовується послідовний обмін за стандартом RS-232. Ряд типів налагоджу-
вальних і цільових плат мають також окреме поле для макетування корис-
тувачем додаткових пристроїв за допомогою проводового монтажу. 

Зважаючи на велику різноманітність галузей і способів застосування 
номенклатура плат розвитку дуже широка і чітка межа між їх типами від-
сутні. У багатьох випадках налагоджувальні плати можуть використовува-
тися в складі цільових систем, а одноплатні комп'ютери часто слугують 
засобами моделювання і налагодження прототипу систем.  

Оціночні комплекти і типові проекти 
Для інженерів, яким не потрібна гнучкість початкового комплекту 

STK600, хорошою альтернативою може стати будь-який з оціночних ком-
плектів або типових проектів. Вони специфічні для кожного пристрою і  
постачаються з мікроконтролером AVR і всіма необхідними компонентами. 

Для початківців рекомендуються такі оціночні комплекти для роботи 
з мікроконтролерами AVR: AVR Xplained та AVR UC3 EVK1104 [14, 15]. 

AVR Xplained. Комплект для створення проектів на базі Atmel AVR 
XMEGA; оснащений МК ATmega128A1 та додатковими компонентами, що 
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дозволяють оцінити функції пристрою. Комплект має всі необхідні апарат-
ні засоби для оцінки високоточних аналогових функцій пристроїв Atmel 
AVR і демонстрації способів взаємодії із зовнішніми модулями пам'яті. Він 
містить пам'ять SDRAM 8 МБ, флеш-пам'ять DataFlash 8 МБ, підключені 
до Atmel ATxmega128A1, а також 8 кнопок і 8 світлодіодних індикаторів 
для взаємодії з користувачем. Як комунікаційний шлюз між портом USB 
COM МК ATxmega128A1 і джерелом живлення виступає інтерфейс USB. 
Для зчитування даних датчика температури і потенціометра можна вико-
ристовувати АЦП, а для генерації звуку на монодинамік – ЦАП.  

EVK1104. Оціночний комплект для 32-розрядного мікроконтролера 
Atmel AVR AT32UC3A3256 з комунікаційними інтерфейсами. Цей оціноч-
ний комплект поєднує 32-розрядний мікроконтролер Atmel AVR UC3 з  
багатим набором комунікаційних інтерфейсів, включаючи On-The-Go і 
SDcard, а також флеш-пам'ять NAND з ECC і 16-розрядний стерео-ЦАП. 

QT600. Повноцінний комплект розробника для реалізації кнопок, пов-
зунків і коліс прокрутки. Atmel QT600 дозволяє експериментувати з сенсор-
ною технологією Atmel і є найпростішим способом аналізу та оцінки сен-
сорних рішень Atmel. Підтримуються обидві технології Atmel для введення 
даних: QTouch, QMatrix. 

Як програмне забезпечення для взаємодії з комплектом використову-
ється середу QTouch Studio. Комплект містить інтерфейсну плату з  
роз'ємом USB, 3 мікроконтролерні плати (ATtiny88, ATmega324PA, 
ATxmega128A1), 3 сенсорні плати, що підтримують до 64 каналів, і кабелі. 

Програматори 
Особливу групу засобів розробки становлять програматори. За функ-

ціональним можливостям програматори умовно можна розділити на такі 
групи: 

− спеціалізовані програматори для мікросхем пам'яті (EPROM, 
EEPROM, FLASH); 

− спеціалізовані програматори для мікросхем пам'яті і внутрішньої 
пам'яті окремих наборів мікроконтролерів; 

− універсальні програматори мікросхем пам'яті, внутрішньої пам'яті 
мікроконтролерів, мікросхем програмованої логіки (PLD). 

Основні функціональні можливості сучасних програматорів: 
− тестова колодка з нульовим зусиллям (ZIF-socket), що забезпечує ба-

гаторазовий надійний контакт з програмованої мікросхемою в корпусі DIP; 
− для програмування мікросхем з корпусами, відмінними від DIP, 

програматори забезпечуються спеціальними адаптерами під відповідний 
тип корпуса; 

− можливість оновлення програмного забезпечення для розширення 
кількості програмованих мікросхем; 

− програмна встановлення параметрів програмування: Vccp, Vvpp; 
− самотестування при включенні живлення; 
− тестування правильності встановлення мікросхем; 
− перевірка якості контакту по всіх виводах запрограмованої мікро-

схеми; 
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− захист всіх виводів мікросхеми від перенапруги і статичної елект-
рики. 

Інтегровані середовища розробки 
Ідея єдності програмного і апаратного забезпечення систем на базі МК 

є дуже важливою. Об'єднання інструментальних засобів розробки програм-
ного забезпечення з інструментальними засобами розробки апаратного  
забезпечення може стати важливою перевагою при розробці пристроїв. 

Істотно полегшують і прискорюють процес розробки та налагодження 
мікропроцесорних систем так звані інтегровані середовища розробки.  
Вони поєднують у собі текстовий редактор для написання вихідних текс-
тів, транслятори з асемблера та С, лінкер, відлагоджувач, довідкову  
інформацію по МК і інші засоби, необхідні розробникові. Налаштування 
трансляторів, линкера й інших компонентів проводиться не методом вказів-
ки ключів у командному рядку, а у вигляді діалогових вікон, де потрібно 
тільки розставити «галочки» у потрібних місцях. Перетворення початкового 
програмного коду в файл машинних кодів запускається натисканням однієї 
клавішею. 

Поява інтегрованих середовищ розробки програм ще більше підвищи-
ло ефективність створення програм для МК, дозволило розробникові зосе-
редитися на суті розв'язуваної задачі і відволіктися від конкретних деталей 
її реалізації. Інтегровані пакети для розробки програм випускають кілька 
фірм, пакети різних виробників схожі між собою за функціями, але розріз-
няються наданими сервісними можливостями, зручністю роботи і якістю 
генерованого машинного коду. 

Як правило, хороше інтегроване середовище об'єднує наявні засоби 
налагодження (внутрішньосхемний емулятор, програмний симулятор і 
програматор) і забезпечує роботу програміста з текстами програм в стилі 
діалогових вікон. 

Інтегроване середовище дозволяє: 
− використовувати вбудований многофайловий текстовий редактор, 

спеціально орієнтований на роботу з вихідними текстами програм; 
− спостерігати одночасно у багатовіконному режимі діагностику  

виявлених при компілюванні помилок і одночасне редагування вихідного  
коду програми; 

− вести паралельну роботу над декількома проектами. Менеджер прое-
ктів дозволяє використовувати будь-який проект як шаблон для новоство-
рюваного. Опції використовуваних компіляторів і список вихідних файлів 
проекту встановлюються в діалогових меню і зберігаються в межах проекту, 
усуваючи необхідність роботи з незручними bat-файлами: піддавати пере-
компілюванню, лише редагувати модулі; завантажувати відлагоджену про-
граму в наявні засоби налагодження і працювати з ними без виходу з оболо-
нки; підключати до оболонки практично будь-які програмні засоби. 

Останнім часом функції інтегрованих середовищ розробки стають 
приналежністю програмних інтерфейсів найбільш «просунутих» емулято-
рів і відлагоджувачів симуляторів. Такі функціональні можливості в поєд-
нанні з дружнім інтерфейсом істотно прискорюють роботу програміста. 
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Так, вибираючи інструментальні засоби налагодження, доцільно брати 
до уваги такий комплекс показників: 
− підтримка можливо більшої кількості мікроконтролерів; 
− різноманітність вбудованих інтерфейсів (RS-232, IEEE1284/LPT, USB) і 

додаткових компонентів, що розширюють функціональні можливості; 
− наявність на платі поля для макетування і контактів для безпосередньо-

го підключення до виводів приладу; 
− можливість підключення додаткових модулів; 
− хороше співвідношення високої функціональності до ціни; 
− наявність демонстраційних програм і прикладів використання; 
− універсальне живлення (живлення від зовнішнього джерела, інтерфей-

сів ПК, батареї, наявність вбудованих регуляторів напруги). 
 

Питання для самоконтролю 
 

1. Дайте загальну оцінку апаратним засоби підтримки мікроконтроле-
рів AVR. 

2. Які є спеціалізовані професійні інструментальні засоби налагоджу-
вання? 

3. Основна функція вутрішньосхемного відлагоджувача. 
4. Наведіть кілька основних засобів розробки для мікроконтролерів 

фірми Atmel. 
5. Які Ви знаєте апаратні засоби підтримки проектування та відлаго-

дження систем? 
6. Які Ви знаєте апаратні засоби аналізу функціонування цифрових 

систем? 
7. Який програмно-апаратний комплекс під час налагодження заміщує 

мікроконтролер в реалізованої системі?  
8. Розкажіть про типи плат розвитку. 
9. Що таке оціночні комплекти і типові проекти? 
10. Призначення програматорів. 
11. Які переваги несе в собі використання інтегрованих середовищ  

розробки? 
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3 ПРОГРАМУВАННЯ МІКРОКОНТРОЛЕРІВ AVR 
 

3.1 Загальна інформація  
 
МК набору AVR підтримують такі режими програмування: режим  

послідовного програмування (по інтерфейсу SPI); режим високовольтного 
паралельного програмування (HVPP); режим програмування через інтер-
фейс JTAG. 

Під високою напругою розуміють напругу керування (12 В), що пода-
ється на вивід RESET мікроконтролера для переведення останнього в ре-
жим програмування. Які з режимів програмування підтримують деякі МК 
AVR, можна дізнатися, звернувшись до табл. 3.1. 

 
Таблиця 3.1 – Режими програмування мікроконтролерів набору AVR  

Режим 
програмування 

A
Tt

in
y1

3 

A
Tt

in
y2

5 

A
Tt

in
y2

31
3 

A
Tm

eg
a8

51
5x

/8
53

5x
 

A
Tm
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a8

x 

A
Tm

eg
a1

6x
/3

2x
 

A
Tm

eg
a6

4x
/1

28
x 

A
Tm

eg
a4

8x
/8

8x
/1

68
x 

A
Tm

eg
a1

62
x 

1. Послідовний (інтерфейс SPI) + + + + + + + + + 
2. Високовольтний паралельний + + + + + + + + + 
3. По інтерфейсу JTAG      + +  + 

 
До того ж, МК AVR мають можливість самопрограмування, тобто 

зміна вмісту пам'яті програм під керуванням самого мікроконтролера. 
У процесі програмування можуть виконуватися такі операції: 
− знищення кристала (chip erase); 
− читання/запис FLASH-пам'яті програм; 
− читання/запис EEPROM-пам'яті даних; 
− читання/запис конфігураційних комірок; 
− читання/запис комірок захисту; 
− читання комірок ідентифікатора; 
− читання байта калібрування. 

Усі моделі мікроконтролерів поставляються зі стертою пам'яттю про-
грам та пам'яттю даних (у всіх комірках знаходиться число $FF) і придатні 
до негайного програмування. 
 

3.1.1 Захист коду і даних 
Вміст FLASH-пам'яті програм, а також вміст EEPROM-пам'яті даних 

може бути захищеним від запису і/або читання за допомогою програму-
вання комірок захисту (Lock Bits) LB1 і LB2. Можливі режими захисту, які 
відповідають різним станам цих комірок, наведені в табл. 3.2. 
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Таблиця 3.2 – Режими захисту коду і даних 

№ режиму 
Комірки захисту 

Опис 
LB1 LB2 

1 1 1 Захист коду і даних відключений 
2 0 1 Запис FLASH і EEPROM заборонений 
3 0 0 Заборонені запис і читання FLASH і EEPROM 

 
У режимах 2 та 3 забороняється також зміна конфігураційних комі-

рок. Тому ввімкнення захисту потрібно виконувати в найостаннішу чергу, 
після програмування інших областей пам'яті мікроконтролера. 

У мікроконтролерах AVR набору ATmega, крім АТmega48х, є чотири 
додаткові комірки захисту ‒ BLB02, BLB01, BLB12 і BLB11. Комірки 
BLB02: BLB01 визначають рівень доступу із секції завантажувача до коду, 
розташованому в секції прикладної програми, а комірки BLB12: BLB11, 
навпаки, визначають рівень доступу з секції прикладної програми до коду, 
розташованому в секції завантажувача. Можливі режими захисту, які від-
повідають різним станам цих комірок, наведені в табл. 3.3 та табл. 3.4 від-
повідно. Усі перераховані комірки захисту згруповані в одному бай-
ті. Розташування комірок захисту в ньому для різних моделей мікроконт-
ролерів AVR наведено на рис. 3.1. 

 
Таблиця 3.3 – Режими захисту секції прикладної програми 

№ 
режиму 

Комірки захисту 
Опис 

BLB02 BLB01 

1 1 1 Немає жодних обмежень з доступу до коду, що розташо-
ваний у секції прикладної програми 

2 1 0 Команда SРМ не може здійснювати запис за адресами, які 
перебувають у межах секції прикладної програми 

3 0 0 

Команда SРМ не може здійснювати запис за адресами, які 
перебувають у межах секції прикладної програми; команда 
LPM (ЕLРМ), що викликається із секції завантажувача, не 
може здійснювати читання з секції прикладної програми. 
Якщо таблиця векторів переривань розташована в секції 
завантажувача, то при виконанні коду з секції прикладної 
програми переривання заборонені 

4 0 1 

Команда LPM (ЕLРМ), що викликається із секції заванта-
жувача, не може здійснювати читання із секції прикладної 
програми. 
Якщо таблиця векторів переривань розташована в секції 
завантажувача, то при виконанні коду з секції прикладної 
програми переривання заборонені 
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Таблиця 3.4 –  Режими захисту секції завантажувача 

№ режиму 
Комірки захисту 

Опис 
BLB12 BLB11 

1 2 3 4 

1 1 1 Немає жодних обмежень по доступу до коду, що роз-
ташований в секції завантажувача 

2 1 0 Команда SPM не може здійснювати запис за адресами, 
які перебувають у межах секції завантажувача 

3 0 0 

Команда SPM не може здійснювати запис за адресами, 
які перебувають у межах секції завантажувача, і  
команда LPM (ЕLРМ), що викликається із секції при-
кладної програми, не може здійснювати читання із 
секції завантажувача. Якщо таблиця векторів перери-
вань розташована в секції прикладної програми, то 
при виконанні коду із секції завантажувача перери-
вання заборонені 

4 0 1 

Команда LPM (ЕLРМ), що викликається із секції  
прикладної програми, не може здійснювати читання  
із секції завантажувача 
Якщо таблиця векторів переривань розташована в  
секції прикладної програми, то при виконанні коду із 
секції завантажувача переривання заборонені 

 

BLB12 BLB11 BLB02 BLB01 LB2 LB1

LB2 LB1

7 6 5 4 3 2 1 0

7 6 5 4 3 2 1 0

1 1 1 1 1 1 1 1

1 1 1 1 1 1 1 1
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ATmega48x

Mega

Початковий стан

Початковий стан

  
Рисунок 3.1 –  Байт комірок захисту 

 
У незапрограмованому стані у всіх комірках захисту міститься 1, піс-

ля програмування – 0. Знищення комірок (запис в них логічної 1) може бу-
ти зроблено тільки при виконанні команди «Знищення кристала», яка зни-
щує також вміст FLASH- і EEPROM-пам'яті. 

 
3.1.2 Конфігураційні комірки 
Конфігураційні комірки (Fuse Bits) визначають різні параметри конфі-

гурації мікроконтролера. Ці комірки розташовані в окремому адресному 
просторі, доступному тільки при програмуванні. Усі конфігураційні комір-
ки згруповані в кілька байтів, а склад цих комірок залежить від конкретної 
моделі мікроконтролера. Наявність тих чи інших комірок у конкретному 
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мікроконтролері можна визначити з табл. 3.5, де в стовпцях, позначених 
«зірочкою», указані стани конфігураційних комірок за замовчуванням. 

Основне призначення всіх конфігураційних комірок наведено в 
табл. 3.6.  Для зміни вмісту конфігураційних комірок використовуються 
спеціальні команди програмування. Команда «Знищення кристала» на стан 
цих комірок не впливає. При програмуванні комірки захисту LB1 конфігу-
раційні комірки блокуються. Тому конфігурацію мікроконтролера необ-
хідно виконувати до програмування комірок захисту. 

Таблиця 3.5 – Конфігураційні комірки мікроконтролерів AVR 

Бі
т ATmega8515 ATmega 8535 ATmega8х ATmega16х/ 

32х 
ATmega64х/ 

128х ATmega48х 

Назва * Назва * Назва * Назва * Назва * Назва * 
Молодший конфігураційний байт 

7 BODLEVEL 1 BODLEVEL 1 BODLEVEL 1 BODLEVEL 1 BODLEVEL 1 CKDIV8 0 
6 BODEN 1 BODEN 1 BODEN 1 BODEN 1 BODEN 1 CKOUT 1 
5 SUT1 1 SUT1 1 SUT1 1 SUT1 1 SUT1 1 SUT1 1 
4 SUT0 0 SUT0 0 SUT0 0 SUT0 0 SUT0 0 SUT0 0 
3 CKSEL3 0 CKSEL3 0 CKSEL3 0 CKSEL3 0 CKSEL3 0 CKSEL3 0 
2 CKSEL2 0 CKSEL2 0 CKSEL2 0 CKSEL2 0 CKSEL2 0 CKSEL2 0 
1 CKSEL1 0 CKSEL1 0 CKSEL1 0 CKSEL1 0 CKSEL1 0 CKSEL1 1 
0 CKSEL0 1 CKSEL0 1 CKSEL0 1 CKSEL0 1 CKSEL0 1 CKSEL0 0 

Старший конфігураційний байт 
7 S8515С 1 S8535С 1 RSTDISBL 1 OCDEN 1 OCDEN 1 RSTDISBL 1 
6 WDTON 1 WDTON 1 WDTON 1 JTAGEN 0 JTAGEN 0 DWEN 1 
5 SPIEN 0 SPIEN 0 SPIEN 0 SPIEN 0 SPIEN 0 SPIEN 0 
4 СКОРТ 1 СКОРТ 1 СКОРТ 1 СКОРТ 1 СКОРТ 1 WDTON 1 
3 ЕЕSАVЕ 1 ЕЕSАVЕ 1 ЕЕSАVЕ 1 ЕЕSАVЕ 1 ЕЕSАVЕ 1 ЕЕSАVЕ 1 
2 ВООТSZ1 0 ВООТSZ1 0 ВООТSZ1 0 ВООТSZ1 0 ВООТSZ1 0 ВООТSZ1 1 
1 ВООТSZ0 0 ВООТSZ0 0 ВООТSZ0 0 ВООТSZ0 0 ВООТSZ0 0 ВООТSZ0 1 
0 ВООТRST 1 ВООТRST 1 ВООТRST 1 ВООТRST 1 ВООТRST 1 ВООТRST 1 

Додатковий конфігураційний байт 
7 

— 

— 1 — 1 
6 — 1 — 1 
5 — 1 — 1 
4 — 1 — 1 
3 — 1 — 1 
2 — 1 — 1 
1 М103С 0 — 1 

0 WDTON I SELFPRGEN 1 
* Значення біта

Молодший конфігураційний байт 
7 СКDIV8 0 СКDIV8 0 СКDIV8 0 СКDIV8 0 СКDIV8 0 СКDIV8 0 
6 СКOUT і СКOUT 1 СКOUT 1 СКOUT 1 СКOUT 1 СКOUT 1 
5 SUT1 і SUT1 1 SUT1 1 SUT1 1 SUT1 1 SUT1 1 
4 SUT0 0 SUT0 0 SUT0 0 SUT0 0 SUT0 0 SUT0 0 
3 СКSEL3 0 СКSEL3 0 СКSEL3 0 СКSEL3 0 СКSEL3 0 СКSEL3 0 
2 СКSEL2 0 СКSEL2 0 СКSEL2 0 СКSEL2 0 СКSEL2 0 СКSEL2 0 
1 СКSEL1 1 СКSEL1 1 СКSEL1 1 СКSEL1 1 СКSEL1 1 СКSEL1 1 
0 СКSEL0 0 СКSEL0 0 СКSEL0 0 СКSEL0 0 СКSEL0 0 СКSEL0 0 
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Продовження таблиці 3.5 
Бі

т ATmega8515 ATmega 8535 ATmega8х ATmega16х/ 
32х 

ATmega64х/ 
128х ATmega48х 

Назва * Назва * Назва * Назва * Назва * Назва * 
Старший конфігураційний байт 

7 RSTDISBL 1 OCDEN 1 OCDEN 1 OCDEN 1 OCDEN 1 OCDEN 1 

6 DWEN 1 JTAGEN 0 JTAGEN 0 JTAGEN 0 JTAGEN 0 JTAGEN 0 

5 SPIEN 0 SPIEN 0 SPIEN 0 SPIEN 0 SPIEN 0 SPIEN 0 

4 WDTON 1 WDTON 1 WDTON 1 WDTON 1 WDTON 1 WDTON 1 

3 ЕЕSАVЕ 1 ЕЕSАVЕ 1 ЕЕSАVЕ 1 ЕЕSАVЕ 1 ЕЕSАVЕ 1 ЕЕSАVЕ 1 

2 BODLEVEL2 1 ВООТSZ1 0 ВООТSZ1 0 ВООТSZ1 0 ВООТSZ1 0 ВООТSZ1 0 

1 BODLEVEL1 1 ВООТSZ0 0 ВООТSZ0 0 ВООТSZ0 0 ВООТSZ0 0 ВООТSZ0 0 

0 BODLEVEL0 1 ВООТRST 1 ВООТRST 1 ВООТRST 1 ВООТRST 1 ВООТRST 1 

Додадковий конфігураційний байт 

7 ‒ 1 ‒ 1 ‒ 1 ‒ 1 ‒ 1 ‒ 1 

6 ‒ 1 ‒ 1 ‒ 1 ‒ 1 ‒ 1 ‒ 1 

5 ‒ 1 ‒ 1 ‒ 1 ‒ 1 ‒ 1 ‒ 1 

4 ‒ 1 М161С 1 ‒ 1 ‒ 1 ‒ 1 ‒ 1 

3 ‒ 1 BODLEVEL2 1 ‒ 1 BODLEVEL2 1 ‒ 1 ‒ 1 

2 ВООТSZ1 0 BODLEVEL1 1 BODLEVE
L2 1 BODLEVEL1 1 BODLEVEL1 1 BODLEVEL2 1 

1 ВООТSZ0 0 BODLEVEL0 1 BODLEVE
L1 1 BODLEVEL0 1 BODLEVEL1 1 BODLEVEL1 1 

0   ВООТRST 1 - 1 BODLEVE
L0 1 RESERVED 1 RSTDISBL 1 BODLEVEL0 1 

* Значення біта

Таблиця 3.6 – Призначення конфігураційних комірок 

Назва 

A
Tm

eg
a8

51
5х

 

A
Tm

eg
a8

53
5x

 

A
Tm

eg
a 

8х
 

A
Tm

eg
a1

6х
/3

2х
 

A
Tm

eg
a6

4х
/1

28
х 

A
Tm

eg
a4

8х
/8

8x
/1

68
x 

A
Tm

eg
a 

16
2х

 

A
Tm

eg
a1

64
x/

32
4х

/6
44

x 

A
Tm

eg
a1

65
х 

A
Tm

eg
a3

25
x/

32
50

х 
A

Tm
eg

a6
45

x/
64

50
x 

A
Tm

eg
a6

40
х/

12
80

x/
12

81
x 

A
Tm

eg
a2

56
0x

/2
56

1x
 

Призначення 

1 2 3 4 5 6 7 8 9 10 11 12 13 

RSTDISBL + + + 

Визначає функціонування 
виводу МК, поєднаного з 
виводом RESET  
(0 ‒ контакт порту  
введення/виведення,  
1 ‒ вивід скидання) 

71 



Продовження таблиці 3.6 
1 2 3 4 5 6 7 8 9 10 11 12 13 

CKSEL + + + + + + + + + + + 

Визначає режим роботи 
тактового генератора, а 
також тривалість затрим-
ки скидання, TOUT 

BODLEVEL + + + + + + + + + + + Визначає поріг спрацьо-
вування схеми BOR 

BODEN + + + + +       

Дозволяє/забороняє фун-
кціонування схеми BOR 
(0 ‒ дозволено,  
1 ‒ заборонено) 

SPIEN 1) + + + + + + + + + + + 

Дозволяє/забороняє про-
грамування по інтерфей-
су SPI (0 ‒ дозволено,  
1 ‒ заборонено) 

SUT + + + + + + + + + + + Визначає тривалість за-
тримки скидання, TOUT 

WDTON + + +  + + + + + + + 

Визначає режим роботи 
сторожового таймера  
(0 ‒ завжди включений,  
1 ‒ може бути виключе-
ний програмно) 

CKOPT + + + + +       

Визначає функціонування 
тактового генератора, дія 
залежить від установок 
комірок СКSEL 

ЕЕSАVЕ 2) + + + + + + + + + + + 

Визначає вплив команди 
«Знищення кристала» на 
ЕЕРRОМ-пам'ять (0 ‒ не 
стирає, 1 ‒ стирає) 

BOOTSZ + + + + + + + + + + + Визначає розмір секції 
завантажувача 

BOOTRST + + + + + + + + + + + Визначає положення  
вектора скидання 

DWEN      +      

Дозволяє/забороняє робо-
ту інтерфейсу debugWire 
(0 ‒ дозволено, 1 ‒ забо-
ронено) 

OCDEN    + +  + + + + + 

Дозволяє/забороняє вну-
трішньосхемне налаго-
дження (0 – дозволено,  
1 ‒ заборонено) 

JTAGEN    + +  + + + + + 

Дозволяє/забороняє ви-
користання інтерфейсу 
JTAG (0 – дозволено,  
1 – заборонено) 

СКDIV8      + + + + + + 
Визначає початковий 
стан подільника систем-
ного тактового сигналу 
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Продовження таблиці 3.6 
1 2 3 4 5 6 7 8 9 10 11 12 13 

CKOUT      + + + + + + 

Визначає стан вихідного 
буфера системного такто-
вого сигналу (0 – підклю-
чений до виводу МК,   
1–відключений) 

SELFPRGE
N3)      +      Дозвіл самопрограмуван-

ня (0 – дозволено) 

S8515C +           

Вмикає/вимикає режим 
сумісності з МК 
AT90S4414/8515 набору 
Classic (0 ‒ включений,  
1 ‒ виключений) 

S8535C  +          

Вмикає/вимикає режим 
сумісності з МК 
AT90S8535 набору 
Classic (0 ‒ включений,  
1 ‒ виключений) 

M161C       +     

Вмикає/вимикає режим 
сумісності з МК 
ATmega161х набору 
Mega (0 ‒ включений, 
1 ‒ виключений) 

M103C     +       

Вмикає/вимикає режим 
сумісності з МК 
ATmega103х набору 
Mega (0 ‒ включений,  
1 ‒ виключений) 

 
3.1.3 Ідентифікатор 
Усі МК фірми Atmel мають три 8-бітові комірки, вміст яких дозволяє 

ідентифікувати пристрій.  
У першій клітинці міститься код виробника, у другій ‒ код обсягу 

FLASH-пам’яті, а в третій ‒ код пристрою. Як і конфігураційні комірки, 
комірки ідентифікатора розташовані в окремому адресному просторі, дос-
туп до якого можливий тільки в режимі програмування.  

Однак, на відміну від конфігураційних комірок, комірки ідентифіка-
тора доступні тільки для читання.  

Вміст комірок ідентифікатора для всіх мікроконтролерів набору Mega 
приведено в табл. 3.7. 

Як видно з табл. 3.7, значення коду пристрою (комірка $ 02) у різних 
моделей може збігатися. Тому пристрій варто ідентифікувати тільки за су-
купністю значень комірок $ 01 і $ 02, так як саме ця пара чисел є унікаль-
ною для кожного мікроконтролера. 
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Таблиця 3.7 – Комірки ідентифікатора мікроконтролерів набору Mega 
Модель 

Комірка ідентифікатора 
$ 00 $ 01 $ 02 

АТmega 8515х $ 1Е $ 93 $ 06 
АТmega 8535х $ IЕ $ 93 $ 08 
АТmega 8х $ IЕ $ 93 $ 07 
АТmega 16х $ IЕ $ 94 $ 03 
АТmega 32х $ 1Е $ 95 $ 02 
АТmega 64х $ 1Е $ 96 $ 02 
АТmega 128х $ 1Е $ 97 $ 02 
АТmega 48х $ 1Е $ 92 $ 05 
АТmega 88х $ 1Е $ 93 $ 0А 
АТmega 168х $ 1Е $ 94 $ 06 
АТmega l62x $ 1Е $ 94 $ 04 
АТmega 164х $ 1Е $ 94 ‒ 
ATmega 324x $ 1Е $ 95 ‒ 
АТmega 644х $ 1Е $ 96 ‒ 
АТmega 165х $ 1Е $ 94 $ 07 
ATmega 325x $ 1Е $ 95 $ 05 
ATmega 3250x $ 1Е $ 95 $ 05  
ATmega 645x $ 1Е $ 96 $ 06 
АТmega 6450x $ 1Е $ 96 $ 06 
АТmega 640х 51Е $ 96 $ 08 
АТmega l280x $ 1Е $ 97 $ 03 
АТmega l281x $ 1Е $ 97 $ 04 
АТmega 2560x $ 1Е $ 98 $ 01 

 
3.1.4  Комірки калібрування 
У калібрувальні комірки при виготовленні мікроконтролера заносять-

ся константи калібрування, які призначені для підстроювання на номіналь-
ну частоту внутрішнього RС-генератора. Кількість цих комірок залежить 
від того, на скількох частотах може працювати внутрішній RC-генератор. 
У моделях АТmegа8515х/8535х і АТmega8х/16х/32х/64х/128х є чотири  
8-бітних комірки, а в інших моделях ‒ одна комірка. Знаходяться вони в 
старших байтах адресного простору комірок ідентифікатора (одна комірка 
‒ за адресою $ 000, чотири комірки ‒ за адресами $ 000, $ 001, $ 002 і $ 003 
для частот 1, 2, 4 і 8 МГц відповідно). 

Завантаження калібрувальної константи в регістр OSCCAL здійсню-
ється апаратно при знаходженні мікроконтролера в стані скидання. Однак 
у моделях АТmega8515х/8535х і АТmega8х/16х/32х/64х/128х генератор 
автоматично калібрується тільки на частоту 1 МГц. Тому при використанні 
іншої частоти RC-генератора його калібрування необхідно здійснювати 
вручну. Для цього вибору програматор під час програмування має прочи-
тати вміст комірки калібрування і занести його за будь-якою адресою 
FLASH-пам'яті програм. А програма має після старту зчитати це значення 
з пам'яті програм і занести його в регістр OSCCAL. 
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3.1.5 Організація пам'яті програм і даних 
У мікрококнтролерах набору Classic, Mega використовується сторін-

кова організація пам'яті програм. При програмуванні весь обсяг FLASH-
пам'яті розбивається на 16-бітові сторінки, розмір яких, а також їхня кіль-
кість залежать від обсягу пам'яті програм мікроконтролера (табл. 3.8). 

 
Таблиця 3.8 – Параметри сторінкової організації пам'яті програм 

Параметр 
Обсяг пам'яті програм [байт] 

4К 8К 16К 32К 64К 128К 256К 
Розмір сторінки, слів 32 32 64 64 128 128 128 
Кількість сторінок 64 128 128 256 256 512 1024 

 
При програмуванні пам'яті програм мікроконтролерів набору Classic, 

Mega дані спочатку завантажуються до буферу сторінки і тільки потім за-
носяться безпосередньо в пам'ять програм. Прошивка всіх комірок сторін-
ки при цьому здійснюється одночасно. 

Аналогічно організована і EEPROM-пам'ять. Розмір 8-бітних сторінок 
EEPROM-пам'яті, а також їхня кількість для моделей Mega мікроконтроле-
рів наведені в табл. 3.9. 

 
Таблиця 3.9 – Параметри сторінкової організації EEPROM-пам'яті 

Параметр 
Обсяг ЕЕРRОМ-пам'яті [байт] 

256 512 1К 2К 4К 
Розмір сторінки, байт 4 4 4 8 8 
Кількість сторінок 64 128 256 256 512 

 
Однак варто зазначити, що в багатьох моделях сторінкова організація 

EEPROM-пам'яті використовується тільки при програмуванні в паралель-
ному режимі, а програмування по послідовному каналу здійснюється  
побайтно. 

 
3.2 Програмування по послідовному каналу 

 
У режимі програмування по послідовному каналу програмування  

пам'яті програм і даних здійснюється по послідовному інтерфейсу SPI. Як 
правило, цей режим використовується для програмування (перепрограму-
вання) мікроконтролера безпосередньо в пристрої. 

Схема ввімкнення мікросхем у режимі програмування по послідовно-
му каналу наведено на рис. 3.2. На цьому ж рисунку наведено два варіанти 
розведення колодки для підключення програматора, рекомендовані компа-
нією Atmel. Як видно з рис. 3.2, для обміну даними між програматором і 
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пристроєм використовуються три лінії: SCK (тактовий сигнал), MOSI (вхід 
даних) і MISO (вихід даних). Відповідність між лініями інтерфейсу і кон-
тактами портів введення/виведення мікроконтролерів набору Mega зобра-
жено в табл. 3.10. Параметри сигналів при програмуванні по послідовному 
каналу зображено в табл. 3.11.  
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Рисунок 3.2 – Увімкнення мікроконтролерів у режимі програмування  
по послідовному каналу 

 
Таблиця 3.10 – Виводи мікроконтролерів Mega, які використовуються 

при програмуванні по послідовному каналу 

Назва 
лінії 

інтерфейсу 

A
Tm

eg
a8

51
5х

/8
53

5х
 

A
Tm

eg
a8

x 

A
Tm

eg
a1

6x
/3

2x
 

A
TY

ne
ga

64
x/

12
8x

 

A
Tm

eg
a4

8x
/8

8x
/1

68
x 

A
Tm

eg
al

62
x 

A
Tm

eg
a1

64
x/

32
4x

/6
44

x 

A
Tm

eg
a1

65
x/

32
5x

/3
25

0x
 

A
Tm

eg
a6

45
x/

64
50

x 

A
Tm

eg
a6

40
x/

12
80

x/
25

60
x 

A
Tm

eg
a1

28
1x

/2
56

1x
 Призначення 

виводів 

SCK PB7 РВ5 РВ7 РВ1 PB5 PB7 PB7 PB1 PB1 PB1 Вхід тактового сигналу 

MISO (PD0) РВ6 РВ4 РВ6 РЕ1 PB4 PB6 PB6 РВ3 PE1 PB3 Вихід даних 

MOSI (PD1) РВ5 РВЗ РВ5 PE0 РВЗ PB5 PB5 PB2 PE0 PB2 Вхід даних 
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Таблиця 3.11– Параметри сигналів при програмуванні по послідовному 
каналу  

Позначення Параметр min typ mах 

   АТmega 162V 0 ‒ 1 

 

 VCC  =   
= 1.8...5.5 В 

АТmega 48V/88V/168V, 
АТmega 164V/324V/644V, 
АТmega 165V/325V/3250V/645V/6450V,  
АТmega 640V/1280V/1281V/2560V/2561V 

0 ‒ 4 

1/t CLCL 

частота 
тактового 
сигналу, 
МГц 

VCC =  
= 2.7...5.5В 

АТmega 8515L/8535L 
АТmega 8L/16L/32L/64L/128L, 
АТmega 162L 
АТmega165х/325х/3250х/645х/6450х, 
ATmega640x/l280х/г/2560х/2561х 

0 ‒ 8 

 
 АТmega48х/88х/168х, 

ATmega164х/324х/644х 0 ‒ 10 

 

 

VCC = 
= 4.5...5.5 В 

АТmega 8515/8535, 
АТmega 8/1б/32/64/128, 
ATmega l62, 
ATmega 165/325/3250/645/6450, 
АТmega 640/1280/1281/2560/2561 

0 ‒ 16 

 
  АТmega 48/88/168, 

ATmega 164/324/644 0 ‒ 20 

tSHSL Тривалість позитивного імпульсу сигналу SCK, нс 2tCLCL
1) ‒ ‒ 

tSLSH Тривалість негативного імпульсу сигналу SCK, нс 2tCLCL
1) ‒ ‒ 

tOVSH 
Затримка наростаючого фронту сигналу SCK щодо встановлення 

сигналу MOSI, нс tCLCL ‒ ‒ 

tSHOX 
Час утримання сигналу MOSI щодо наростаючого фронту сигналу 

SCK, нс 2tCLCL
1) ‒ ‒ 

tSLIV 
Затримка встановлення сигналу MISO щодо спадаючого фронту 

сигналу SCK, нс 10 16 32 

tWD_ERASE 
Період очікування після завантаження команди  

«Знищення кристала», мс 9 ‒ ‒ 

tWD_FLASH Період очікування після запису FLASH-пам'яті, мс 4.5 ‒ ‒ 

tWD_EEPROM Період очікування після запису EEPROM-пам'яті, мс 9 ‒ ‒ 

t WD_FUSE 
Період очікування після запису конфігураційних комірок  

або комірок захисту, мс 4.5 ‒ ‒ 

 
Як і в робочому режимі, при програмуванні по послідовному каналу 

мікроконтролеру потрібно джерело тактового сигналу. Як джерела такто-
вого сигналу може використовуватися будь-яке таке джерело. При цьому 
має виконуватися така умова: тривалість імпульсів як «0», так і «1» рівня 
сигналу SCK має бути більше 2 (при f ск <12 МГц) або 3 (при fск > 12 МГц) 
періодів тактового сигналу мікроконтролера. 

77 



Програмування здійснюється шляхом посилки 4-байтних команд на 
вивід MOSI мікроконтролера. Результат виконання команд читання зніма-
ється з виводу MISO мікроконтролера. Передача команд і видача результа-
тів їхнього виконання здійснюються від старшого біта до молодшого. 
Формат усіх команд, які використовуються для програмування мікроконт-
ролерів набору в цьому режимі, наведено в табл. 3.12. 

Таблиця 3.12 – Команди режиму програмування по послідовному 
каналу 

Команда 
Формат команди 

Опис команди 1-й 
байт 

2-й 
байт 

3-й 
байт 

4-й 
байт 

Дозвіл 
програмування $ АС $ 53 $ 00 $ 00 

Дозволяє програмування МК, 
допоки на виводі RESET��������� прису-
тня напруга НИЗЬКОГО рівня 

Знищення 
кристала $ АС $ 80 $ 00 $ 00 Очищення вмісту FLASH- і 

EEPROM-пам'яті 

Читання 
прапорця
готовності 
RDY/BSY�����1) 

$ F0 $ 00 $ 00 дані 

Якщо 0-й біт прийнятого байта 
скинутий в 0, то попередня 
операція програмування не за-
вершена. Перед посилкою но-
вої команди програмування не-
обхідно дочекатися встанов-
лення цього біта в 1 

Завантаження 
додаткового бай-
та адреси 

$ 40 $ 00 адреса $ 00 

Завантаження старшого байта 
адреси слова даних в моделях 
АТmega2560х/2561х (викорис-
товується тільки молодший біт) 

Команди завантаження 
Завантаження 
сторінки FLASH-
пам'яті, старший 
байт 

$ 48 $ 00 адреса старший 
байт 

Запис молодшого/старшого  
байта в  
буфер сторінки пам'яті  
програм. Адреса є адресою  
слова в  
межах сторінки. Молодший байт 
має завантажуватися першим 

Завантаження 
сторінки FLASH-
пам'яті, молод-
ший байт 

$ 40 $ 00 адреса молодший 
байт 

Завантаження 
сторінки 
ЕЕРRОМ-пам'яті 
(сторінковий 
доступ) 1) 

$ С1 $ 00 адреса дані 

Запис байта в буфер сторінки 
ЕЕРRОМ-пам'яті 
Адреса є адресою байта в межах 
сторінки 
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Продовження таблиці 3.12 

Команда 
Формат команди 

Опис команди 1-й 
байт 

2-й 
байт 

3-й 
байт 

4-й 
байт 

команди читання 
читання 
FLASH-пам'яті, 
старший байт 

$28 
адреса 

(ст. 
байт) 

адреса 
(мол. 
байт) 

дані 
Читання старшого/молодшого 
байта пам'яті програм. Адреса є 
адресою слова в межах адрес-
ного простору пам'яті програм. 
У моделях АТmega 2560х/2561х 
попередньо повинен бути зава-
нтажений старший біт адреси 
(команда завантаження додат-
кового байта адреси) 

читання 
FLASH-пам'яті, 
молодший байт 

$20 
адреса 

(ст. 
байт) 

адреса 
(мол. 
байт) 

дані 

читання 
ЕЕРRОМ-пам'яті $А0 

адреса 
(ст. 

байт) 

адреса 
(мол. 
байт) 

дані 

Читання вмісту комірки 
ЕЕРRОМ-пам'яті. Адреса є  
адресою байта в межах адрес-
ного простору ЕЕРRОМ 

Читання комірок 
захисту $58 $00 $00 дані Читання байта, що містить зна-

чення комірок захисту 

читання іденти-
фікатора $30 $00 адреса дані 

Читання байта ідентифікатора з 
заданим адресою (тільки в ре-
жимах захисту №1 і №2, див. 
табл. 3.2) 

Читання молод-
шого конфігура-
ційного байта 

$50 $00 $00 дані 
Читання конфігураційних комі-
рок. Скинутий біт означає, що 
відповідна конфігураційна ко-
мірка запрограмована Читання старшо-

го конфігурацій-
ного байта 

$58 $08 $00 дані 

Читання додатко-
вого конфігура-
ційного байта 

$50 $08 $00 дані 

Читання конфігураційних комі-
рок. Скинутий біт означає, що 
відповідна конфігураційна ко-
мірка запрограмована 

Читання калібру-
вальної комірки $38 $00 адреса дані Читання калібрувальної конста-

нти за заданою адресою 
Команди запису 

Запис сторінки 
FLASH-пам'яті 

$4С адреса 
(ст. 

байт) 

адреса 
(мол. 
байт) 

$ 00 Запис сторінки пам'яті програм 
за заданою адресою. Адреса 
являє собою значення старших 
бітів слів завантаженої сторін-
ки. У моделях 
АТmega25б0х/2561х попередньо 
повинен бути завантажений ста-
рший біт адреси (команда зава-
нтаження додаткового байта 
адреси) 
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Продовження таблиці 3.12 

Команда 
Формат команди 

Опис команди 1-й 
байт 

2-й 
байт 

3-й 
байт 

4-й 
байт 

запис 
ЕЕРRОМ-пам'яті $С0 

адреса 
(ст. 

байт) 

адреса 
(мол. 
байт) 

дані 
Запис значення в клітинку 
ЕЕРRОМ-пам'яті по заданій 
адресі 

Запис сторінки 
ЕЕРRОМ-пам'яті 
(сторінковий дос-
туп) 

$С2 
адреса 

(ст. 
байт) 

адреса 
(мол. 
байт) 

$ 00 Запис сторінки ЕЕРRОМ-пам'яті 
за заданою адресою  

Запис комірок 
захисту $АС $ Е0 $ 00 дані 

Запис комірок захисту. Для про-
грамування комірки відповідний 
біт байта даних має бути скину-
тий 

Запис молодшого 
конфігураційного 
байта 

$ АС $ А0 $ 00 дані 

Запис конфігураційних комірок. 
Для програмування комірки 
відповідний біт байта даних по-
винен бути скинутий 

Запис старшого 
конфігураційного 
байта 

$ АС $ А8 $ 00 дані 

Запис додатково-
го конфігурацій-
ного байта 

$ АС $ А4 $ 00 дані 

 
3.2.1 Перемикання в режим програмування 
Для переведення мікроконтролера в режим програмування по послі-

довному каналу необхідно виконати такі дії: 
1. Подати на мікроконтролер напругу живлення, при цьому на виво-

дах SCK і RESET��������� має бути присутньою напруга «0» рівня.  
2. Зачекати не менше 20 мс. 
3. Послати на вивід MOSI команду «Дозвіл програмування». 
Для контролю проходження команди при посиланні 3-го байта повер-

тається значення 2-го байта ($53). Якщо значення, що повертається відмінно 
від зазначеного, необхідно подати на вивід RESET��������� позитивний імпульс і 
знову послати команду «Дозвіл програмування». Причому незалежно від 
значення, що повертається необхідно передавати всі 4 байти команди. Від-
сутність повернення числа $53 після кількох спроб вказує на відсутність 
зв'язку між програматором і мікросхемою або на несправність мікросхеми. 

Після завершення програмування на вивід RESET��������� можна подати на-
пругу рівня «1» для переведення мікроконтролера в робочий режим або 
вимкнути його. В останньому випадку необхідно виконати таку послідов-
ність дій: 

1) Подати на вивід XTAL1 напругу рівня «0», якщо тактування мікро-
контролера здійснюється від зовнішньої схеми. 

2) Подати на вивід RESET��������� напругу рівня «1». 
3) Відключити напругу живлення від мікроконтролера. 

80 



3.2.2 Управління процесом програмування FLASH-пам'яті 
Програмування пам'яті програм мікроконтролерів набору Mega здійс-

нюється посторінково. Спочатку вміст сторінки побайтно заноситься в бу-
фер по командах «Завантаження сторінки FLASH-пам'яті». У кожній ко-
манді передаються молодші біти адреси змінною комірки (положення ко-
мірки всередині сторінки) і записується значення. Вміст кожної комірки 
має завантажуватися в такій послідовності: спочатку молодший байт, по-
тім старший. 

Фактичне програмування сторінки FLASH-пам'яті здійснюється після 
завантаження буфера сторінки за командою «Запис сторінки FLASH-
пам'яті». У команді передаються старші біти адреси комірок (номер  
сторінки). 

Подальше програмування пам'яті можна буде виконувати тільки після 
завершення запису сторінки. Визначити момент закінчення запису можна 
трьома способами. Перший і найбільш простий спосіб ‒ витримувати  
між посиланням команд паузу тривалістю не менше TWD_FLASH (табл. 3.11). 
Другий спосіб полягає в контролюванні вмісту будь-якої із записуваних 
комірок після посилання команди запису: до завершення запису комірки 
при її читанні повертається значення $ FF? а після завершення – записане 
значення.Третій спосіб – аналіз стану прапорця готовності RDY/BSY����� за до-
помогою відповідної команди і відновлення процесу програмування після 
встановлення прапорця в «1». 

 

3.2.3 Управління процесом програмування EEPROM-пам'яті 
У всіх старих моделях програмування ЕЕРROМ-пам'яті здійснюється 

звичайним способом – побайтно. У нових моделях з'явився альтернатив-
ний спосіб запису ЕЕРRОМ-пам'яті – посторінковий. Вміст сторінки по-
байтно заноситься в буфер по командах «Завантаження сторінки ЕЕРRОМ-
пам'яті», а потім здійснюється фактичне програмування сторінки 
ЕЕРRОМ-пам'яті за командою «Запис сторінки ЕЕРRОМ-пам'яті». Значен-
ня адрес, що передаються в цих командах, визначаються так само, як і при 
програмуванні ЕЕPROM-пам'яті. Для визначення моменту закінчення за-
пису можна використовувати будь-який з описаних вище способів. 

 

3.3 Паралельне програмування 
 

У режимі паралельного програмування, як випливає з його назви, від 
програматора до мікроконтролеру передаються одночасно всі біти коду 
команди або байта даних. Цей режим задіє велику число виводів мікрокон-
тролера і, до того ж, вимагає використання додаткового джерела підвище-
ної напруги (12 В). Тому програмування в паралельному режимі здійсню-
ється спеціалізованими програматорами. Основне застосування цього ре-
жиму ‒ «прошивка» мікроконтролерів перед установкою їх на плату в 
умовах масового виробництва. 

Схема ввімкнення мікросхем у режимі паралельного програмування 
зображено на рис. 3.3. Призначення сигналів, присутніх на виводах мікро-
контролера в цьому режимі, наведено в табл. 3.13‒3.15.   
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Рисунок 3.3 –  Увімкнення мікроконтролерів  
у режимі паралельного програмування 

 
Таблиця 3.13 – Позначення та функції виводів, що використовуються 

при програмуванні в паралельному режимі 
Сигнал Вивід Вхід/вихід Призначення 

RDY/BSY����� РD1 вихід 

Стан пристрою: 
0 ‒ зайнято (виконується попередня  
команда); 1 ‒ готово до прийому наступ-
ної команди 

ОЕ РD2 Вхід Управління режимом роботи шини даних 
РВ7 ... РВ0: 0 ‒ вихід, 1 ‒ вхід 

WR РDЗ Вхід Сигнал запису (активний рівень ‒ лог. 0) 
ВS1 РD4 Вхід Вибір байта (табл. 3.14) 

ХА0 РD5 Вхід Визначають дію, яка виконується по  
позитивному імпульсу на виводі ХТАL1 
(табл. 3.15) ХА1 РD6 Вхід 

РАGEL РD7 Вхід Сигнал завантаження сторінки пам'яті 
ВS2 РА0 Вхід Вибір байта (табл. 3.14) 

DАТА РВ7...РВ0 Вхід/вихід Двонаправлена шина даних 
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Таблиця 3.14 –  Функції сигналів BS1 і BS2 

BS2 BS1 Адреси 
FLASH/ЕЕРROМ 

Завантаження/читання 
FLASH 

Програмування 
конфігураційних 

комірок 

Читання 
конфігурацій-
них комірок і 

комірок захисту 
0 0 молодший байт молодший байт молодший байт молодший байт 

0 1 старший байт старший байт старший байт байт комірок  
захисту 

1 0 додатковий 
байт зарезервовано додатковий 

байт 
додатковий 

байт 

1 1 зарезервовано зарезервовано зарезервовано старший байт 

 
Таблиця 3.15 – Функції сигналів ХА0 і ХА1 

ХА1 ХА0 Дія, що виконується по тактовому імпульсу 

0 0 Завантаження адреси комірки пам'яті (молодшого або старшого байта залежно 
від рівня сигналу BS1) 

0 1 завантаження даних (молодшого або старшого байта залежно від рівня сигналу 
BS1) 

1 0 Завантаження команди 
1 1 Немає дії, режим очікування 

 
Таблиця 3.16 – Параметри сигналів (програмування в паралельному 

режимі) 
Позна- 
чення Параметр Min Мax Одиниці 

виміру 
Vpp Напруга дозволу програмування 11,5 12,5 В 
Ipp Струм, споживаний від джерела +12 В (V pp) ‒ 250 мкА 

tDVXH 
Затримка сигналу ХТАL1 відносно моменту встановлення 
сигналів управління і даних 67 ‒ нс 

tXLXH Інтервал між імпульсами сигналу ХТАL1 200 ‒ нс 
tXHXL Тривалість імпульсів сигналу ХТАL1 150 ‒ нс 

tXLDX 
Час утримання сигналів управління і даних щодо заднього 
фронту сигналу ХТАL1 67 ‒ нс 

tXLWL Затримка сигналу відносно заднього фронту сигналу ХТАL1 0 ‒ нс 

tXLPH Затримка сигналу PAGEL відносно заднього фронту сигналу 
ХТАL1 0 ‒ нс 

tPLXH Затримка сигналу ХТАL1 відносно заднього фронту сигналу 
PAGEL 150 ‒ нс 

tBVPH Затримка сигналу PAGEL відносно сигналу ВS1 67 ‒ нс 
tPHPL Тривалість імпульсу сигналу РАGЕL 150 ‒ нс 

tPLBX Час утримання сигналу ВS1 щодо заднього фронту сигналу 
PAGEL 67 ‒ нс 

tWHBX Час утримання сигналів ВS1/ВS2 щодо заднього фронту 
сигналу WR����� 67 ‒ нс 

tPLWL Затримка сигналу щодо заднього фронту сигналу PAGEL 67 ‒ нс 
tBVWL Затримка сигналу щодо моменту встановлення сигналу ВS1 67 ‒ нс 

tRHBX Час утримання сигналу ВS1 щодо заднього фронту сигналу 
RDY/BSY����� 67 ‒ нс 
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Продовження таблиці 3.16 
Позна- 
чення Параметр Min Мax Одиниці 

виміру 
tWLWH Тривалість імпульсу сигналу 150 ‒ Нс 

tWLRL Затримка появи сигналу RDY/BSY�����щодо переднього фронту 
сигналу WR����� 0 1 мкс 

tWLRH Затримка зняття сигналу RDY/BSY����� щодо переднього фронту 
сигналу 3.4 4.5 мс 

tWLRH_CE Затримка зняття сигналу RDY/BSY����� щодо переднього фронту 
сигналу для команди «Знищення кристала»  WR����� 7.5 9 7 мс 

tXLOL Затримка сигналу ОЕ щодо заднього фронту сигналу ХТАL1 0 ‒ нс 

tBHDV Час встановлення сигналів даних щодо наростаючого фрон-
ту сигналу ВS 1 0 250 нс 

tOLDV Час встановлення сигналів даних щодо переднього фронту 
сигналу ОЕ����� ‒ 250 нс 

tOHDZ Затримка перемикання шини даних в третій стан щодо зад-
нього фронту сигналу  ОЕ����� ‒ 250 нс 

 
У загальних рисах процес програмування в цьому режимі складається 

з багаторазового виконання таких операцій: 
−  завантаження команди; 
−  завантаження адреси; 
−  завантаження даних; 
−  виконання команди. 
Послідовність подачі сигналів на виводи мікроконтролера при вико-

нанні різних базових операцій наведено в табл. 3.17. 
  

Таблиця 3.17 –  Базові операції програмування в паралельному режимі 
№ Назва 

операції Дії 

1 Завантаження  
команди 

1. Установити виводи ХА1, ХА0 у стан 10 (завантаження ко-
манди) 
2. Подати на вивід BS1 напругу логічний 0 
3. Виставити на шину DATA код команди (табл. 3.18) 
4. Подати на вивід XTAL1 позитивний імпульс 

2 Завантаження  
адреси 

1. Установити висновки ХА1, ХА0 в стан 00 (завантаження ад-
реси) 
2. Установити виводи BS2: BS1 у стан 00 (завантаження моло-
дшого байта), 01 (завантаження старшого байта) або 10 (заван-
таження додаткового байта) 
3. Виставити на шину DATA байт адреси 
4. Подати на вивід XTAL1 позитивний імпульс 

3 Завантаження  
даних 

1. Установити виводи ХА1, ХА0 у стан 01 (завантаження да-
них) 
2. Подати на вивід BS1 напругу логічний 0 (завантаження мо-
лодшого байта) або логічна 1(завантаження старшого байта) 
3. Виставити на шину DATA вміст байта даних 
4. Подати на вивід XTAL1 позитивний імпульс 
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Продовження таблиці 3.17 

№ Назва 
операції Дії 

4 Запис даних у 
буфер сторінки 

1. Подати на вивід ВS1 напругу логічна 1 
2. Подать на вивід PAGEL позитивний імпульс 

5 Запис байта  
конфігурації 

1. Установити виводи ВS2: ВS1 у стан 00 (запис молодшого 
байта), 01 (запис старшого байта) або 10 (запис додаткового 
байта) 
2. Подать на вивід WR����� негативний імпульс; при цьому на  
виводі RDY/BSY����� з'являється сигнал рівня «0» 
3. Очікувати появи на виводі RDY/BSY ������ сигналу рівня «1» 

6 Запис сторінки 

1. Установити виводи ВS2: ВS1 у стан 00 
2. Подать на вивід WR ����� негативний імпульс; при цьому на  
виводі  RDY/BSY����� з'являється сигнал рівня «0» 
3. Очікувати появи на виводі RDY/BSY����� сигналу рівня «1» 

 
У цьому режимі використовується 9 команд, коди яких наведені в 

табл. 3.18. 
 

Таблиця 3.18 –  Команди програмування в паралельному режимі 
Код команди Опис 

1000 0000 Знищення кристала 
0100 0000 Запис конфігураційних комірок 
0010 0000 Запис комірок захисту 
0001 0000 Запис FLASH-пам'яті 
0001 0001 Запис ЕЕРRОМ-пам'яті 
0000 1000 Читання ідентифікатора 
0000 0100 Читання конфігураційних комірок і комірок захисту 
0000 0010 Читання FLASH-пам'яті 
0000 0011 Читання ЕЕРRОМ-пам'яті 

 
3.3.1 Перемикання в режим паралельного програмування 
Першою операцією при програмуванні мікроконтролера є його пере-

ведення в режим програмування. Для переведення мікроконтролера в ре-
жим програмування необхідно виконати таки дії: 

1. Подати на мікроконтролер напругу живлення. 
2. Подати на вивід RESET��������� напругу рівня «0» і сформувати не менше 

трьох імпульсів на виводі XTAL1. 
3. Подати на виводи PAGEL, ХА1, ХА0, BS1 напругу рівня «0» на час 

не менше 100 нс. 
4. Подати напругу 11,5...12,5 В на вивід RESET��������� і утримувати напругу 

рівня «0» на виводах PAGEL, ХА1, ХА0, BS1 протягом, як мінімум, 
10 мкс. Будь-яка активність на зазначених виводах протягом цього часу 
призведе до того, що мікроконтролер не перейде в режим програмування. 

5. Зачекати не менше 300 мкс перед посиланням наступної команди. 

85 



Окремо варто сказати про мікроконтролери ATmega8515x/8535x, 
ATmega8x і ATmega48x/88x/168x, так як в цих моделях вивід скидання 
може бути задіяний під лінію введення/виведення (якщо конфігураційна 
комірка RSTDISBL запрограмована). У цьому випадку перед виконанням 
дій, описаних вище, необхідно: 

1. Подати на виводи PAGEL, ХА1, ХА0, BS1 напругу рівня «0». 
2. Подати на мікроконтролер напругу живлення (VСС), а на вивід 

RESET��������� ‒ напругу 11,5...12,5 В (Vрр ). 
3. Зачекати не менше 100 нс. 
4. Перепрограмувати комірку RSTDISBL (якщо встановлений захист, 

то спочатку необхідно виконати знищення кристала). 
5. Вийти з режиму програмування (вимкнути живлення або подати на 

вивід RESET��������� напругу рівня «1»). 
6. Перевести мікроконтролер у режим програмування, як було описа-

но раніше. 
 

3.3.2 Знищення кристала 
Команда «Знищення кристала» має виконуватися перед кожним переп-

рограмуванням мікроконтролера. Така команда повністю знищує вміст 
FLASH- і EEPROM-пам'яті, а потім скидає комірки захисту (записує в них 
логічну 1). Однак на стан конфігураційних комірок дана команда не впли-
ває. До того ж, у низці моделей мікроконтролерів набору Mega можна запо-
бігти цьому EEPROM-пам'яті шляхом програмування конфігураційної комі-
рки EESAVE. 

Для виконання команди «Знищення кристала» необхідно виконати  
такі дії: 

1. Завантажити команду «Знищення кристала» (код 1000 0000). 
2. Подати на вивід WR����� негативний імпульс; при цьому на вивід 

RDY/BSY����� з'являється сигнал рівня «0». 
3. Чекати появи на виводі RDY/BSY����� сигналу рівня «1». 
 

3.3.3 Програмування FLASH-пам'яті 
Запис FLASH-пам'яті проводиться в такій послідовності (реалізація 

кожного етапу наведена в табл. 3.17): 
1. Завантажити команду «Запис FLASH-пам'яті» (код 0001 0000). 
2. Завантажити молодший байт адреси (положення комірки всередині 

сторінки). 
3. Завантажити молодший байт даних. 
4. Завантажити старший байт даних. 
5. Запам'ятати дані в буфері. 
6. Повторити п. 2...5 до повного заповнення буфера сторінки. 
7. Завантажити старший байт адреси (номер сторінки). 
8. Завантажити додатковий байт адреси (у моделях 

ATmega2560x/2561x). 
9. Зберегти сторінку. 
10. Повторити п. 2...9 для запису інших сторінок пам'яті програм. 
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11. Завершити програмування, завантаживши команду «Немає опера-
ції» (код 0000 0000).  

Для читання FLASH-пам'яті необхідно виконати такі дії (реалізація 
кожного етапу наведена в табл. 3.17): 

1. Завантажити команду «Читання FLASH-пам'яті» (код 0000 0010). 
2. Завантажити додатковий байт адреси (у моделях ATmega 

2560/2561х). 
3. Завантажити старший байт адреси. 
4. Завантажити молодший байт адреси. 
5. Установити OE���� і BS1 в 0, після цього з шини даних DATA можна 

буде зчитати значення молодшого байта вмісту комірки пам'яті. 
6. Установити BS1 в 1, після цього з шини даних DATA можна буде 

зчитати значення старшого байта вмісту комірки пам'яті. 
7. Установити OE����  в 1. 
 
3.3.4 Програмування EEPROM-пам'яті 
Запис EEPROM-пам'яті проводиться у такій послідовності (реалізація 

кожного етапу наведена в табл. 3.17): 
1. Завантажити команду «Запис EEPROM-пам'яті» (код 0001 0001). 
2. Завантажити старший байт адреси. 
3. Завантажити молодший байт адреси. 
4. Завантажити байт даних. 
5. Запам'ятати дані в буфері. 
6. Повторити п. 3...5 до повного заповнення буфера. 
7. Зберегти сторінку. 
Для читання вмісту EEPROM-пам'яті необхідно виконати такі дії  

(реалізація кожного етапу наведена в табл. 3.17): 
1. Завантажити команду «Читання EEPROM-пам'яті» (код 0000 0011). 
2. Завантажити старший байт адреси. 
3. Завантажити молодший байт адреси. 
4. Встановити ОЕ���� і BS1 в 0, після цього з шини даних DATA можна 

буде зчитати вміст комірки пам'яті. 
5. Установити ОЕ���� в 1. 
 
3.3.5 Програмування конфігураційних комірок 
Програмування байтів конфігурації мікроконтролерів набору Mega 

здійснюється так. 
Молодший конфігураційний байт: 
1. Завантажити команду «Запис конфігураційних комірок» (код 0100 0000). 
2. Завантажити молодший байт даних. Якщо біт скинутий в 0, викону-

ється програмування відповідної комірки, якщо встановлений в 1 ‒ її ски-
дання. 

3. Записати молодший байт конфігурації. 
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Старший конфігураційний байт: 
1. Завантажити команду «Запис конфігураційних комірок» (код 0100 0000). 
2. Завантажити молодший байт даних. Якщо біт скинутий в 0, викону-

ється програмування відповідної комірки, якщо встановлений в 1 ‒ її ски-
дання. 

3. Записати старший байт конфігурації. 
Додатковий конфігураційний байт записується аналогічно. 
 
3.3.6 Програмування, читання комірок захисту та конфігурації 
Програмування комірок захисту виконується аналогічно програму-

ванню конфігураційних комірок (реалізація кожного етапу наведена в 
табл. 3.17): 

1. Завантажити команду «Запис комірок захисту» (код 0010 0000). 
2. Завантажити молодший байт даних. Для програмування комірки  

відповідний біт має бути скинутий в 0. Невикористані біти мають бути 
завжди встановлені в 1. 

3. Записати молодший байт конфігурації. 
Читання комірок конфігурації та захисту  виконується у такій послі-

довності (реалізація кожного етапу наведена в табл. 3.17): 
1. Завантажити команду «Читання конфігураційних комірок та комі-

рок захисту» (код 0000 0100). 
2. Установити ОЕ����, BS1 і BS2 в «0», після цього з шини даних DATA 

можна буде зчитати значення молодшого конфігураційного байта. 
3. Установити ОЕ���� в 0, a BS1 і BS2 ‒ у «1». Після цього з шини даних 

DATA можна буде зчитати значення старшого конфігураційного байта. 
4. Установити ОЕ����  в 0, BS1 ‒ у «0», a BS2 ‒ у «1». Після цього з шини 

даних DATA можна буде зчитати значення додаткового байта конфігурації. 
5. Установити ОЕ���� в 0, BS1 ‒ у «1», a BS2 ‒ у «0». Після цього з шини 

даних DATA можна буде зчитати значення байту захисту. 
6. Встановити ОЕ����  в «1». 

 
3.3.7 Читання комірок ідентифікатора і комірок калібрування 
Читання комірок ідентифікатора здійснюється у такій послідовності: 
1. Завантажити команду «Читання комірок ідентифікатора» (код 0000 1000). 
2. Завантажити молодший байт адреси ($00...$02). 
3. Установити ОЕ���� і BS1 в «0», після цього з шини даних DATA можна 

буде зчитати вміст вибраної комірки ідентифікатора. 
4. Установити ОЕ���� в «1». 
5. Читання калібрувальних констант здійснюється аналогічно і за до-

помогою тієї ж команди: 
6. Завантажити команду «Читання комірок ідентифікатора» (код 0000 1000). 
7. Завантажити молодший байт адреси ($00 ... $03). 
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8. Установити ОЕ���� в «0», a BS1 ‒ в «1», після цього з шини даних 
DATA можна буде зчитати значення обраної константи калібрування. 

9. Установити ОЕ���� в «1». 
 

3.4. Програмування по інтерфейсу JTAG 
 

3.4.1 Використання інтерфейсу JTAG для програмування кристала 
Інтерфейс JTAG був розроблений групою провідних фахівців з про-

блем тестування електронних компонентів (Joint Test Action Group).  
Вбудований у більшість мікроконтролерів набору Mega, інтерфейс JTAG 
може бути використаний для: 

−  тестування друкованих плат; 
−  конфігурації (програмування) кристала; 
−  внутрішньосхемного налагодження. 
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Рисунок 3.4 – Розводка роз'єму JTAG 
 

Доступ до модуля JTAG здійснюється через чотири виводи мікрокон-
тролера, що складають так званий «порт тестового доступу» (Test Access 
Port – ТАР): TMS, ТСК, TDI і TDO. Відповідність цих виводів контактам 
портів введення/виведення мікроконтролера, а також їхні функції наведені 
в табл. 3.19. Стандартний роз'єм для підключення пристроїв наведений на 
рис. 3.4.  

Роботою модуля JTAG керує ТАР-контролер, який є скінченним ав-
томатом зі 16 станами. Перехід між станами здійснюється за наростаючим 
фронтом сигналу ТСК відповідно до сигналу, що присутній на виводі 
TMS. Після ввімкнення живлення контролер знаходиться в стані Test-
Logic-Reset. 

Дозвіл/заборона інтерфейсу JTAG здійснюється за допомогою конфі-
гураційної комірки JTAGEN. Якщо вона не запрограмована (1), то виводи 
ТАР працюють як звичайні контакти портів введення/виведення, а ТАР-
контролер знаходиться в стані скидання. Для ввімкнення інтерфейсу  
комірка JTAGEN має бути запрограмована (стан за замовчуванням). До 
того ж, має бути скинутий біт JTD регістра MCUCSR або MCUCR 
(рис. 3.5). Причому, для зміни стану цього біта нове значення необхідно 
записати в нього двічі протягом чотирьох тактів. 
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Таблиця 3.19 – Виводи, які використовуються інтерфейсом JTAG 

Назва 
лінії 

інтерфейсу 
A
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a1
6x

/3
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eg
a1

62
x 

A
Tm

eg
a1

64
x/

32
4x

/6
44

x 

A
Tm

eg
a1

65
x 

A
Tm

eg
a 

32
5x

/3
25

0x
 

A
Tm

eg
a6

40
x/

12
80

x/
25

60
x 

Призначення 
виводів 

TCK РC2 РF4 РC4 РC2 РF4 РF4 РF4 Вхід тактового сигналу 
TMS РC3 РF5 РC5 РC3 РF5 РF5 РF5 Вхід вибору режиму 
TDO РC4 РF6 РC6 РC4 РF6 РF6 РF6 Вихід даних 
TDI РC5 РF7 РC7 РC5 РF7 РF7 РF7 Вхід даних 

 

JTRF

JTD
7 6 5 4 3 2 1 0

7 6 5 4 3 2 1 0

0 0 0 0 0 0 0 0

0 0 0 0 X X X X

ATmega 16x/32x
ATmega 64x/128x
ATmega 162x

Початковий стан

MCUCR PUD IVSEL IVCE

JTD X X WDRF BORF EXTRF PORF

ATmega 164x/324x/644x
ATmega 165x
ATmega 325x/3250x/645x/6450x
ATmega 640x/1280x/1281x
ATmega 2560x/2561x

MCUCSR

 

Рисунок 3.5 – Регістри MCUCSR/MCUCR  
щодо інтерфейсу JTAG 

 
3.4.2 Команди JTAG для програмування 
З 16 команд, підтримуваних інтерфейсом, при програмуванні викори-

стовуються тільки п'ять. Описи цих команд наведені нижче. 
AVR_RESET (код команди $ 0С). Ця команда призначена для переве-

дення мікроконтролера в стан скидання і відповідно виведення його з цьо-
го стану. Як регістру даних обирається 1-бітний регістр скидання (Reset 
Register). Запис «1» у цей регістр еквівалентна подачі на вивід RESET мік-
роконтролера напруги рівня «0». У стані скидання мікроконтролер буде 
перебувати до тих пір, поки в регістр скидання не буде записаний «0». 

Активний стан: Shift-DR – здійснюється завантаження регістра ски-
дання. 

PROG_ENABLE (код команди $ 04). Ця команда призначена для  
дозволу програмування кристала через порт JTAG. Як регістр даних обира-
ється 16-бітовий регістр дозволу програмування (Programming Enable 
Register). При запису в цей регістр числа $А370 (сигнатура дозволу про-
грамування) дозволяється програмування мікроконтролера по інтерфейсу 
JTAG. При виході з режиму програмування цей регістр має скидатися. 

Активні стани: 
−  Shift-DR – здійснюється завантаження регістра дозволу переривання; 
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−  Update-DR – здійснюється порівняння вмісту регістра з числом $A370 
і в разі збігу ‒ переведення мікроконтролера в режим програмування. 

PROG_COMMANDS (код команди $ 05). Ця команда призначена для 
завантаження команд програмування і видачі результатів їхнього виконан-
ня (якщо вони є). Як регістр даних обирається 15-бітний регістр команд 
(Programming Command Register). 

Активні стани: 
−  Capture-DR – результат виконання попередньої команди завантажу-

ється в регістр; 
−  Shift-DR – за наростаючим фронтом сигналу ТСК здійснюється ви-

дача результату з одночасним завантаженням нової команди; 
−  Update-DR – завантажена команда подається на блок пам'яті мікро-

контролера; 
−  Run-Test/Idle – генерується один тактовий імпульс, необхідний для 

виконання команди. 
PROG_PAGELOAD (код команди $06). Ця команда призначена для 

безпосереднього завантаження сторінки пам'яті програм через порт JTAG. 
Реалізація цієї команди залежить від моделі мікроконтролера. У «старих» 
моделях (ATmegal6x/32x/64x/128x і ATmegal62x) як регістр даних обира-
ється регістр завантаження віртуальної сторінки (Virtual FLASH Page Load 
Register), розмір якого дорівнює розміру однієї сторінки пам'яті програм. 
Власне зсувний регістр є 8-бітовийм, а пересилання по байтах даних в бу-
фер здійснюється автоматично. 

Активний стан: Shift-DR – здійснюється побітова завантаження да-
них і побайтне їхнє пересилання в буфер сторінки FLASH-пам'яті. 

В інших моделях як регістр даних обирається 8-бітовий регістр да-
них FLASH-пам'яті. Активні стани: 

−  Shift-DR ‒ здійснюється побітне завантаження байта даних; 
−  Update-DR – вміст регістра даних FLASH-пам'яті копіюється у тим-

часовий регістр в буфері сторінки. Чергування старшого і молодшого бай-
тів при кожному проходженні стану Update-DR здійснюється автоматично, 
починаючи з молодшого байта при завантаженні команди. 

PROG_PAGEREAD (код команди $07). Ця команда призначена для 
зчитування вмісту сторінки пам'яті програм через порт JTAG. Реалізація 
цієї команди також залежить від моделі мікроконтролера. У «старих»  
моделях (ATmcgal6x/32x/64x/128x і ATmegal62x) як регістр даних обира-
ється регістр читання віртуальної сторінки (Virtual FLASH Page Read 
Register), розмір якого на 1 байт більше розміру сторінки пам'яті програм. 
Побайтне пересилання вмісту сторінки у зсувний регістр здійснюється  
автоматично. 

Активні стани: Shift-DR – здійснюється побайтне пересилання вмісту 
сторінки FLASH-пам'яті у зсувний регістр і побітова його видача на вивід 
TDO. Перші 8 тактів використовуються для первинного завантаження  
зсувного регістру, оскільки біти, що вивантажуються в цей час, необхідно 
ігнорувати. 
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В інших моделях як регістр даних обирається 8-бітний регістр даних 
FLASH-пам'яті. Активні стани: 

−  Capture-DR – вміст обраного байта замикається в регістрі даних 
FLASH-пам'яті. Чергування старшого і молодшого байтів при кожному 
проходженні стану Capture-DR здійснюється автоматично, починаючи з 
молодшого байта при завантаженні команди. 

−  Shift-DR – здійснюється побітове завантаження байта даних. 
 
3.4.3 Алгоритм програмування 
У розділі описуються дії, які необхідно виконувати для програмуван-

ня мікроконтролерів через порт JTAG. Формат усіх команд, які використо-
вуються при програмуванні, наведено в табл. 3.20. 

 
Таблиця 3.20 – Команди програмування по інтерфейсу JTAG 

Команда TDI TDO Примітка 

1 
а. Знищення кристала 

0100011_10000000 
0110001_10000000 
0110011_10000000 
0110011_10000000 

ххххххх_хххххххх 
ххххххх_хххххххх 
ххххххх_хххххххх 
ххххххх_хххххххх 

‒ 

b. Запит 
стану операції 0110011_10000000 ххххх0х_хххххххх 2 

2 

а. Вхід у режим запису 
FLASH-пам'яті 0100011_00010000 ххххххх_хххххххх ‒ 

b. Завантаження додатко-
вого байта адреси 0001011_сссссссс ххххххх_хххххххх ‒ 

с. Завантаження старшого 
байта адреси 0000111_аааааааа ххххххх_хххххххх ‒ 

d. Завантаження молодшо-
го байта адреси 0000011_bbbbbbbb ххххххх_хххххххх ‒ 

е. Завантаження молодшо-
го байта даних 0010011_iiiiiiii ххххххх_хххххххх ‒ 

f. Завантаження старшого 
байта даних 0010111_iiiiiiii ххххххх_хххххххх ‒ 

g. Фіксація даних 
0110111_00000000 
1110111_00000000 
0110111_00000000 

ххххххх_хххххххх 
ххххххх_хххххххх 
ххххххх_хххххххх 

‒ 

h. Запис сторінки FLASH-
пам'яті 

0110111_00000000 
0110101_00000000 
0110111_00000000 
0110111_00000000 

ххххххх_хххххххх 
ххххххх_хххххххх 
ххххххх_хххххххх 
ххххххх_хххххххх 

- 
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Продовження таблиці 3.20 
Команда TDI TDO Примітка 

 і. Запит стану операції 0110111_00000000 ххххххх_хххххххх 2 

3 

a. Вхід в режим читан- 
ня FLASH-пам'яті 0100011_00000010 ххххххх_хххххххх ‒ 

b. Завантаження додат-
кового байта адреси 0001011_сссссссс ххххххх_хххххххх ‒ 

с. Завантаження стар-
шого байта адреси 0000111_аааааааа ххххххх_хххххххх ‒ 

d. Завантаження моло-
дшого байта адреси 0000011_bbbbbbbb ххххххх_хххххххх ‒ 

с. Читання молодшого і 
старшого байтів даних 

0110010_00000000 
0110110_00000000 
0110111_00000000 

ххххххх_хххххххх 
ххххххх_00000000 
ххххххх_00000000 

9 
8 

4 

а. Вхід в режим запису 
ЕЕРRОМ-пам'яті 0100011_00010001 xxxxxxx_xxxxxxxx ‒ 

b. Завантаження стар-
шого байта адреси 0000111_аааааааа xxxxxxx_xxxxxxxx ‒ 

с. Завантаження молод-
шого байта адреси 0000011_bbbbbbbb xxxxxxx_xxxxxxxx ‒ 

d. Завантаження байта 
даних 0010011_iiiiiiii xxxxxxx_xxxxxxxx ‒ 

e. Фіксація даних 
0110111_00000000 
1110111_00000000 
0110111_00000000 

ххххххх хххххххх 
ххххххх хххххххх 
ххххххх хххххххх 

‒ 

f. Запис сторінки  
ЕЕРКОМ-пам'яті 

0110011_00000000 
0110001_00000000 
0110011_00000000 
0110011_00000000 

ххххххх_хххххххх 
ххххххх_хххххххх 
ххххххх_хххххххх 
ххххххх_хххххххх 

‒ 

g. Запит стану операції 0110011_00000000 xxxxx0x_xxxxxxxx 2 

5 

а. Входу режим  
читання ЕЕРROМ-
пам'яті 

0110011_00000011 xxxxxxx_xxxxxxxx ‒ 

b. Завантаження старшо-
го байтуадреси 0000111_aaaaaaaa ххххххх_хххххххх ‒ 

с. Завантаження  
молодшого байта  
адреси 

0000011_bbbbbbbb ххххххх_хххххххх ‒ 

d. Читання байта 
даних 

0110011_bbbbbbbb 
0110010_00000000 
0110011_00000000 

ххххххх_хххххххх 
ххххххх_хххххххх 
ххххххх_оооооооо 

‒ 
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Продовження таблиці 3.20 
Команда TDI TDO Примітка 

6 

а. Вхід у режим запису 
конфігураційних  
комірок 

0100011_01000000 ххххххх хххххххх ‒ 

b. Завантаження байта 
даних 0010011_iiiiiiii ххххххх_хххххххх 3,5 

с. Запис додаткового 
конфігураційного байта 

0111011_00000000 
0111001_00000000 
0111011_00000000 
0111011_00000000 

ххххххх_хххххххх 
ххххххх_хххххххх 
ххххххх_хххххххх 
ххххххх_хххххххх 

‒ 

d. Запит стану операції 0110111_00000000 ххxххох_хххххххх 2 
е. Завантаження байта 
даних 0010011_ііііiііi ххххххх_хххххххх 3,5 

f. Запис старшою 
конфігураційного 
байта 

0110111_00000000 
0110101_00000000 
0110111_00000000 
0110111_00000000 

ххххххх_хххххххх 
ххххххх_хххххххх 
ххххххх_хххххххх 
ххххххх_хххххххх 

‒ 

g. Запит стану операції 0110111_00000000 ххххххх_хххххххх 2 
h. Завантаження байта 
даних 0010011_iiiiiiii ххххххх_хххххххх 3, 5 

і. Запис молодшого 
конфігураційного 
байта 

0110011_00000000 
0110001_00000000 
0110011_00000000 
0110011_00000000 

ххххххх_хххххххх 
ххххххх_хххххххх 
ххххххх_хххххххх 
ххххххх_хххххххх 

‒ 

6 j. Запит стану операції 0110011_00000000 ххххххх_хххххххх 2 

7 

а. Вхід у режим запису 
комірок захисту 0100011_00100000 ххххххх_хххххххх ‒ 

b. Завантаження байта 
даних 001001_11iiiiii ххххххх_хххххххх 3,6 

с. Запис байта зашитий 

0110011_00000000 
0110001_00000000 
0110011_00000000 
0110011_00000000 

ххххххх_хххххххх 
ххххххх_хххххххх 
ххххххх_хххххххх 
ххххххх_хххххххх 

‒ 

d. Запит стану операції 0110011_00000000 ххххххх_хххххххх 2 

8 

а. Вхід у режим читання 
конфігураційних комі-
рок і комірок захисту 

0100011_00000100 ххххххх_хххххххх ‒ 

b. Читання додаткового 
конфігураційного байта 

0111010_00000000 
0111011_00000000 

ххххххх_хххххххх 
ххххххх_oooooooo 5 

с. Читання старшого 
конфігураційного байта 

0111110_00000000 
0111111_00000000 

ххххххх_хххххххх 
ххххххх_оооооооо 5 
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Продовження таблиці 3.20 
Команда TDI TDO Примітка 

 

d. Читання мол. 
конфігураційного 
байта 

0110010_00000000 
0110011_00000000 

ххххххх хххххххх 
ххххххx_оооооооо 5 

е. Читання байта захисту 0110110_00000000 
0110111_00000000 

ххххххх хххххххх 
ххххххх ххоооооо 4, 6 

 f. Читання конфігураційних 
комірок і комірок захисту 

0111010 00000000 
0111110 00000000 
0110010 00000000 
0110110 00000000 
0110111_00000000 

ххххххх_хххххххх 
хххххххоооооооо 
ххххххх оооооооо 
ххххххх оооооооо 
ххххххх ххоооооо 

4 
4, 7 
4, 8 
4, 9 
4, 10 

9 

а. Вхід у режим читання  
комірок ідентифікатора 0100011 00001000 ххххххх_хххххххх ‒ 

b. Завантаження байта адреси 000001_bbbbbbbb ххххххх_хххххххх ‒ 
с. Читання байта  
ідентифікатора 

0110010_00000000 
0110011_00000000 

ххххххх_хххххххх 
ххххххх_оооооооо ‒ 

10 

а. Вхід до режиму читання 
комірки калібрування 0100011_00001000 ххххххх_хххххххх ‒ 

b. Завантаження байта адреси 000001_bbbbbbbb  ххххххх_хххххххх ‒ 
с. Читання 
константи калібрування 

0110110_00000000 
0110111_00000000 

ххххххх_хххххххх 
хххххххоооооооо ‒ 

11 а. Завантаження команди 
«Немає операції» 

0100011_00000000 
0110011_00000000 

ххххххх_хххххххх 
ххххххх_хххххххх  ‒ 

 
Примітки: 
1. Умовні позначення, що використовуються в таблиці: 
а ‒ біти старшого байта адреси; 
b ‒ біти молодшого байта адреси; 
i – дані, що посилаються до мікроконтролера; 
о – дані, що зчитуються з мікроконтролера; 
х – довільний стан біта. 
2. Повторювати до тих пір, поки о = 1. 
3. Для програмування комірки відповідний їй біт має бути скинутий, для знищен-
ня ‒ встановлений. 
4. 0 – комірка запрограмована, 1 – незапрограмована. 
5. Відповідність біт коміркам конфігурації (табл. 3.5). 
6. Відповідність біт коміркам захисту (рис. 3.5). 
7. Додатковий байт. 
8. Старший байт. 
9. Молодший байт. 
10. Байт захисту. 
 
Операції програмування (номера команд відповідно до табл. 3.20). 

Операція «Вхід до режиму програмування»: 
1. Завантажити команду AVR_RESET і занести «1» у регістр скидання. 
2. Завантажити команду PROG_ENABLE і занести в регістр дозволу 

програмування значення 1010_0011_0111_ 0000 ($ А370). 
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Операція «Вихід з режиму програмування»: 
1. Завантажити команду PROG_COMMANDS. 
2. Заборонити виконання всіх команд програмування, запустивши  

команду «Немає операції». 
3. Завантажити команду PROG_ENABLE і занести в регістр дозволу 

програмування значення 0000_0000_0000_0000. 
4. Завантажити команду AVR_RESET і занести «0» у регістр скидання. 
 
Операція «Знищення кристала»: 
1. Завантажити команду PROG_COMMANDS. 
2. Почати знищення кристала, запустивши команду 1а. 
3. Дочекатися закінчення виконання цієї операції, контролюючи зна-

чення, що повертається командою 1b. Як альтернативу можна просто заче-
кати (див. табл. 3.16). 

 
Операція «Програмування FLASH-пам'яті»: 
1. Завантажити команду PROG_COMMANDS. 
2. Увійти в режим програмування FLASH-пам'яті (команда 2а). 
3. Завантажити додатковий байт адреси (команда 2b). 
4. Завантажити старший байт адреси (команда 2с). 
5. Завантажити молодший байт адреси (команда 2d). 
6. Завантажити дані (команди 2е, 2f і 2g). 
7. Повторити п. 5 та 6 для кожної комірки сторінки пам'яті програм. 
8. Зберегти сторінку (команда 2h). 
9. Дочекатися закінчення виконання цієї операції, контролюючи зна-

чення, що повертається командою 2h.  
10. Повторити п. 3...9 для програмування інших сторінок пам’яті про-

грам. 
 
Операція «Читання FLASH-пам'яті»: 
1. Завантажити команду PROG_COMMANDS. 
2. Перейти в режим читання FLASH-пам'яті (команда 3а). 
3. Завантажити адресу комірки пам'яті (команди 3b, 3с та 3d). 
4. Прочитати вміст комірки (команда 3с). 
5. Повторити п. 3 та 4 для читання інших комірок пам'яті програм. 
 
Операція «Програмування EEPROM-пам'яті»: 
1. Завантажити команду PROG_COMMANDS. 
2. Увійти в режим програмування EEPROM-пам'яті (команда 4а). 
3. Завантажити старший байт адреси (команда 4b). 
4. Завантажити молодший байт адреси (команда 4с). 
5. Завантажити дані (команди 4d і 4е). 
6. Повторити п. 4 і 5 для всіх комірок сторінки. 
7. Зберегти сторінку (команда 4f). 
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8. Дочекатися закінчення виконання цієї операції, контролюючи зна-
чення, що повертається командою 4g.  

9. Повторити п. 3...8 для програмування інших сторінок EEPROM-
пам'яті. 

 
Операція «Читання EEPROM-пам'яті»: 
1. Завантажити команду PROG_COMMANDS. 
2. Увійти в режим читання EEPROM-пам'яті (команда 5а). 
3. Завантажити адресу комірки пам'яті (команди 5b та 5с). 
4. Зчитати вміст комірки (команда 5d). 
5. Повторити п. 3 та 4 для читання інших комірок EEPROM-пам'яті. 
 
Операція «Програмування комірок конфігурації»: 
1. Завантажити команду PROG_COMMANDS. 
2. Увійти в режим програмування конфігураційних комірок (команда 

6-а). 
3. Завантажити байт даних (команда 6b). 
4. Записати додатковий байт конфігурації (команда 6с). 
5. Дочекатися закінчення виконання цієї операції, контролюючи зна-

чення, що повертається командою 6d.  
6. Завантажити байт даних (команда 6е). 
7. Записати старший байт конфігурації (команда 6f) 
8. Дочекатися закінчення виконання цієї операції, контролюючи зна-

чення, що повертається командою 6g. 
9. Завантажити байт даних (команда 6h). 
10. Записати молодший байт конфігурації (команда 6i). 
11. Дочекатися закінчення виконання цієї операції, контролюючи зна-

чення, що повертається командою 6j.   
 
Операція «Програмування комірок захисту»: 
1. Завантажити команду PROG_COMMANDS. 
2. Увійти в режим програмування комірок захисту (команда 7а). 
3. Завантажити байт даних (команда 7b). 
4. Записати байт захисту (команда 7с). 
5. Дочекатися закінчення виконання цієї операції, контролюючи зна-

чення, що повертається командою 7d.   
 
Операція «Читання конфігураційних комірок та комірок захисту»: 
1. Завантажити команду PROG_COMMANDS. 
2. Увійти в режим читання конфігураційних комірок та комірок захис-

ту (команда 8а). 
3. Для читання всіх комірок виконати команду 8f. 
4. Для читання тільки додаткового байта конфігурації виконати  

команду 8b. 
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5. Для читання тільки старшого байта конфігурації виконати команду 
8с. 

6. Для читання тільки молодшого байта конфігурації виконати коман-
ду 8d. 

7. Для читання тільки байту захисту виконати команду 8е. 
 
Операція «Читання комірок ідентифікатора»: 
1. Завантажити команду PROG_COMMANDS. 
2. Увійти в режим читання комірок ідентифікатора (команда 9а). 
3. Завантажити адресу $00, використовуючи команду 9b. 
4. Прочитати перший байт ідентифікатора (команда 9с). 
5. Повторити п. 3 та 4 для читання другого (адреса $01) та третього 

(адреса $02) байта ідентифікатора. 
 
Операція «Читання комірок калібрування»: 
1. Завантажити команду PROG_COMMANDS. 
2. Увійти в режим читання комірок калібрування (команда 10а). 
3. Завантажити адресу комірки (команда 10b). 
4. Зчитати значення константи калібрування (команда 10с). 
 

3.5 Самопрограмування мікроконтролерів набору Меgа 
 
Усі МК набору Меgа мають можливість самопрограмування, тобто 

самостійно змінювати вміст своєї пам'яті програм.  
У всіх мікроконтролерах набору, за винятком моделі ATmega48x, уся 

область пам'яті програм логічно розділена на дві секції – секцію приклад-
ної програми (Application Section) і секцію завантажувача (Boot Loader 
Section). Зміна параметрів пам'яті програм здійснюється програмою-
завантажувачем, що розташована в одноіменній секції  завантаження ново-
го вмісту пам'яті програм. Для вивантаження пам’яті програма-
завантажувач може використовувати будь-який інтерфейс передачі даних 
(USART, SPI, TWI), що наявний у складі конкретного мікроконтролера. 
Завантажувач може змінювати вміст обох секцій. Це дозволяє йому моди-
фікувати власний код і навіть видаляти себе з пам'яті, якщо в ньому не бу-
де потреби. Рівень доступу (читання/запис) до кожної з секцій задається 
користувачем за допомогою комірок захисту BLB02: BLB01 та BLB12: 
BLB11 (див. табл. 3.3, табл. 3.4). У моделі ж ATmega48x зміна вмісту па-
м'яті програм може бути здійснена з будь-якого її місця, тобто секцією за-
вантажувача, по суті справи, є вся пам'ять програм. Перехід до програми-
завантажувача може здійснюватися різними способами. Зокрема, вона мо-
же бути викликана з основної програми командами CALL/JMP. Іншим спо-
собом є переміщення вектора скидання в початок секції завантажувача. У 
цьому випадку запуск програми-завантажувача буде здійснюватися авто-
матично після кожного скидання мікроконтролера. Положення вектора 
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скидання визначається станом комірки конфігурації BOOTRST. Якщо в ній 
міститься 1, вектор скидання розташовується на початку пам'яті програм, 
за адресою $0000. Якщо комірка запрограмована (0), то вектор скидання 
розташовується на початку секції завантажувача (див. табл. 3.21). Розмір 
секції завантажувача і відповідно розмір секції прикладної програми прак-
тично у всіх мікроконтролерах задається за допомогою двох конфігурацій-
них комірок ‒ BOOTSZ1: BOOTSZ0. Виняток становлять лише моделі 
ATmega48x, у яких поділ на секції відсутній. Можливі конфігурації пам'яті 
програм всіх мікроконтролерів набору Mega наведені в табл. 3.21. 

 
Таблиця 3.21 – Конфігурація пам'яті програм 

Модель 

B
O

O
TS

Z1
 

B
O

O
TS

Z0
 

Розмір  
заванта-
жувача 
[слів] 

К-сть 
сторінок 

Секція  
прикладної 
програми 

Секція  
завантажувача 

ATmega8515x/8535x, 
ATmega8x, 
ATmega88x 

1 1 128 4 $000...$F7F $F80...$FFF 
1 0 256 8 $000...$EFF $F00...$FFF 
0 1 512 16 $000...$DFF $E00...$FFF 
0 0 1024 32 $000...$BFF $C00...$FFF 

ATmegal6x, 
ATmegal62x, 
ATmegal64x, 
ATmegal65x, 
ATmegal68x 

1 1 128 2 $0000...$1F7F $1F80...$1FFF 
1 0 256 4 $0000...$1EFF $1F00...$1FFF 
0 1 512 8 $0000...$1 DFF $ 1 E00...$ 1FFF 

0 0 1024 16 $000...$1BFF $1C00...$1FFF 

ATmega32x, 
ATmega324x, 
ATmega325x/3250x 

1 1 256 4 $0000...$3EFF $3F00...$3FFF 
1 0 512 8 $0000...$3DFF $3E00...$3FFF 
0 1 1024 16 $0000...$3BFF $3C00...$3FFF 
0 0 2048 32 $0000...$37FF $3800...$3FFF 

ATmega64x, 
ATmega640x, 
ATmega645x/6450x 

1 1 512 4 $0000...$7DFF $7E00...$7FFF 
1 0 1024 8 $0000...$7BFF $7C00...$7FFF 
0 1 2048 16 $0000...$77FF $7800...$7FFF 
0 0 4096 32 $0000...$6FFF $7000...$7FFF 

ATmegal28x, 
ATmegal280x/1281x 

1 1 512 4 $0000...$FDFF $FE00...$FFFF 
1 0 1024 8 $0000...$FBFF $FC00...$FFFF 
0 1 2048 16 $0000...$F7FF $F800...$FFFF 
0 0 4096 32 $0000...$EFFF $F000...$FFFF 

ATmega2560x/2561x 

1 1 512 4 $0000...$1FDFF $1FE00...$FFFF 
1 0 1024 8 $0000...$! FBFF $1FC00...$FFFF 
0 1 2048 16 $0000...$ 1F7FF $1F800...$FFFF 
0 0 4096 32 $0000...$1EFFF $1F000...$FFFF 

 
Зміна вмісту пам'яті програм і комірок захисту завантажувача здійсню-

ється за допомогою команди SPM (Store Program Memory). Параметрами 
цієї команди є адреса області пам'яті, що завантажується попередньо в інде-
ксний регістр Z, і, за необхідності, дані, що знаходяться в регістровій парі 
R1: R0. Управління процесом програмування і, зокрема, визначення опера-
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ції, що виконується при виклику команди SPM, здійснюється за допомогою 
регістра введення/виведення SPMCR (моделі ATmega8515x/8535x, 
ATmega8x/16x/32x/64x/128x і ATmegal62x) або SPMCSR (в інших моде-
лях). У всіх мікроконтролерах, за винятком моделей ATmega64x/128x, цей 
регістр розташований за адресою $ 37 ($ 57). У моделях ATmega64x/128x 
цей регістр розташований в просторі додаткових регістрів введен-
ня/виведення за адресою ($68). Формат цих регістрів для різних моделей 
набору показаний на рис. 3.6, а опис його біт наведено в табл. 3.22. 

 

SPMIE
7 6 5 4 3 2 1 0

7 6 5 4 3 2 1 0

0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 0

Початковий стан

SPMCR

SPMCSR

RWWSB RWWSRE BLBSET PGWRT PGERS SPMEN

SPMIE RWWSB RWWSRE BLBSET PGWRT PGERS

SELFPRGEN
7 6 5 4 3 2 1 0

X 0 0 0 0 0 0 0

SPMCSR SPMIE RWWSB RWWSRE BLBSET PGWRT PGERS

SPMEN

ATmega 48x/88x168x

ATmega 8515x/8535x
ATmega 8x/16x/32x/64x
ATmega 64x/128x
ATmega 162x

ATmega 164x/324x/644x
ATmega 165x
ATmega 325x/3250x/645x/6450x
ATmega 640x/1280x/1281x
ATmega 2560x/2561x

Початковий стан

Початковий стан  
 

Рисунок 3.6 –  Формат регістра SPMCR/SPMCSR 
 

Таблиця 3.22 – Біти регістра SPMCR/SPMCSR 
Біт Назва Опис 
1 2 3 

7 SPMIE 

Дозвіл переривання «Готовність SPM». Якщо в цьому біті записана 
«1» і прапорець I регістра SREG також встановлено в «1», то до-
зволяється переривання «Готовність SPM». Переривання генеру-
ється весь час, поки біт SPMEN регістра скинутий в «0» 

6 RWWSB 

Заборонено доступ до області RWW. Цей прапорець показує мож-
ливість звернення за адресами, розташованим в області RWW. Як-
що прапорець встановлений в «1», доступ до області RWW забо-
ронений, якщо скинутий в «0» дозволено. Установлення цього 
прапорця здійснюється апаратно при виконанні операцій запису 
або знищення сторінки пам'яті. Скидання прапорця здійснюється 
або програмно, записом «1» в біт RWWSRE після закінчення опе-
рації, або апаратно, при запуску операції завантаження сторінки 

5 ‒ Зарезервовано   

4 RWWSRE 

Читання області RWW дозволено. Одночасне встановлення цього 
біта і біта SPMEN дозволяє доступ до області RWW. Дозвіл досту-
пу до цієї області здійснюється запуском команди SPM протягом  
4 тактів після встановлення зазначених бітів. Дозвіл доступу до 
області RWW може здійснюватися тільки після завершення опера-
ції програмування (після скидання прапорця SPMEN) 
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Продовження таблиці 3.23 

3 BLBSET 

Зміна комірок захисту завантажувача. При одночасній установці 
цього біта і біта SPMEN команда SPM, запущена протягом таких  
4 тактів, здійснить установку захисних комірок завантажувача  
відповідно до вмісту регістра R0. Скидання біта BLBSET здійсню-
ється апаратно після встановлення комірок захисту або після  
закінчення зазначеного часу. За командою (E)LPM, запущеної  
протягом 3 тактів після встановлення зазначених біт, буде здійсне-
но читання або конфігураційних комірок або комірок захисту  
(залежить від значення біта Z0 регістра Z) 

2 PGWRT 

Запис сторінки. При одночасній установці цього біта і біта SPMEN  
команда SPM, запущена протягом таких 4 тактів, здійснить запис 
сторінки пам'яті програм з тимчасового буфера. Адреса сторінки 
має бути завантажена в старший байт регістра Z (R31). Скидання 
біта PGWRT здійснюється апаратно після закінчення запису сторі-
нки або після закінчення зазначеного часу. При запису в секцію 
NRWW центральний процесор зупиняється на час виконання 

1 PGERS 

Знищення сторінки. При одночасній установці цього біта і біта 
SPMEN команда SPM, запущена протягом таких 4 тактів, здійснить 
знищення сторінки пам'яті програм. Адреса сторінки має бути зава-
нтажена в старший байт регістра Z (R31). Скидання біта PGERS 
здійснюється апаратно після закінчення знищення сторінки або піс-
ля закінчення зазначеного часу. При запису в секцію NRWW 
центральний процесор зупиняється на час виконання операції 

0 
SPMEN 

(SELFPRG
EN) 

Дозвіл виконання команди SPM. Установлення цього біта дозволяє 
запуск команди SPM протягом таких 4 тактів. Якщо біт SPMEN 
встановлюється одночасно з одним з бітів RWWSRE, BLBSET, 
PGWRT або PGERS, виконується операція, яка визначається цим  
бітом. Якщо встановлюється тільки біт SPMEN, здійснюється збе-
реження вмісту регістрів R1: R0 у тимчасовому буфері за адресою, 
що знаходиться в регістрі Z. Скидання біта SPMEN здійснюється 
апаратно після завершення операції або після закінчення зазначено-
го часу 

 
 
Під час запису в ЕЕРRОМ-пам'ять змінювати регістр SPMCR немож-

ливо. Тому, перед тим як записати будь-яке значення в регістр SPMCR, ре-
комендується дочекатися скидання прапорця ЕЕWЕ регістра ЕЕСR. 

Для адресації пам'яті програм при використанні команди SPM вико-
ристовується індексний регістр Z, який складається з R30 (молодший байт) 
і R31 (старший байт), а в моделях з об'ємом пам'яті програм більше 
64 Кбайт ‒ ще і регістр введення/виведення RAMPZ. Оскільки пам'ять про-
грам в мікроконтролерах набору має сторінкову організацію, лічильник 
команд можна умовно розбити на дві частини. Перша частина (молодші 
біти) адресує комірка на сторінці, а друга частина визначає сторінку. Після 
запуску операції програмування вміст регістра Z фіксується і його можна 
використовувати для інших цілей. 

101 



Зміна вмісту пам'яті програм здійснюється в такій послідовності:  
заповнення тимчасового буфера сторінки новим вмістом; видалення сто-
рінки; вміст буфера в пам'ять програм. 

Для визначення моменту закінчення виконання операцій можна або 
опитувати стан прапорця SPMEN регістра SPMCR, чекаючи його скидан-
ня, або скористатися перериванням «Готовність SPM». Це переривання ге-
нерується весь час, поки прапорець SPMEN скинутий. В останньому випа-
дку таблиця векторів переривань має знаходитися в секції завантажувача, а 
це переривання має бути дозволено установкою прапорця SРМIЕ регістра 
SPMCR. 

Для знищення сторінки пам'яті програм необхідно занести адресу сто-
рінки в регістр Z (секція РСРАGЕ), записати значення х0000011 в регістр 
SPMCR і протягом таких чотирьох тактів виконати команду SРМ. Вміст 
регістрів R1 і R0 при цьому ігнорується. 

Для занесення слова команди в буфер варто завантажити адресу комі-
рки в регістр Z (секція РСWORD), а код операції ‒ у регістри R1: R0. Після 
цього необхідно записати значення х0000011 в регістр SPMCR і протягом 
таких чотирьох тактів виконати команду SРМ. Очищення буфера здійсню-
ється автоматично, після закінчення запису сторінки, або вручну, записом 
«1» в біт RWWSRE регістра SPMCR.  

Запис вмісту буфера в пам'ять програм здійснюється аналогічно. У ре-
гістр Z (секція РСРАGЕ) заноситься адреса сторінки, у регістр SPMCR за-
писується значення х0000101, і протягом таких чотирьох тактів виконуєть-
ся команда SРМ. Вміст регістрів R1 і R0 при цьому ігнорується. 

Зміна комірок захисту завантажувача ВLВ12: ВLВ11 і ВLВ02: ВLВ01 
також здійснюється командою SPM. Для цього необхідно завантажити в 
регістр R0 необхідне значення відповідно до рис. 3.7 (скинутий біт означає 
програмування відповідної комірки). 

 

1
7 6 5 4 3 2 1 0

1 BLB11 1BLB12 1BLB01BLB02
 

 

Рисунок 3.7 –  Вміст R0 при зміні комірок захисту завантажувача 
 

Після цього необхідно записати значення х0001001 у регістр SPMCR і 
протягом таких чотирьох тактів виконати команду SРМ. Уміст регістра Z 
при цьому ігнорується, проте для сумісності з майбутніми пристроями  
рекомендується записувати в нього значення $ 0001. Під час програмуван-
ня комірок захисту можна звертатися до будь-якої області пам'яті програм. 

Крім програмування мікроконтролера, завантажувач може також зчи-
тувати вміст конфігураційних комірок і комірок захисту. Так, для читання 
байту захисту варто завантажити в регістр Z число $0001 записати в ре-
гістр SPMCR значення х0001001 і протягом трьох таких тактів виконати 
команду LРМ. У результаті вміст байту захисту буде занесено в заданий 
регістр загального призначення. Відповідність бітів регістра коміркам на-
ведено на рис. 3.1. 
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Читання конфігураційних байтів здійснюється аналогічно. У регістр Z 
завантажується адреса байта ($0000 ‒ молодший байт, $0003 ‒ старший 
байт, $0002 ‒ додатковий байт), після чого в регістр SPMCR потрібно за-
писати значення х0001001 і протягом трьох таких тактів виконати команду 
LРМ. У результаті виконання команди вміст обраного байту конфігурації 
буде занесено в регістр загального призначення.  

 

3.6 Розробка комутатора панелі ZIF  
для програмування мікроконтролерів Atmel 

 

Паралельне програмування вимагає використання додаткового джере-
ла підвищеної напруги (12В), використовує велике число виводів мікроко-
нтролера і виконується на спеціальних програматорах. Таке програмування 
зручне, коли при масовому виробництві необхідно "прошивати" велику 
кількість кристалів. Послідовне програмування не вимагає додаткового 
джерела живлення і може виконуватися безпосередньо в мікропроцесорній 
системі (Іn System Programmіng) через послідовний SPI – інтерфейс 
(рис. 3.2), що використовує всього чотири виводи AVR-мікроконтролера. 
Можливість внутрішньосистемного програмування є однією з найважли-
віших переваг AVR, тому що дозволяє значно спростити й здешевити про-
цес розробки і модернізації програмного забезпечення. Паралельний і пос-
лідовний способи програмування припускають використання зовнішнього 
пристрою програмування.  

Для внутрішньосхемного програмування мікроконтролерів AVR існує 
велика кількість різноманітних програматорів. Широко поширення набув 
програматор USBASP [12, 18, 24, 28, 30], який буде використовуватись  
разом з комутатором ZIF-панелі. Інформація між мікроконтролером та 
програматором передається порозрядно послідовним кодом, причому кож-
ний розряд супроводжується по лінії синхронізації (SCK) імпульсом, який 
генерує програматор. Для передачі даних з програматора в мікроконтролер 
фірми Atmel слугує ланка MOSI (Master-Out Slave-In), а у зворотному  
напрямку MISO (Master-In Slave-Out). Схема адаптера для програмування 
ІМС фірми Atmel зображена на рис. 3.8. При розробці комутатора був про-
ведений аналіз розташування виводів найбільш популярних мікроконтро-
лерів фірми Atmel. Його результати відображені в табл. 3.24. МК розподі-
лені на п'ять груп, кожна з яких об'єднує мікросхеми з однаковим числом 
виводів (8, 20, 28 або 40) та однаковим розташуванням тих з них, що вико-
ристовуються для програмування, у тому числі виводів живлення та  
загальної шини. У табл. 3.25 наведено, з якими контактами панелі ZIF не-
обхідно з'єднати відповідні виводи програматора за умови, що перший ви-
від мікроконтролера вставлений в перше гніздо панелі ZIF. Лінії для про-
грамування MOSI, RST, SCK, VCC, GND, що є вхідними для мікроконтро-
лерів можливо під’єднати до відповідних виводів ZIF-панелі через 
5 буферних регістрів (табл. 3.25). Буферні регістри знаходяться в z-стані. 
Один з буферних регістрів вмикається залежно від типу мікроконтролера, 
що буде програмуватись, і з’єднує його виводи MOSI, RST, SCK, VCC, 
GND з відповідними виводами ZIF-панелі. 
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Рисунок 3.8 – Схема адаптера для програмування ІМС фірми Atmel 
 

Таблиця 3.24 – Розташування виводів мікроконтролерів AVR, що  
використовуються для внутрішньосхемного програмування  

Група Мікроконтролер 
Номера виводів МК для ISP програмування 

MOSI MISO SCK RES XTAL GND UCC 
1 2 3 4 5 6 7 8 9 
1 AT90S2313 

ATtiny2313 
17 18 19 1 5 10 20  

 2 AT90S8515 
AT89S8252 
ATmega8515 

6 7 8 9 19 20 40 

3 AT90S8535 
ATmega16 
ATmega32 
ATmega8535 

6 7 8 9 13 11, 31 10,30 

4 
ATmega8 
ATmega48 
ATmega88 
ATmega168 
ATmega328 

17 18 19 1 9 8, 22 7, 20 

5 ATtiny12 
ATtiny13 
ATtiny15 

5 6 7 1 2 4 8 
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Таблиця 3.25 – Відповідність виводів для ISP програмування у  
ZIF-панелі 
Група 

Мікроконтролер 
Номера виводів ZIF-панелі 

MOSI MISO SCK RES XTAL GND UCC 
1 AT90S2313 

ATtiny2313 
37 38 39 1 5 10 40  

2 
AT90S8515 
AT89S8252 
ATmega8515 

6 7 8 9 19 20 40 

3 AT90S8535 
ATmega16 
ATmega32 
ATmega8535 

6 7 8 9 13 11, 31 10,30 

4 ATmega8 
ATmega48 
ATmega88 
ATmega168 
ATmega328 

29 30 31 1 9 8, 22 7, 32 

5 
ATtiny12 
ATtiny13 
ATtiny15 

37 38 39 1 2 4 40 

 
Обираємо мікросхему 74HC541 як буферний регістр для роботи у 

складі комутатора ZIF-панелі. Функціональна схема 74HC541 наведена на 
рис. 3.9 [1]. Мікросхема складається з восьми буферів D0-D7. Коли на обох 
входах OEA, OEB буде рівень логічного «0», мікросхема виходить з  
високоімпедансного стану, що можна використати для вибору типу мікро-
контролера, який буде програмуватись. 

 

 
 

Рисунок 3.9 – Функціональна схема мікросхеми 74HC541 
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Основні експлуатаційні параметри мікросхеми 74HC541 [11, 19, 20]: 
напруга живлення – 2‒6 В, максимальний вихідний струм – 75 мА, макси-
мальна частота – 50‒150 МГц, затримка розповсюдження сигналу – 
3,5‒5 нс, рівень логічного «0» – менше 0,1 В, рівень логічної «1» – U жив. 
Для правильного з’єднання вихідного сигналу MISO з програматором буде 
використаний селектор-мультиплексор CD4051BCN. Сигнали на адресних 
входах такої мікросхеми формує шифратор на діодах VD1‒VD7 залежно 
від вибраної мікросхеми для програмування (рис. 3.10). 

Таймер DA1 генерує імпульси з частотою 1 МГц, які необхідні для 
тактування мікроконтролера при програмуванні. Вони поступають, якщо 
перемичкою S2 з’єднати контакти 1, 2 з’єднувача XP3.  

 

 
 

Рисунок 3.9 – Схема комутатора ZIF-панелі  
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Питання для самоконтролю 
 
1. Які режими програмування підтримують МК набору AVR?  
2. У чому полягає захист коду і даних?  
3. Яке призначення конфігураційних комірок?  
4. Як називаються 8-бітові комірки, вміст яких дозволяє ідентифікува-

ти пристрій?  
5. Поняття комірок калібрування та констант калібрування. 
6. Як організовано пам'ять програм і даних?  
7. Розкажіть про особливості програмування по послідовному каналу. 
8. Які дії необхідно виконати для переведення мікроконтролера в ре-

жим програмування по послідовному каналу? 
9. Опишіть процес управління програмування FLASH-пам'яті. 
10. Опишіть процес програмування EEPROM-пам'яті. 
11. Опишіть особливості паралельного програмування. 
12. Які дії необхідно виконати для перемикання в режим паралельного 

програмування?  
13. Яка команда повністю знищує вміст FLASH- і EEPROM-пам'яті? 
14. Послідовність програмування FLASH-пам'яті. 
15. Послідовність програмування EEPROM-пам'яті.  
16. Послідовність програмування конфігураційних комірок. 
17. Як відбувається програмування, читання комірок захисту та кон-

фігурації? 
18. Опишіть процес читання комірок ідентифікатора і комірок каліб-

рування. 
19. Дайте коротку характеристику програмуванню по інтерфейсу 

JTAG. 
20. Опишіть використання інтерфейсу JTAG для програмування крис-

тала. 
21. Перелічіть команди JTAG для програмування.  
22. Дайте визначення поняттю самопрограмування мікроконтролерів 

набору Меgа. 
23. Які етапи розробки комутатора панелі ZIF для програмування мік-

роконтролерів Atmel? 
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ВИСНОВКИ 

Системи з мікроконтролерами належать до класу цифрових обчислю-
вальних систем, тому методологія їхнього проектування має містити еле-
менти апаратної та програмної підтримки. Увесь технологічний процес 
створення програмного продукту можна розбити на кілька етапів. Черго-
вість проектування полягає в складанні технічного завдання, розробці та 
деталізації алгоритму, наборі лістинга програми, компілюванні, моделю-
ванні, програмуванні та реальній роботі. За результатами моделювання або 
реальної роботи можуть бути змінені вихідні дані технічного завдання, 
відкоригований алгоритм функціонування.  

Набір тексту лістинга, компілювання, моделювання та програмування 
можуть здійснюватися як окремими комп'ютерними програмами, так і в 
комплексі. 

Компілятори 8-бітових МК є вузькоспеціалізовані комп'ютерні про-
грами. Вони можуть бути автономними або входити до складу пакетів, що 
мають власну графічну оболонку, редактор тексту, засоби моделювання та 
програмування. Переважна більшість таких комплексів комерційні, платні. 

При розробці програмного забезпечення мікроконтролерів необхідно 
звернути увагу на безкоштовні програмні засоби (AVR Studio, WinAVR) 
підтримки проектування та налагодження систем на мікроконтролерах 
AVR, робота з якими економить гроші та забезпечує ліцензовану чистоту 
кінцевого програмного продукту. 

Обираючи інструментальні засоби налагодження, доцільно брати до 
уваги: підтримка можливо більшої кількості мікроконтролерів; різноманіт-
ність вбудованих інтерфейсів (RS-232, IEEE1284/LPT, USB) та додаткових 
компонентів, що розширюють функціональні можливості; наявність на 
платі поля для макетування і контактів для безпосереднього підключення 
до виводів приладу; можливість підключення додаткових модулів; універ-
сальне живлення. 

МК AVR при програмуванні застосовують такі технології: низьково-
льтне послідовне програмування (ISP); низьковольтне шлейфове програ-
мування з можливістю відлагодження (JTAG); низьковольтне однопровід-
не програмування з можливістю відлагодження (debugWire); високовольт-
не паралельне програмування (HVPP), самопрограмування (BootLoader). 
Кількість виводів мікроконтролерів для їхнього програмування зводиться 
до мінімуму. Для програмування достатньо ліній синхронізації, однієї – 
двох ліній для передачі послідовним кодом команд, адрес й даних та лінії 
для подачі сигналу, який переводить мікроконтролер у режим програму-
вання. Тому для програмування мікроконтролерів AVR усе частіше вико-
ристовують інтерфейс USB та низьковольтне послідовне програмування. 
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